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1 - Introduction to Trainz

Welcome to the latest edition of the Trainz series, Trainz 
Simulator 12. As well as all the features you have come to 
expect from Trainz over the past ten years, Trainz Simulator 
12 extends the Trainz experience by introducing online 
multiplayer.

Whether you wish to drive the trains yourself, manage ‘AI’ 
operations of multiple trains, control industries or create 
your own Trainz world, Trainz Simulator 12 is the platform 
that will allow you to do this and more to bring your virtual 
railway to life.

The team at N3V Games wish to thank you for purchasing this 
evolutionary product, and we trust that you will enjoy not 
only what’s in the box, but also the rapidly growing online 
Trainz community and wealth of free user created / 3rd party 
content that expands and enhances your experience. You can 
discover more about Trainz at

http://www.trainzportal.com/
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Common Terms Used In This Manual
•	 Click - use the Left Mouse Button (LMB)
•	 Double-Click - clicking the LMB twice
•	 R-Click - use the Right Mouse Button (RMB)
•	 Mouse-over - move the cursor over an object and pause
•	 Drag - click and hold the LMB then drag the item
•	 Hotkey – press the key described to carry out the action
•	 CM - Content Manager
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Basic Controls
KP = numpad

W	 Throttle Up		  KP8
X	 Throttle Down		  KP2
S	 Throttle Idle		  KP5

Q	 Brake Release		  KP9
A	 Brake Lap		  KP6
Z	 Brake Apply		  KP3

F	 Reverser Fwd		  KP*
R	 Reverser Bwd		  KP/
H	 Horn			   KP+

B	 Bell			   KP-
L	 Headlight		
Shift-L	 Dimmer
;	 Ditch Lights
V	 Toggle Sanders
P	 Pause

Camera Hotkeys
1	 Cab Interior View
2	 Chase View
3	 Lineside View
4	 Free Roaming View

Interface Hotkeys
F5	 Interface Toggle on/off
F6	 Driver Bar
F7	 Button Bar
F8	 Custom HUD
F9	 HUD Controls
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2 - GETTING STARTED

To get the most out of your Trainz experience, it’s a good idea 
to do a little preparation first. Make sure your PC has up to 
date graphics drivers, clean your mouse and keyboard, grab 
the beverage of your choice, adjust your chair, and you’ll be 
ready for a rail journey of a lifetime. Welcome to the world 
of Trainz.

Installation

Before installing, ensure that you have sufficient disk space 
(at least 10GB) and that you have no other programs running.

If you have the DVD version, begin the installation process 
by inserting the DVD into your DVD drive. Ifyou have auto 
run enabled on your computer the installer will start 
automatically. If you don’t have auto run enabled, you will 
need to start the installation yourself - double click on your 
DVD drive through My Computer or manually browse the 
contents of the DVD and double click on the setup.exe file 
found on the root directory of the DVD.

The installation wizard will guide you through the installation 
process. During this process, you will need to enter your 
product key. For a DVD version, this is normally found on a 
label stuck inside the DVD case or on the back of the manual. 
For a Digital Download version, you will have been notified of 
your product key electronically by the online shop.

For further help with installing TS12, please refer to the 
Readme file found on the DVD, or refer to the Trainz Portal 
website at http://www.trainzportal.com
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Starting Trainz for the first time

At the end of the installer, you will be prompted if you want 
to launch Trainz straight away. If you chose not to, then click 
on the Trainz icon on the desktop or in the start menu to start 
the Trainz Launcher. The first time Trainz is run, a diagnostic 
check will verify if your computer is up to date and capable of 
running Trainz. Any warnings it flags may cause functionality 
or performance problems.

Once the diagnostic check is complete, and you have 
addressed any problems it raised, you will arrive at the Trainz 
launcher. To get the most from your Trainz experience click 
the Options button in the launcher to open the configuration 
screen, and go to the ‘Planet Auran’ tab. From here you can 
enter your Planet Auran profile details.
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If you are new to Trainz click Join Planet Auran to create a 
Planet Auran profile. Although not compulsory, once you 
have a profile, you can register your serial number and gain 
access to the extensive library of content available via the 
Download Station. There are currently well over 100,000 
items on the Download station, and it is growing every day.

Note: You must be connected to the internet to register with 
Planet Auran and to download content.

For Trainz to look its best, you should run Trainz in the same 
resolution as your native display resolution. This is set in the 
‘display settings’ section of the Launcher. For a typical flat 
panel screen, this is generally the highest setting listed in 
the launcher - the one at the bottom of the list. If in doubt, 
consult the documentation for your monitor to determine 
what the native resolution is.

Once these details are entered, click on OK to save them and 
click Start to launch Trainz.

You can update or change any of these details by clicking on 
Options on the Trainz launcher at any time.

Overview Of Available Settings

If you are having issues with game performance on your 
machine, please try the tweaks listed below:

•	 Draw Distance (Trainz in-game option): Larger draw 
distances require significantly more CPU and GPU power. 
If you are having performance problems, try lowering the 
draw distance first.

10
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•	 Anti-Aliasing (Trainz Launcher option; Video Driver 
Options): Reducing or disabling AA quality increases 
performance on low-end hardware but results in a 
significant reduction of visual quality. We recommend 
that you use the TS12 anti-aliasing settings rather than 
attempting to override them with your video driver 
settings.

•	 Anisotropy (Trainz in-game option): Anisotropy 
dramatically improves the crispness of distant objects 
and objects that are on an angle to the observer.  
However, this may introduce performance problems on 
low-end hardware.

•	 Virtual memory settings (System options): Virtual 
memory is used when windows has used up all of the 
available RAM installed in your system. You can edit the 
virtual memory settings by going to Windows Control 
Panel -> System -> Advanced Tab - > Settings (in the 
performance section) -> Advanced Tab -> and clicking 
“Change” in the Virtual memory section. Select the 
Custom size radio button and change the Maximum size 
to at least 4092. Click OK on the various screens to return 
to Windows.

•	 Enable hardware accelerated texture compression 
(CM settings - Miscellaneous): Enabled by default, this 
option can significantly reduce the time taken to install 
large content items. On some faulty video hardware/
video driver combinations, this may result in corrupted 
textures. To fix this issue disable the option and reinstall 
the affected content items.

11
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TS12 Launcher

Once you have successfully installed TS12, Double Click on 
the TS12 icon on your Desktop (or at N3V Games > on the 
Start menu) to access the Trainz Launcher menu. 

The Trainz Launcher menu provides a number of functions: 

Start 

This will launch Trainz.  

Options 

Enables you to customize your settings for Trainz, including 
your Planet Auran settings, display settings and advanced 
graphics features such as shadows.  Read on to to the next 
section for a detailed description of these options.

Content 

This will start Content Manager, a utility to help you manage 
your Trainz content and to download additional content. 

12
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Section 14 examines the details of Content Manager.

Manual

Opens up the .PDF version of the Trainz manual (i.e. what you 
are reading now). The Adobe® Reader® application must be 
installed for you to view the digital manual.  

Website 

This will open up your browser to the Trainz Online 
community portal where you can access wikis and community 
information along with the latest Trainz news. 

Extras 

A number of extra documents from N3V and the 3rd Party 
Content Creators.  

Forums

This will open up your browser to the TS12 community forum 
where thousands of Trainz fans are ready to help you with 
your questions and share experiences.  

Quit 

Closes the TS12 Launcher. 

13
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Options menu in detail

By selecting “options” from the TS12 Launcher you can 
customize various elements to maximize your enjoyment. 

General

Under this tab you will find a dialogue for adding your product 
keys and selecting your desired language.

Planet Auran 

Planet Auran is an ever growing online community that is 
free for all TS12 users to join.  There is an incredible wealth 
of additional information and content available that will 
enormously expand your enjoyment of TS12. 

Highlights include: 

•	 Additional files and utilities that help you get the 
most out of TS12.

14
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•	 Online forums (message boards) where you can ask 
questions you have about using TS12 and learn from others. 

•	 Interactive online features like iTrainz Chat; iPortal 
and Multiplayer. 

If you haven’t already joined, click on the “Join Planet Auran” 
button to register. This will launch your default browser with 
the Planet Auran registration page that will guide you through 
the registration process. You will need to have Internet access 
and be online to do this. 

Once you’ve registered, you’ll have access to over 150,000 
different items such as routes, engines, rolling stock, 
buildings, bridges, track, etc so that you can build exactly the 
rail empire you want to.

 

15
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Display Settings 

DirectX mode or OpenGL mode can be selected depending 
on your graphics hardware requirements. For older systems, 
DirectX generally improves rendering speed. Experiment to 
see which graphics setting works best with your hardware. 

Display Resolution determines what resolution your screen 
will run at.  For best results, set this to your usual (native) 
desktop resolution.

Bit Depth should be left at 32 bit unless your graphics card 
doesn’t support 32 bit graphics.

Anti-Aliasing - Disabling AA increases performance on low-
end hardware but results in a significant reduction of visual 
quality. We recommend that you use the TS12 antialiasing 
settings rather than attempting to override them with your 
video driver settings.

16
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Advanced options

Under this tab you will find technical settings along with the 
option to disable in-game Shadows.

Vertical Sync - Allows for smoother graphics (helps eliminate 
tearing).  “Half-Rate” option is recommended for slower 
hardware.

Frequency - Specifies the “vertical refresh frequency”.  If this 
is set too high for your hardware, the game may not start.  
The default (“Auto”) should run on most hardware, but may 
not give the best results.

Disable Hardware TL - Turns off some hardware acceleration 
options.  Results in poorer performance, but may help reduce 
conflicts with faulty AGP or GPU drivers.

Vertex Offset - Applicable only to DirectX.  If set incorrectly, 
some elements of Trainz (such as text) will appear blurred.

17
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Developer

This tab stores further technical settings related to developer 
and beta testing.

18
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3 - MENU SYSTEM

The Trainz main menu has five options, Tutorials, Routes, 
Saved Sessions, Railyard and Content Updates.

3.1 Tutorials
This menu features 4 introductory tutorials, each focused on 
a different aspect of train operation in the Driver system.
The 4 tutorials in order are:

Tutorial 1 – Trainz interface and basic DCC Controls
Tutorial 2 – Advanced DCC Controls
Tutorial 3 – Basic CAB Controls
Tutorial 4 – Advanced CAB Controls

To get started, select the first tutorial. This will bring up a 
description of the tutorial at the bottom of the screen. Once 
the tutorial has been selected, click on the Play Tutorial 
button found at the bottom right corner of the screen. Trainz 
will now start running Tutorial 1, where you will be guided 
through all the basic controls that make up the Trainz driving 
interface. Once you have completed Tutorial 1, go through 
to the next tutorials and discover more ways to control your 
trains.

19
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3.2 Routes
The Routes menu provides access to drive, edit, and create 
routes and sessions.

There are a number of pre-defined sessions for the built-
in routes for your driving pleasure. You can also use the 
‘Sandbox’ mode to quickly place a train of your choice and 
explore a route. You can also choose to create your own 
session to drive on one of the existing routes, or even create 
your own route from scratch.

Click on a route in the list, and a description of the route will 
be shown in the information pane below the list. Clicking the 
‘Sessions’ button will list the sessions for this route, along 
with any saved sessions or active multiplayer games currently 
running on this route.

20
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If you click on a session in the list, the description of the 
session will be shown in the information pane. Click the 
‘Drive Session’ button to begin driving.

We recommend you start with the easier sessions and 
progress onto the more difficult sessions when you are 
looking for more of a challenge. The relative difficulty of a 
session is listed in the information displayed about it.  If you 
click on a saved session, details about the saved session (e.g. 
when it was saved, and how long the session had run for) will 
be displayed in the information pane.

If you click on a multiplayer game, details of the game (e.g. 
the number of current players and the host’s description) 
will be shown in the information pane. Click the ‘Join Game’ 
button to join the multiplayer game.  Participation in a 
multiplayer game requires an internet connection, a Planet 
Auran account (with a registered serial number), and an 
active multiplayer account.

21
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We recommend that you join a number of existing 
multiplayer games and gain some experience with the 
multiplayer environment before you consider hosting your 
own multiplayer game.

See section 6 of this manual for more information on 
multiplayer sessions.

Definitions
Route - Routes contain the ‘world’ components such as 
terrain, buildings, track, trees and trackside objects.
Session - Sessions contain the ‘variable’ aspects such as locos, 
rolling stock, time of day, weather and other Rules.
Saved session - A session you have previously started playing, 
and saved part way through.

3.3 Saved Sessions
The ‘Saved Sessions’ menu provides an alternative way to 
load a previously saved session. In particular, it allows you 
to easily find a session you’d started if you can’t remember 
which map you started it on.

22
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3.4 Railyard
The railyard module allows you to inspect your locomotive 
and rolling stock collection. There is a list of all available 
rolling stock, and clicking on a vehicle in the list will bring it 
into the shed, where you can inspect it from any angle, and 
operate the horn, lights and pantograph (if fitted). Many of 
the locomotives also have extensive descriptions including 
vehicle history and operating information, which can be read 
in the Railyard module.

23
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3.5 Content Update
The content update menu allows you to download any content 
updates from the Download Station. Updated content items 
may fix minor behavioural or graphical problems, or add 
additional functionality. Much of this content is sourced 
from community members. Keeping your content up to date 
is recommended, particularly if you intend to participate 
in multiplayer games, where a consistent set of content is 
required across all players.

The content update menu requires an internet connection 
and a Planet Auran account with a registered serial number. 
If you download a lot of content, you may wish to consider 
buying a ‘first class ticket’, which will improve content 
download speed.

3.6 iTrainz Chat
To chat with other Trainz fans, click on the iTrainz Chat icon 
in the top right of the menu bar across the top of the screen.
This opens the Chat Buddy List. Click on #trainz to open the 
general Trainz chat channel. Begin typing and press the Enter 
key to ‘publish’ your words for others to see.

You can create your own chat channels, add Buddies and also 
ignore users. Ignore will stop you from seeing any comments 
from that person but they will still be able to see your 
comments.

Note: For iTrainz Chat to work, you are required to have your 
Planet Auran username and password entered in the main 
options screen (accessed from the Launcher).

24
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4 - DRIVER

To drive a session, first select a route from the list and click 
Sessions, you can also double-click the route name. Once you 
are in the sessions submenu, select which session you wish 
to drive and click “Drive Session” to launch.

Note: When you have a route or session selected, information 
regarding the route and session is displayed in the central 
box beneath the main listing.

In Trainz you can also give commands to AI Drivers to carry 
out tasks such as delivering freight, coupling and decoupling 
and keeping to a passenger schedule.

Whilst in Driver, you can use either your mouse or Hotkeys to 
drive. Experiment with different camera positions (Hotkeys 
1-4) or use the “[“ or “]” keys to move between different 
camera views.

In Cab Interior View, hold RMB to rotate your view around 
the cab.

In Chase View it rotates the camera around the currently 
selected vehicle.

Lineside View (Hotkey 3) selects the closest pre-placed 
camera. If there are no pre-placed cameras nearby then it 
will change to Chase View by default.

In Free Roaming View, holding RMB will move the focal point 
around the map, similar to the camera controls in Surveyor. 

25
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4.1 Navigating the Driver Interface

Main Menu Drop-Down List
This drop-down menu is found in the top-left corner of the 
screen.

Help
This opens a browser window within Trainz to display the 
Online Wiki.

Options
This is where you can tweak the graphics slider settings to 
improve the visual quality of your game, or sacrifice some 
visual quality for improved performance (framerate).

Achievements
This lets you check your progress towards earning Trainz 
Achievements.

26
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Save Game (Ctrl-S)
Lets you save your progress including where each train is 
located and the state of each industry. To reload a Saved 
Session, either choose it from the list in the “Routes” menu 
or from the “Saved Session” menu from the Trainz Main 
Menu screen.

Find Object (Ctrl-F)
Lets you locate a particular item on the map (such as a 
junction, station, loco or interactive industry). Selecting the 
item will move the camera position to that position on the 
route.

Exit Driver (Esc)
Quits the current session back to the Driver Main Menu or 
Surveyor screen with the option to save the session before 
exiting.

Main Menu Bar
This section covers the icons to the right of the Main Menu 
drop-down list.

Pause (P)
The Pause button is located beside the Main Menu 
button.  Clicking the Pause button (or pressing ‘P’), 
will suspend the current session so that you can 

answer that important phone call or stop for a lunch, dinner 
or toilet break.  It can also be used to give additional time 
when reading the instructions for a session.

27
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4.2 Camera Views
There are many different ways of viewing the 3D world in 
Trainz, as well as a map view that gives you a 2D top down 
view. You can zoom in and out, pan around, and change the 
camera focus point with each of these views.

The current camera mode is shown on the Trainz menubar. 
Clicking it will bring down the camera menu, allowing you to 
choose from one of 5 camera modes.

Cab Interior View
Firstly, make sure the view is focused on a 
locomotive (Click LMB on a locomotive to focus 
the view), then click LMB on the Cab Interior View 
(or “Cab View”) entry in the camera menu (you 

can also press the “1” key). Your view is now from the driver’s 
seat of the cab. Hold the RMB and move the mouse to look 
around the cab and out of the windows. You can change your 
viewpoint within the cab by pressing the “[“ and “]” keys.

If the locomotive has a second cab, press ALT + C to switch 
between the cabs.

28
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Chase View
When you first start a Driver session, you will 
normally be in Chase (or “External”) View by 
default. The scene will be focused on a particular 
locomotive. Selecting Chase View, or pressing the 

“2” key, will return you to this camera mode. While in Chase 
View, use RMB + Drag to rotate and elevate the view, and the 
mouse wheel (or Page Up / Page Down keys) to zoom. Chase 
View will follow the currently selected vehicle as it moves 
around the map.

If you Click LMB on one of the cars attached to the locomotive, 
the view will move along the train so that the selected car 
becomes the new focus. You can also press the “-“ and “+” 
keys on the keyboard to select the next or previous car in the 
consist.  You can still control the locomotive using the HUD or 
keyboard controls even while viewing a parts of the consist 
other than the engine. 

To shift the focus to a different train, simply Click LMB on the 
desired train, use the driver selector in the bottom left of the 
screen, or click on the consist icons in the 2D Map View.

Lineside View
Click on Lineside View (or “Tracking Camera”) 
and your view changes to the nearest pre-placed 
camera. You can also go to Lineside View view 
by pushing the “3” key. There are two types of 

cameras, static and tracking.

These cameras are placed in the 3D world in Surveyor mode. 
Static cameras will stay fixed in a direction, and allow the 

29
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tracked object to enter, cross and move out of the frame.
Tracking cameras are fixed in place, but pan with the tracked 
object, keeping it in the centre of the view. If there are no 
cameras within visual range of the tracked object, the view 
reverts back to Chase View functionality until a camera 
comes within range.

Free Roaming View
The fourth camera mode is Free Roaming View. 
This is accessed by selecting it from the menu 
or pushing the “4” key.  It operates in a similar 

fashion to navigating in the route editor (Surveyor).

To move the camera focus point, simply Click RMB in the 3D 
world to where you want the new central focus point to be. 
The view will then smoothly move to the new focus point. 
You can use the cursor keys to rotate or change elevation. To 
zoom in and out scroll the mouse wheel or press the Page 
Up/Page Down keys.  Like in Surveyor, in Free Roaming Mode 
you are able to zoom out all the way to satellite altitudes at 
which point it transitions into Map View.

Hold down RMB and move the mouse to continuously change 
the focus point, and hence the view point. By combining 
this mouse movement with the cursor keys and the zoom 
function, you will be able to roam around the route with 
great speed and precision.
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Map View
The fifth camera mode isn’t really a camera mode 
at all - it is the 2D map view. You can get to the 
map by using the Map View menu item, or by 
pressing ‘M’. You will find the Map View is useful 

for getting an overview of where your trains are in relation 
to the industries, the track configuration, plotting your train 
movements and checking turnout settings and signal states.

In the Map View you will see the position, length, and 
name of each Consist, the direction set for each turnout 
and important names for assets such as turnouts, industries 
and stations. Zoom in and out using the mouse wheel or the 
Page Up/Page Down keys.  Unlike entering Map View from 
Free Roaming View, you are able to zoom in close without it 
transitioning into the 3D map.

The map follows the movement of the currently selected 
Consist. The currently selected Consist shows as green, and 
all other Consists show as gray on the map. Click on one of 
the gray Consists to centre the Map view on that Consist.

Click RMB on a point on the map to centre the map view to a 
new location, losing focus on any particular consist.
You can also set the turnouts by clicking on them and seeing 
the direction arrows change. Also visible is the state of any 
signals on the route.  Exit the map screen either by picking 
another camera mode, or pressing CTRL + M again to close 
the map.
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4.3 Tools Menu
The tools menu consolidates many functions that are useful 
when driving in a session.

Toggle Session Instructions
Click on this to display the 
session instructions.

Show Commodity Picker
This displays the commodity 
picker.  See section 4.12 for 
more information.

Show Waybills
This shows available waybills 
from participating industries on 
the route.  See section 4.11 for 
more information.

Toggle Schedule Information
This displays the schedule (if applicable to the session).

Show Message Window
This displays the message window which contains many 
messages about the movements of trains throughout the 
route.

Show Junction Overlays
This toggles whether junction names (and arrow controls) 
are visible at all times or only when you hover your mouse 
over them.

32
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Switch Between Imperial/Metric Units
Toggles the settings from Imperial to Metric or vice versa. 
This will affect parts of Trainz that involve the display of 
measurement/speed information such as the Time & Speed 
HUD Panel.

Dim Headlight
Changes the headlight to dimmed state or if dim, turns off.

Bright Headlight
Changes the headlight to a bright state or if already bright, 
turns headlights off.  This button can also be found in the 
bottom-right corner of the screen.  Read on for more details.

Ditchlights On
This toggles the selected train’s ditchlights on and off.  Read 
on for more details.

Raise/Lower Front Pantograph
If applicable, this toggles the selected train’s front 
pantographs up and down.  A pantograph button can also be 
found in the bottom-right corner of the screen.  Read on for 
more details.

Raise/Lower Rear Pantograph
If applicable, this toggles the selected train’s rear pantographs 
up and down.  A pantograph button can also be found in the 
bottom-right corner of the screen.  Read on for more details.

Start Sanding
This toggles sanding the tracks in front of the selected train 
to help prevent wheel slippage.
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Start Ringing Bell
If applicable, this begins ringing the selected train’s bell.  This 
button can also be found in the bottom-right corner of the 
screen.  Read on for more details.

Reverse Train Facing
This toggles the direction that the train considers forwards.  
This button can also be found in the bottom-right corner of 
the screen.  Read on for more details.

Enable Decouple Mode
Clicking on this display all of the available couplers as bright 
red.  You will also be able to see them through other objects.  
This button can also be found in the bottom-right corner of 
the screen.  Read on for more details.

On Screen Help (Ctrl-H)
Toggles the display of on screen icons such as turnout 
direction markers.

iTrainz Chat
This icon changes colour depending on various events 
when online (eg, to show that you are online, or if there is a 
message waiting, etc).  See section 3.6 for more information.

Trainz Online Browser
Provided you have an internet connection, this opens an 
in-game browser that lets you surf N3V Games approved 
websites without leaving Trainz.
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Help Mode
By first clicking this icon and then clicking on an object that 
you wish to quiery, Trainz will open the in-game browser 
taking you to the wiki entry providing details or help for that 
object.

4.4 DCC Controller (W/X/S)
In DCC mode, a simple rotary dial 
controller is available in the bottom right 
panel of the HUD. This dial controls the 
movement of the currently selected train 
and is analogous to a model railway DCC 
controller knob. Click LMB and drag it 

clockwise on the dial to move forward. Dragging the dial so 
the arrow points upwards will stop the train. Dragging the 
dial anti-clockwise will move the train in reverse. Clicking 
LMB on a position of the dial will also move the dial to that 
location.

Stop (S)
To quickly reset the dial and bring the current 
consist to a halt, Click LMB on the Stop icon.

You can also use the “W” and “X” keys for forward 
and reverse controls and the “S” key for stop. If you are using 
the keyboard to control the throttle, you can refer to the 
position of the rotary dial on the HUD to see your current 
throttle setting.
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Decouple
To decouple traincars from your train, first click 
the decouple button. A series of coupler icons will 
appear where the train can be decoupled. Click 
on the coupler where you want to make a break 

in the train.  Go to section 4.6 for more details.

Pantographs (KPend / KP1)
Click LMB on the Pantograph button on the right 
of the throttle to raise and lower them or press 
the ‘End’ key on the keypad. If the locomotive 
has multiple pantographs subsequent key/button 

presses will raise them individually or together before cycling 
back to all down.

Reverse Train Facing (ALT + C)
If your locomotive has two cabs, or two control 
desks in the same cab, you can click LMB on the 
Reverse Train Facing button to change to the other 
cab. This can also be done (from Cab Interior View 

only) with the key combination ALT + C.

Bell (B)
To activate or deactivate the locomotive bell, Click 
LMB on the bell button or press the “B” key.

Ditchlights (;)
To activate or deactivate the flasher for the 
ditchlights, Click LMB on the ditchlights button, or 
press the “;” key.
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Lights (L)
To activate the headlights, click LMB on the Light 
button. The lights will cycle through off, dim and 
bright settings. You can also control the headlights 
with the “L” key on the keyboard, which will 

switch the lights on and off. Shift + L will change between 
dim and bright.

Horn (H)
To operate the horn or whistle, Click LMB on the 
Horn button to the right of the throttle control on 
the HUD. For long blasts of the horn, simply hold 
the “H” key down longer or Click LMB + Hold on 

the Horn button. Some horns may have a set length, and will 
play for the same duration each time.

Note: Your locomotive may not be fitted with some of these 
devices. Only devices fitted to this loco will be operable.
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4.5 Signals
Trainz signalling is mostly a basic block signalling system, but 
there is a large amount of flexibility built in to allow customized 
signal systems that reproduce many of the different types 
found around the world. Many signal systems convey similar 
information in very different visual ways. Colour light signals, 
semaphore signals and position light signals have different 
ways of showing these aspects.

Typical indications are as follows:

Line Clear (Green)

The next signal is either green or yellow, proceed at line 
speed.
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Caution (Yellow)

The next signal is red, proceed prepared to stop at next signal.

Stop (Red)

The block is occupied, terminates, or is closed.
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On densely used track or where line speed is high, a fourth 
aspect (Advanced Caution) may be used to give advance 
warning to trains that they have to slow down.

This would be used between Line Clear (green) and Caution 
(yellow). The US searchlight (far left) would be flashing to 
indicate to differentiate this from the caution signal.

Where there are junctions, the signalling can give an 
indication of which direction the junction is set.

These signals are showing the diverging route is set, and 
you will need to be travelling at mid speed. The exact 
interpretation of ‘mid speed’ is railroad specific, but is often 
30mph or thereabouts. The signal doesn’t specify left or right 
- just that the route you are taking is not the mainline route.
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This signal is showing the left hand diverging route 
is set. It doesn’t specify how fast the junction 
should be taken - in this case this information 
would be given by a separate speedboard with a 
left hand arrow on it near the junction.

This signal is showing the route to the right 
is set. The highest signal is the mainline 
route. Any signal arms mounted lower 
indicate that a lower speed limit applies to 
that route. The exact speed is not specified 
directly - that information would be 
provided by a speedboard.

Signals are divided into two types - automatic and controlled. 
A controlled signal is generally used to protect one or more 
junctions or other track features. Controlled signals show 
Stop by default, and only clear to a proceed aspect in the 
presence of a train. An automatic signal shows clear (green) 
by default unless the track is occupied or blocked ahead, 
when it will display the appropriate restriction.
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There are many reasons why a signal won’t clear - and you 
can get a hint about why a signal is showing a specific state 
by hovering over it with the mouse cursor - this will show a 
tooltip with a message showing why that state has been set. 
You can also click on the signal to move the camera to an 
obstruction (e.g. a train in advance of the signal).

When a train encounters a green light, it is permissible to 
pass the signal at normal speed. The signal will change to red 
once the block in advance of the signal is first occupied (i.e. 
the train has passed the signal and travelled the length of the 
overlap distance). It will not change to caution (yellow) until 
the train has completely vacated the block in advance of the 
signal - this requires that the back of the train has passed the 
next signal by the length of the overlap distance.

4.6 Junction levers
You change the direction of the Turnout (Junction/Switch) 
by Clicking LMB on arrows associated with the Switch. The 
green arrow points in the direction the Turnout is set to. If 
you are in the Cab, hold the Ctrl key when you Click LMB or 
use the J key to change the junction ahead (Ctrl-J if you are 
reversing).

You can also change turnouts in the 2D Map View, which is 
useful for planning your train’s movements well in advance 
of its progress.  Keep in mind the position of other trains on 
the route when setting up junctions far away.

Tip: Click between the arrows to change their direction.
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4.7 Turntables and Transfer Tables
To operate a turntable or transfer table, click the curved 
arrow to rotate the turntable in that direction. The turntable 
will slowly rotate to the next track, and stop lined up with 
it. Clicking repeatedly will allow the table to rotate across 
several tracks.

Once the table is lined up with your track, drive the loco 
slowly onto the table. Stop in the middle, making sure the 
train is clear of both ends. Then rotate the turntable to the 
track you want to depart on, and pull slowly off the turntable.

4.8 Decoupling
To activate decouple mode, click on the Decouple icon (or press 
the “Ctrl-D” key), then move your cursor over the couplers 
between train cars until you see a red decouple icon. When 
the red decouple icon appears, click LMB to decouple the 
consist at this point. When you have successfully performed 
the decouple operation, the red coupler icon “opens” and a 
message is displayed on the screen.

The act of decoupling creates a new consist and your 
camera remains focused on the same car or loco as before 
the decoupling operation. To re-couple, ensure that you are 
operating at speeds below 5mph (8kph). Experiment with 
different camera positions to make this task easier.
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4.9 Cab mode
Cab Mode provides a more realistic driving experience taking 
into account much more detailed aspects of locomotive 
performance, the length and weight of the train, and the 
gradient.

Each of the levers, switches and dials in the 3D cab can be 
used to operate the locos or you can use the Hotkeys or HUD 
to carry out the same function. (This lets you control the 
locos from outside, even in Cab Mode).

The following tips will get you started, but we recommend 
you play through the cab mode tutorials included with Trainz, 
and also that you check out the ‘Engineer’s Guide’ in section 
of this manual for more detailed information about driving 
using Cab controls.

Cab controls (Diesel or Electric locos)
To start a locomotive in cab mode, first release the train 
brakes (“Q”). If the brake cylinder has not emptied, you may 
need to also release the independent brake (“D”). Put the 
reverser into forward pressing “F” (make sure you have not 
increased the throttle before altering the reverser).

Increase the throttle (“W”) slowly and the train will begin to 
move forward. Don’t increase it too far too quickly, or the 
wheels will begin to spin. If they do, use “X” to decrease the 
throttle and/or “S” to set the throttle to idle. If you are having 
difficulty pulling away, you may also find applying sand (“V”) 
helpful - this will increase the level of traction slightly. Don’t 
forget to turn the sanders off once you are underway!
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Slowing and/or stopping a train can be quite a challenge in 
cab mode. There are three different brake systems available.
The Independent brake is simple to use (one handle 
progressively applies and releases the brake) and fast to 
act, but it will apply the brakes on the locomotive only. This 
provides effective stopping power for a locomotive without a 
train, or for a light train moving slowly. It will not be effective 
for a heavy train.

The train air brake applies brakes down the entire train - but 
is more complicated and slower to take effect. There are two 
types - standard and self-lapping. A standard air brake handle 
has ‘release’, ‘lap’ and ‘apply’ positions.

Move the handle to ‘Apply’ (“A”), wait for a period to allow 
the brake pipe pressure to reduce, and then move the handle 
to ‘Lap’ (“Z”). The brakes will slowly apply down the train to 
the requested level. How hard the brakes apply is controlled 
by how long the lever was in the ‘Apply’ notch.  Think of filling 
up a bucket to store power (apply) and then pouring it out to 
apply the brakes (lap); the more water you put in the bucket, 
the more you have to use.

You can apply the brakes further - simply move the handle 
back to ‘Apply’, and then back to ‘Lap’ again. Though you 
cannot partially release the brakes - you can only fully release 
the brakes by moving the handle to ‘release’. You must then 
wait for the brakes to fully release before you can apply them 
again.

A self-lapping brake handle has a range of ‘Apply’ notches 
- which will automatically lap the brakes at specific braking 
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levels. This means you don’t have to wait in ‘Apply’ for a set 
period of time - you just move the lever to the level of braking 
you want. Just like the standard air brake, you can apply the 
brakes further - this time by moving the lever further, but you 
cannot partially release the brakes. You must fully release the 
brakes and re-apply them.

Be careful with the air brakes - if you repeatedly release and 
re-apply the brakes in quick succession, you can run out of 
air and the brakes will no longer apply properly.  The air will 
return over time, but make sure not to waste it in case you 
don’t have enough braking power for when you really need 
it!

The third braking system is the dynamic (or regenerative) 
brake. Not all locomotives have a dynamic brake fitted, but 
for locomotives that are fitted, you can move the dynamic 
braking lever into the ‘brake’ position (“E”), and control the 
level of braking with the throttle lever (“W”/”S”/”X”).

Dynamic breaks use the locomotive’s own engine to power 
their application which means that they are quick to respond, 
and will generate a lot of force to slow the train, but they 
become ineffective at low speed. They are ideally suited for 
descending hills.

Tip: Watch the information in the Cab HUD Panel to get 
information on speed, throttle, brake settings and Reverser 
direction.

Cab controls (Steam locos)
Entering the cab of a steam locomotive for the first time 
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during a new session, you will find that the light-up crew will 
have prepared you a nice hot fire. Fire temperature can be 
gauged by looking at the colour of the firebox; an orange 
fire is relatively cool, and a white-hot fire is required to raise 
the necessary pressure to power the locomotive. You should 
have a nice head of steam already raised and you can check 
the gauge pressure either in the cab or on the Cab HUD Panel.

To pull away, release the brakes (same as for a diesel or 
electric loco), check that the reverser/cutoff is in full forward 
gear (the HUD should show 75% forward cutoff - use “F” to 
increase this if necessary) and open the throttle (regulator) 
a small amount (“W”). Open the throttle further (“W”) for 
more power. Reduce the throttle (“S”) to reduce power. 
When a steam loco slips, it often spins up very fast, so you 
may need to fully close the throttle (“X”) and wait for the 
wheels to stop spinning before opening the throttle again.

As you pick up speed, to maintain steam pressure, you need 
to reduce the demand for steam. This is usually done by 
reducing the cutoff level. Consider this like the gears in a car 
- 75% is like first gear, and 15% like fifth gear. First is great 
for starting, but you can’t go very fast. As you pick up speed 
you change up the gears.  Fifth is great for cruising down the 
highway. You may need to change down to 3rd or 4th when 
climbing a hill. The steam loco is the same - so slowly wind 
back the cutoff as you accelerate. You’ll want the full 75% 
when you are just starting out, but you’ll get the best out of 
the loco at about 15% or 20% cutoff at full speed. Open it 
back up to 30% or more when climbing a hill.

The brakes work much the same as a diesel or electric loco 

47



4 - DR


IV
ER

- you have independent (steam) brakes for the locomotive 
and tender, and air brakes for the whole train. There is no 
dynamic braking on a steam loco.

Maintaining the boiler pressure is essential for good 
performance. If the pressure drops off by any margin, the 
performance of the locomotive will drop off dramatically. 
Boiler pressure is maintained by heating the water in the 
boiler, which you do by having a nice hot firebed.

Add coal to the firebed by pressing the spacebar. Do this 
progressively over time, rather than dumping a large amount 
of coal into the firebox in one go. Fresh coal is cold, and 
adding lots of it in one go will actually cool the fire down, 
making it burn slower and produce less heat.

As the fire heats up, the boiler pressure should start to 
rise. Always ensure there is sufficient water in the boiler by 
checking the water gauges; they should show be half to two-
thirds in the glass. Water level in the boiler is increased by use 
of the injectors (“I”/”O” and “shift+I”/”shift+O”). Again, add 
water gradually, as it is cold when coming from the tender - 
and will cool the boiler if added in large quantities, resulting 
in a drop in pressure.

To increase the rate the coal burns at, draft the fire. There 
are three sources of draft - the steam exhaust (increased by 
working the locomotive hard), the primary airflow (increased 
by running fast) and the blower (which uses steam directly 
from the boiler to create artificial draft). The blower is 
generally used to build pressure when stationary, not while 
driving.
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When the nominal boiler pressure is exceeded, Safety Valves 
lift to vent excess pressure to the atmosphere. A good crew 
will avoid this waste of steam and fuel by striking a good 
balance between the temperature of the fire, the pressure 
in the boiler, and the conditions of the road ahead. When 
approaching a heavy ascent for example, a hot fire will be 
required to maintain adequate steam pressure. Conversely 
when approaching an easy section with a very hot fire, 
pressure can be eased to prevent lifting safety valves by 
adding more water to the boiler.

Observe the water level in the locomotives tender 
periodically, especially after working the locomotive hard, as 
it may require topping up. Steam routes often have water 
supplies provided at regular intervals for this purpose.

Note: Nominal Boiler Pressure is different for each locomotive 
type.

Note: Take care not to add excessive coal, as this will lower 
the temperature of the fire for a time. A great rule of thumb 
is “a little coal often”, try between 2-4 shovels every kilometer 
(that’s 3-6 shovels every mile).

4.10 Industries and passenger stations
An industry will operate automatically by stopping a 
compatible vehicle in the right place on the track (or 
sometimes dragging one slowly past, if the industry supports 
moving load/unload operations).
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Ctrl+RMB on an industry will bring up a menu. Click ‘Properties’ 
to describe the industry and its current commodity levels.

4.11 Waybills – Who Needs What
The waybill entry on the ‘tools’ menu will bring up a list of 
industries that have created waybills showing that they 
require certain products for delivery. Click LMB on each 
industry icon in the list to show what quantities of products 
are required.

Waybills are automatically produced by an industry when 
that industry reaches a percentage of capacity of a particular 
commodity. Once the full amount required by the Waybill 
has been delivered, the Waybill is deleted from your list 
(although another one may well have appeared in its place).

4.12 Commodities
You can allocate which commodities are carried by a particular 
item of rolling stock. Click on the ‘Show Commodity Picker’ 
entry on the ‘tools’ menu to bring up the Commodities Menu.

Click on an appropriate icon and then click on an item of 
rolling stock. The icon shows that the rolling stock is now 
limited to carrying only that type of Commodity. To stop any 
commodity being loaded or unloaded, use the “Stop” icon. 
To allow the default load only, use the “Default” icon. You 
can only assign commodities to vehicles built for carrying 
that type of commodity.

50



5 - INTRODUCT








ION


 TO
 Q

U
IC

K
DR


IV

E

5 - Introduction to QuickDrive
QuickDrive allows you to configure a limited set of variables 
for conveniently constructing simple Driver sessions.

Whilst in Surveyor, QuickDrive can be accessed by Clicking 
LMB on the QuickDrive icon or with Ctrl+F2. 

QuickDrive can also be accessed directly from the routes 
menu by selecting a route and clicking the QuickDrive button 
on the right hand side of the routes menu.

Using QuickDrive, you can operate trains on a route without 
any preparation in Surveyor.

After starting a Driver session with QuickDrive, you will see 
the QuickDrive settings window.
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Control Type
Here you can switch between Cab and DCC control.  Click on 
the image of your chosen control type to select it.

Environment
Here you can change the weather type, time & date, game 
rate and derailment realism.

Consists
Click LMB on “Consists” and you will see the current consists 
on the route. Here you have the some consist options:

Clone - Allows you to place another instance of the same 
consist. As before, the popup will appear notifying you that 
placement mode is active.

Delete - Requests your confirmation before deleting the 
consist from the route.

Driver - Allows you to assign a driver from among those you 
have enabled under “Drivers”.

New Train
Click LMB on “New Train” to display consist management 
options. From the Global Consist Library select Surveyor List 
or a custom list and find a suitable consist.

Click LMB on the consist of your choice and a pop up window 
will appear saying “placement active”, this means that the 
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consist can now be placed onto the track in the usual way 
by Clicking LMB on the track. You will now see the popup 
displays options to either reverse or delete that particular 
consist.
Click the close window button when done.

Tip: Make sure the track you click on is long enough for the 
consist.

Drivers
Here you can select the available drivers for the session by 
Clicking LMB in the checkbox beside each driver.

Commands
Use this menu for selecting the commands you would like to 
be able to issue to the drivers in the session.

Tip: QuickDrive, like the Control Type rule is one of the session 
rules implemented by default when creating a new session. It 
can be removed from a session by entering Surveyor’s Edit 
Session dialogue explained in section 11.

Tip: QuickDrive can be accessed at any time during a Driver 
session which has the rule enabled. Click the User Rules 
Menu icon in the top right of the menu bar to re-open the 
QuickDrive settings.
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6 - Multiplayer
Joining an Existing Multiplayer Session
To join a multiplayer session, simply follow these steps:

Start Trainz and open the Routes menu.

Select a Multiplayer-capable Route (e.g Debrecen - 
Nyiregyhaza) to view the available sessions.

In the route’s sessions list, select an active multiplayer 
session. If there are any active multiplayer sessions they will 
appear below the regular sessions.

Enter the multiplayer session as you would any other session. 
A multiplayer-specific connection dialog is displayed before 
Driver begins loading.

If you don’t have the latest content required for the selected 
session, you will be prompted to download it at this point. 
Selecting “Yes” will download the updates and automatically 
launch you in to the game. Selecting “No” will cancel the 
session join and return you to the Routes menu.

When you load into Driver, you’ll notice that the Multiplayer 
Session is still loading. This can take a minute or so depending 
on the route and your connection speed.

Once you’re in the game, the multiplayer window will change 
to show a list of players currently in the game.

Click LMB on “Choose a Driver” to see a list of available 
drivers and trains in the session.
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Click LMB on an eye button to view that train’s location on 
the map, and then Click LMB on the arrow button next to the 
driver of your choice to select that train.

Drive your train around! 

Chat During Multiplayer Sessions
During a Multiplayer Session, a special chat channel is visible 
which allows communication between participants. This chat 
channel is not a regular window, but can still be dragged or 
resized to suit. Session admins and officers are denoted in the 
chat and you should take care to follow their directions - they 
have the power to kick you from that Multiplayer Session if 
you are being disruptive.

We recommend that the first thing you do when joining a 
multiplayer session is to greet your fellow participants and 
ask how you can best help out in the Session. Don’t be afraid 
to ask for advice regarding Trainz Multiplayer or the specific 
session that you have joined.
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Gameplay
In Trainz Multiplayer, you control one or more Drivers. Each 
driver is assigned to a train, so through the driver you can 
control a train. You cannot control a train which does not 
have your driver, and you cannot control a train which is 
already controlled by someone else’s driver.

Multiplayer introduces a new level of interactivity to the Trainz 
environment. Just like on a real railroad, the safe passage of 
several trains requires the co-operation of railroad staff.

With real people working each train, operational possibilities 
of online sessions are virtually limitless!

Before hosting your own multiplayer session, it’s probably 
worthwhile for you to take some time to familiarise yourself 
with the routes and to participate in a few established 
multiplayer sessions. This way you can get a feel for the 
capabilities of Trainz Multiplayer before you’re lumped with 
the responsibility of assigning tasks to other users. 
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Hosting a Multiplayer Session
Anybody can start a Multiplayer Session, however it helps if 
you’ve got some friends ready to join you. Follow these steps: 

Start Trainz and open the Routes Menu. Select a Multiplayer-
capable Session and enter the session as per normal. You’ll 
note that Driver begins like a single-player session. You 
need to take additional steps to begin hosting a Multiplayer 
Session.

The Multiplayer options dialog is visible on the screen. If you 
close it, you can use the new Multiplayer button near the 
right of the Trainz main menu bar to bring it back.

If you want, you can customise the options in the Multiplayer 
dialog. We recommend that you give your Multiplayer 
Session a short, descriptive name.
If you wish to start a private multiplayer session, you can 
specify a password. If you do this, you’ll need to let your 
friends know the name of your session and the password to 
use.

Click “Start Session” to begin the multiplayer session. This 
allows other users to find your Multiplayer Session in the 
Routes Menu.

Wait for some friends to join your session! While it’s possible 
for random Trainz users to join in (when you haven’t set a 
password), it’s best if you organise some friends to join you 
straight away.

Once other players are in the game, you can assign them 
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drivers by clicking on them in the player list and choosing 
“Assign Driver...”

You can also promote or kick players by clicking on their 
portraits in the multiplayer window list and selecting the 
relevant options.

You are now the Admin of your multiplayer session. Let your 
participants know what you’d like them to do, and away you 
go. 

Note: Trainz Multiplayer requires that any content used 
in a Multiplayer Session is available on your computer in 
unmodified form. If you’ve modified the content, Trainz 
will automatically revert your modifications and (where 
necessary) download the latest version from the Auran 
Download Station. Don’t worry- Trainz will always ask before 
modifying content, and will move the modified files into a 
“backups” folder in the Trainz program folder in case you 
need to get them back later.
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7 - Engineer’s Guide
The following section is provided to expand on the controls 
and concepts discussed in the section 4.

7.1 Train Braking System Overview
The Westinghouse or ‘Automatic’ airbrake is the standard 
braking system used by TS12. It was introduced in 1869, 
and has endured with essentially little modification to the 
present day.

TS12 currently considers all the vehicles in a consist to be fitted 
with Westinghouse equipment regardless of era or region. 
The system is based on a pressurized air pipe connected 
to reservoirs on all the vehicles in the train. Simply put, a 
pressure reduction in the pipe results in airbrake application.

When the brake pipe is pressurized or “charged”, the 
Westinghouse is considered a “failsafe” system. This means 
that a brake application can be actuated by anything from 
an emergency application on a loco, passenger car or guard’s 
van, a burst hose, a derailment or an otherwise parted train.

Flow - Brake Pipe Flow
The Flow field displays the movement of air in the train Brake 
Pipe. It should return to zero before attempting to move away 
from a standstill, as the presence of brake pipe flow indicates 
that the brakes have not released on all of the vehicles in the 
train. The time it takes to make a full service application is 
dependant on the length of the train. The brakes will release 
on the forward vehicles much more quickly than they will on 
vehicles at the rear.
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It may take several minutes to release the brakes on a very 
long train after a full service application. The Flow Gauge is 
the only true indication of system equilibrium when viewing 
from the cab, as Brake Pipe Pressure is measured at the 
locomotive.

If the flow gauge pointer is bouncing it means the brakes on 
the train are in the process of applying or releasing, avoid 
heavy acceleration during this time.

Brake Pipe - Brake Pipe Pressure
The Brake Pipe field displays the pressure in the Brake Pipes. 
Flexible hoses connect the Brake pipe or Train Pipe between 
vehicles along the length of the train. Pressure changes 
required to control the braking are relayed from vehicle 
to vehicle via this pipe. The Train Pipe is fed by the Main 
reservoir. The maximum pressure is generally prescribed 
by the Railway’s administration and is maintained by a feed 
valve. Over use of the airbrakes over a long descent can 
deplete the air in each vehicle’s auxiliary reservoir more 
rapidly than the brake pipe can recharge them resulting in 
runaways.

A fully pressurized brake pipe results in brake release.

Brake Cylinder
The Brake Cylinder field displays the pressure in the Brake 
Cylinders of the currently selected locomotive/car. Each car 
is fitted with one or more brake cylinders. A piston inside the 
cylinder moves as a result of pressure changes in the train 
pipe. The piston’s force is transmitted via rigging to brake 
blocks or discs at the wheels. Since a pressurized cylinder 
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results in brake application, a reading of 0 Brake Cylinder 
pressure indicates that the brakes are released on the 
locomotive. The Brake Pipe Flow Gauge and the Train Pipe 
Pressure Gauge are the driver’s means of estimating brake 
cylinder pressure at the rear of a train.

If there is any brake cylinder pressure showing on the gauge 
or HUD, the brakes have applied on the vehicle you have 
selected. By selecting a vehicle toward the rear of a long 
train, you can see how much longer it takes for the brakes to 
apply at the back of the train.

Main Res - Main Reservoir
The Main Res field displays the pressure in the Main Reservoir. 
This is a storage tank for compressed air used by the braking 
and some auxiliary systems. It is fed by a compressor.

Equalizer - Equalizing Reservoir
The Equalizer field displays the pressure in the Equalizing 
Reservoir. The Equalizing Reservoir overcomes the difficulty 
of setting the brakes to a desired level on a long train. Small 
changes in train pipe pressure made by the driver will 
not display correctly on the gauge until the pressure has 
stabilized along the length of the train, as brake pipe pressure 
is measured at the locomotive.

When applying the brakes, air will vent from the Equalizing 
Reservoir and its rate is not affected by the length of the train. 
A relay valve detects pressure reduction and discharges air 
from the brake pipe until its pressure is the same as that of 
the equalizing reservoir. This serves as a guide for the driver 
as to the pressure the train pipe will settle at, and thus how 
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hard the brakes will apply. Watch the equalizing reservoir 
when making a brake application to gauge how hard the 
brakes will be applied.

Throttle - Notch Setting
The Throttle field displays the current throttle notch setting 
which can range from 0 (no application of tractive effort) to 8 
(maximum application of tractive   effort).

Reverser - Which Way
The Reverser field displays the Reverser setting. The Diesel/
Electric Reverser has 3 positions; Forward, Reverse and 
Neutral. As it suggests it determines the direction of travel.

Brake - Stopping or Going
The Brake field displays the current application of brakes. 
The train brake can have the following settings: Release, Lap, 
Application, Emergency and Handle Off.
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7.2 Driving in Deisel / Electric Cabin Mode
Train Brakes (Q/Z/A/Pause Break)
The tooltip text in the Cab Interior View for the Train Brake is 
“trainbrakelap lever”.

Release (Q)
Select the Release setting by moving the trainbrakelap lever 
into the “Release” position or by pressing the “Q” key.

In this position it connects the train pipe to the main reservoir, 
raising pressure in the pipe and thus releasing the brakes. 
While motoring, it gently maintains brake pipe pressure to 
counteract any leaks in the system. Leave the handle in the 
Run/Release position while motoring.

Lap (Z)
Select the Lap setting by moving the trainbrakelap lever into 
the “Lap” position or by pressing the “Z” key.

This shuts off the flow of air from the main reservoir into the 
train pipe, and closes the connection to the atmosphere that 
is made during a brake application. It can be used to make a 
partial application, and TS12 also permits a partial release 
both on Freight and Passenger trains.

Watch the equalizing reservoir when making a service, and 
when its pressure has decreased by 10-30 psi, move the 
handle to the lap position.

Modern locomotives are fitted with self-lapping brake 
systems, which shut off the flow of air automatically when 
a reduction is made. To make an application on self-lapping 
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systems, simply move the handle into the initial service 
position, the brakes will be held at that level until they are 
released. Greater braking effort can be achieved by moving 
the handle further into the braking range.

On self-lapping systems, simply move the handle to the initial 
service position and leave it there. If braking is insufficient, 
move the handle further into the braking range.

Select the Application setting by moving the trainbrakelap 
lever into the “Application” position or by pressing the “Z” 
key.

This shuts off main reservoir connection and opens the train 
pipe to the atmosphere. The resulting reduction in train pipe 
pressure causes the brakes to apply. A full application or 
“equalization of pressures” occurs at 64-psi for a 90-psi train 
pipe such as that in use on the F7 diesel.

Air vents out of the equalizing reservoir, and its gauge 
provides a guide as to the amount of reduction being made. 
The flow of air must be lapped off at the desired pressure by 
moving the brake handle to the lap position.

Gradually the Brake Pipe pressure will stabilize at the same 
pressure as the equalizing reservoir. A heavy freight train can 
generally be slowed by a Brake Pipe reduction of 10-psi, a 
fast moving passenger train can require heavier reductions 
of up to 30-psi.

The brakes of a long train will take more time to react, as 
changes in pressure must be transmitted by the train pipe 
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to every vehicle in the consist. The brakes will be held at this 
level until the handle is moved to the release/run position, 
when air will flow from the main reservoir into the brake 
pipe and the brakes will gradually release. The flow gauge 
serves as a guide to air movement within the Brake Pipe, a 
reading above zero indicates that the brakes are either in the 
process of application or release or are otherwise venting air 
somewhere in the consist.

Note: Use the ‘A’ key to apply handbrakes to consists without 
locomotives to prevent them from rolling away.

Emergency Brake (Pause Break)
Select the Emergency setting by moving the trainbrakelap 
lever into the “Emergency” position or by pressing the 
“PauseBreak” key. Like the service position, this allows air to 
escape into the atmosphere, though the air is vented from 
the system more rapidly so the train will stop more quickly.

Independent Brake (E/D)
The Independent Brake as the name suggests is independent 
of the main train braking system. It is used to apply braking 
force only on the selected locomotive.

Note: Not all locomotives have an independent braking 
system. The tooltip text in the Cab Interior View for the 
Independent Brake is “independentbrake lever”.

In Cab Interior View, the independent brake lever has a 
continuous range from fully off (red range) to fully on 
(green range). Set the Independent Brake by moving the 
independent brake lever across this range.
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In keyboard control mode the Independent Brake is set 
by pressing the “E” key. However, this only toggles the 
Independent Brake between being fully on or fully off.
Application of the Independent brake takes some pressure 
away from the Main Reservoir and the Brake Cylinder pressure 
will rise. Remember this only applies to the locomotive and 
not the rest of the train. 

Independent Brake Bail (D)
The Independent Brake Bail can only be operated from the 
keyboard by pressing the “D” key. It immediately vents only 
the locomotive brake cylinder without affecting the braking 
effort on the rest of the train.

If the Train Brake or the Independent Brake is applied when 
you use the Independent Brake Bail, the locomotive Brake 
Cylinder will fill again with air and rise in pressure. This is 
mainly used to “stretch” the train by allowing the locomotive 
to “run away” from the rest of the train. This stretches the 
train to the limits of the couplers and reduces strain.

Reverser (F/R/V)
The tooltip text in the Cab Interior View for the Reverser is 
“reverser lever”. The Reverser has three settings: Forward, 
Reverse and Neutral. You select the Forward setting by moving 
the reverser lever into the Forward position or by press the 
“F” key. Select the Reverse setting by moving the reverser 
lever into the Reverse position or by pressing the “R” key. The 
Neutral setting is selected by moving the reverser lever into 
the Neutral position or by pressing the “V” key.
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As the settings indicate, the Reverser position determines 
the direction the train will travel relative to the cab with the 
driver. This is important to remember in dual cab locomotives.
The Neutral position disengages any tractive effort regardless 
of throttle setting. The locomotive should always be stopped 
before changing the reverser setting to the opposite direction.

Note: You cannot change the position of the Reverser unless 
the Throttle is at the idle position.

Throttle (W/S/X)
The tooltip text in the Cab Interior View for the Throttle is 
“throttle lever”. In Cab Interior View select the required 
Throttle setting by moving the throttle lever to the required 
notch position (0 = no tractive effort, 8 = maximum tractive 
effort).

When using the keyboard press the “W” key to increase the 
Throttle one notch position, while the “X” key reduces the 
Throttle one notch position and the “S” key immediately sets 
the Throttle notch position to zero.

Correct use of the throttle depends on various factors such 
as the type of locomotive, the weight and length of the train, 
the severity of grades and weather conditions. The variety 
of operating conditions cannot be discussed in the context 
of this manual, and generalized operating instructions are 
therefore provided.

For each throttle position, a definite maximum load current 
and corresponding tractive effort may be developed. The 
increase as the throttle is moved from one position to the 
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next is immediate. Since the total tractive effort of the 
locomotive is divided into eight steps available at the eight 
throttle notches, it is necessary to advance all the way into 
the last notch in order to develop full tractive power. Further, 
since the current is controlled, it is perfectly safe to do so, in 
fact it is often necessary under certain conditions.

The load indicating meter or Ammeter provides the best 
guide for throttle handling when accelerating a train. By 
observing this meter, it will be noted that the pointer moves 
to the right (increased amperage) as the throttle is advanced. 
Thus for maximum acceleration without slipping, the throttle 
should be advanced one notch each time the pointer begins 
moving back toward the left, until full power is reached in 
notch 8.

It is well understood that the worst treatment that can be 
given to a traction motor is to allow it to stand at “stall” for 
any appreciable length of time with load current applied to 
it. It is therefore most important, having given due care to 
ensure that the brakes are released, and that the train slack 
is out, to start the locomotive to move as quickly as possible, 
accelerating to a speed that will bring the load meter pointer 
down in a minimum of time.

When starting off, it is good practice to advance the throttle 
promptly to a notch that will start the train moving. If after 
starting, acceleration is too fast, you can back off the throttle 
once all the slack is out, in order to maintain desired speed. 
Once the slack has run out, the throttle may be advanced 
as desired to suit operating conditions and the needs of 
the schedule. It is good practice to hesitate at each notch 
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position, to allow the engine to come up to the new run 
speed, and to prevent slipping.

When decelerating, it is also important to consider the 
action of slack running in and out on the train. Always avoid 
reducing the throttle from high power to idle before allowing 
traction motor voltage to decay. Pressing the “S” key returns 
the throttle to 0, but it is only intended for emergency use, 
as such sudden changes in power propagate a wave motion 
throughout the train. This kind of surge increases the risk of 
drawbar or coupler failure, along with possible damage to 
loads or a very uncomfortable ride for your passengers.
Avoid heavy handed use of the throttle, sudden changes in 
force send surges along the train.

Dynamic Brake (C)
The tooltip text in the Cab Interior View for the Dynamic 
Brake is “dynamicbrake lever”. To activate the Dynamic 
Brake, ensure the Throttle is set to the Neutral position, then 
move the dynamic brake lever fully into the green range or 
press the ‘C’ key. The throttle lever and corresponding keys 
are now used to control braking effort.

To deactivate the Dynamic Brake move the throttle lever 
to the 0 notch setting or press the ‘S’ key. Then move the 
dynamic brake lever fully into the red range or press the ‘C’ 
key. The Dynamic brake is now inactive and the Throttle will 
once more control tractive effort.

The Dynamic Brake is a means of reducing locomotive speed 
by an electrical system, which converts the traction motors 
into generators. The operation and effect of this system 
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applies braking power only to the locomotive(s). Power 
required to rotate the generators through gearing on the 
wheels and axles, retards the locomotive’s travel. Current 
generated by the traction motors is dissipated in resistance 
grids located in the engine hood of the locomotive.

The grids are cooled by motor driven fans that are powered 
by a portion of the current generated. Although similar in 
effect to an independent air-brake application, Dynamic 
Brake is fully electrical; it does not produce friction between 
brake shoes and tires, thus avoiding heat and wear on these 
parts. The load indicating meter shows the current generated 
by the traction motors and may be compared in effect, with 
a brake-cylinder pressure gauge.

Dynamic braking is valuable in many phases of locomotive 
operation. It is particularly valuable when descending grades, 
though it can effectively be used to retard train speed while 
coming to a halt if desired (10 mph minimum), reducing the 
necessity for air brake.

Advance cautiously through the braking range until desired 
braking effort has been reached. The amount of braking 
strength available varies with train speed, and with the 
throttle in notch 8 continues to rise, as the speed decreases 
until reaching its maximum value at around 20 mph. It is 
permissible to start from a standstill on a downgrade with 
Dynamic Brake applied.

When braking a heavy train on a severe grade, the maximum 
available braking effort may not be sufficient to maintain 
desired speed. An application of the Train Brake may be 
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used in addition to the Dynamic Brake, in order to maintain 
permissible track speed.

Grades
When starting to climb a hill, the locomotive and train will 
slow down, and the increased load will be indicated by the 
load meter pointer moving toward the right.

When traveling down a hill, due care may be required to keep 
your train under control. When making a long descent, keep in 
mind that several successive brake applications and releases 
can result in depletion of the system, and it’s therefore 
sometimes necessary to plan your approach to braking. It 
may be necessary to set a constant partial application to 
control your speed.

Many locomotives are fitted with dynamic brake, which may 
be used in conjunction with the train brake to control speed 
when descending a grade.

When descending a long grade, try to estimate how much 
braking is required to keep the train moving under controlled 
speed. It’s safer to make an application that may initially 
slow the train more than desired, than it is to make several 
successive applications and releases.

Operating Over Crossings
The severe mechanical shocks encountered by the traction 
motors when passing over crossings and station yards, may 
cause the brushes to bounce and flashover the motors.
At speeds above 40 mph, reduce the throttle to fifth notch 
position or below while all units are passing over the crossing. 
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This is not necessary at low speeds. It is also recommended 
during dynamic braking at high speeds for the same reason. 
This procedure will ensure decay of motor and generator 
voltage to a safe level before the shock occurs.

Running Through Water
Under ABSOLUTELY NO CIRCUMSTANCES should any 
locomotive be operated through water deep enough to 
contact the bottom of the traction motors.

Water any deeper than 3 inches above rail level is likely to 
cause damage to the traction motors. Every precaution 
should be exercised under circumstances of water over track, 
and speed should not exceed 2 mph in such conditions.

N3V Games cannot accept responsibility for damage 
caused by attempting to operate your Trainz in sub-marine 
environments.
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7.3 Driving in Steam Cabin Mode
So you want to get one of the steam-powered behemoths 
from yesteryear moving? Controlling a steam engine is 
quite different from a diesel or electric engine. Forget about 
dynamic brakes and “notch” throttle settings, these machines 
use steam regulation as the method of control.

Of course you still have the train brake, but the regulator/
reverser are the combined throttle/power settings and 
balancing these and maintaining your steam is the art of 
steam engine driving.

Making Steam - Fire & Water
A Steam Engine needs a full head of steam to operate 
effectively. To generate the steam you build a fire in the 
firebox by shoveling coal through the firebox door found in 
the middle of the backhead. The backhead is that part of 
the boiler that makes up most of the front of the cab of the 
locomotive.

You must also have the boiler filled up appropriately with 
water. A hot fire and an empty boiler is a catastrophic 
situation. Maintaining the water level in the boiler is of great 
concern. The water glass in the engine shows you the level 
of water in the boiler. Try and keep it at about 2/3 of the way 
up the glass.

When the session begins the light-up crew has already got 
your boiler up to pressure and your water levels will be good 
to go. While standing in the station or otherwise stopped, 
you may use the steam available in the boiler to add more 
water to the boiler. To do this, you adjust the valve on the 
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backhead that controls the provision of steam into the Steam 
Injector.

Boiler - Under Pressure
The Boiler field measures the current steam pressure in the 
boiler. The steam pressure in the boiler is dependent on a 
number of factors and maintaining a head of steam is one of 
the challenges in running a steam locomotive.

Of course driving the locomotive uses up steam and reduces 
the boiler pressure. The following information about General 
Steam Driving Principles will help you learn how to drive a 
steam locomotive with an eye to maintaining your head of 
steam.

Regulator - Give Me Steam!
The Regulator field displays the current position of your 
regulator the range of values is expressed as a percentage 
(0-100%).

The Regulator in conjunction with the Reverser setting 
determines how much and at what portion of the piston 
stroke that steam is sent to the cylinder.

Together the Reverser (or Cutoff setting) and the Regulator 
act as the Train’s throttle.

Cutoff - How Much Steam?
The Cutoff field displays the percent cutoff as dictated by 
the position of the Reverser lever (sometimes known as a 
Johnson Bar) is expressed as a percentage (minus 75% to plus 
75%). Negative values indicate the valve gear has been set to 
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move the locomotive in reverse.

The higher the Cutoff value, the greater the duration of steam 
application to each piston stroke. Long cutoff, represented by 
higher percentage values (40 to 75%) for the cutoff, maximize 
the tractive effort applied to the locomotive wheels. This is 
mainly used to get the locomotive moving from a standstill or 
when tackling an ascent.

Short cutoff, represented by lower percentage values (less 
than 40%) for the cutoff, are used to maximize the speed 
attainable by the locomotive during easy sections of the 
route and where speed restrictions permit.

Water - Nearly Steam
The Water field displays the percentage of the boiler filled 
with water. The water level should be maintained at around 
66% as a hot fire without much water is a potentially 
catastrophic situation. The steam pressure in the boiler may 
rise faster than the safety valves can cope and…well you just 
don’t want to go there!

The injectors allow water to move from the tender (or engine 
mounted water tank) to the boiler. Moving the water into 
the boiler can also be used to reduce the rate of pressure 
increase in the boiler as the thermal energy of the fire is now 
being used to heat the incoming cool water.

Steam Cabin Mode Controls
Reverser (F/R)
The tooltip text in the Cab Interior View for the Reverser is 
“reverser lever”. The reverser determines the steam Cutoff 
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and has a range of -75% to +75%. Negative values indicate 
the valve gear has been set to select reverse movement, 
conversely positive values set the valve gear to select forward 
movement. The neutral or mid-gear position (0% cutoff) 
prevents any tractive effort being applied to the locomotive 
wheels.

You adjust the reverser setting by moving the reverser lever 
either forwards/backwards or by pressing the ‘F’/’R’ keys. 
The Neutral setting is selected by moving the reverser lever 
into the Neutral position.

Regulator (W/X)
The tooltip text in the Cab Interior View for the Regulator 
is “regulator lever”. In Cab Interior View select the required 
Regulator setting by moving the regulator lever to the 
required position (0 to 100%) or pressing the “W” key to 
increase or “X” to decrease.

Fireman (Space)
To maintain your steam you need to ensure you have a fire 
in the firebox sufficient to maintain boiler pressure. As the 
fire burns it consumes fuel (coal or oil). To stoke the fire by 
adding fuel, press the ‘Space’ key. In some locomotives you 
will see an animated fireman actually shoveling coal – make 
sure you have opened the firebox door with your mouse in 
Cab Interior View or your fireman will not go to work. As the 
fire is stoked, it burns hotter (red is a cool fire, white is a hot 
fire) and starts to raise the boiler pressure.

Injector (I/0)
The injectors are used to force water into the boiler and 
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can be controlled independently of each other by using the 
mouse, or in tandem using the keyboard shortcuts.

The Steam Injector is a precision piece of equipment which 
uses a venturi system to use high pressure steam to push 
water from the tender into the boiler under pressure through 
a check valve which only allows water into the boiler if the 
pressure behind the water exceeds the pressure in the boiler.

Use the Steam Injector to bring the water level up to the right 
level and then turn it off.

Once the train is moving, the Steam Injector can be set 
carefully to just the right setting so that the amount of water 
entering the boiler matches that being  used up as the steam 
is used to drive the train. If you have equilibrium here, the 
water level will be maintained at a given level. But as an 
engineer, you must continually adjust the flow of water as 
steam will be used up at different rates depending on the 
speed of the engine and how hard it is working which can 
vary dramatically with grades.

Blower (N / Shift+N)
Accelerates the flow of air through the chimney pulling a 
strong draft through the firebox to keep the fires burning 
strongly when the loco isn’t working hard. When closing the 
regulator, turn on the blower to maintain your fire and to 
avoid dangerous backdraught through the firebox. 

Reverser & Regulator
The Steam Reverser Handle (also called a Johnson Bar or 
Steam Cutoff) has multiple positions and adjusts the steam 
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locomotive’s valve gear in such a way that the pistons drive 
the driving wheels in the appropriate directions. In the center 
or neutral position, no tractive effort will be developed by 
opening the throttle.

When first starting a steam engine, place the Reverser 
Handle in the full forward position. Once the consist is 
moving forward at a constant speed, bring the Reverser 
Handle back towards the short cutoff position, thus adjusting 
the valve gear appropriately for most efficient operation 
to preserve your use of coal and water. Move the Reverser 
Handle forward into the high cutoff range when accelerating 
or climbing grades.

The Reverser is used with the Regulator to control a 
combination of speed and tractive effort.

Correct use of the Regulator depends on various factors such 
as the type of locomotive, the weight and length of the train, 
the severity of grades and weather conditions. The variety 
of operating conditions cannot be discussed in the context 
of this manual, and generalized operating instructions are 
therefore provided.

Opening the Regulator on a steam engine delivers steam to 
the valves which govern the distribution of the steam to the 
main cylinders which in turn drive the driving wheels through 
the main rods on each side of the engine.

When starting off, it is good practice to advance the Regulator 
very gently. The finest of steam era engineers started their 
trains so smoothly that passengers hardly noticed that they 

78



7 - ENG


INEER


’S GU


IDE


were moving. It is also important to pick up the slack in all 
of the couplers in along train. Once the slack has run out, 
the Regulator may be advanced as desired to suit operating 
conditions and the needs of the schedule.

Steam engines are notorious for the ease with which you 
can get wheel slippage, which is quite a spectacular site to 
watch. To avoid slippage, start gently and do use the sanders 
if conditions warrant. Sanders deposit sand just in front of 
the driving wheels to improve traction.

When decelerating, it is also important to consider the 
action of slack running in and out on the train. Always avoid 
reducing the Regulator quickly. Sudden changes in power 
propagate a wave motion throughout the train. This kind of 
surge increases the risk of drawbar or coupler failure, along 
with possible damage to loads, spilled soup in the dining car 
or a very uncomfortable ride for your passengers.
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8 - Introduction to SURVEYOR
Driving or operating locos is a big part of the Trainz Simulator 
experience, but Surveyor is where the creative juices can 
really flow. Surveyor is a toolset that is both fun to use and 
powerful enough to create your ultimate dream railroad.  
Anyone can jump right in and have some fun, and with time 
and patience become a master world-builder!

Using Surveyor and your imagination, you can create terrain, 
paint it with textures and then populate it with trees, shrubs, 
buildings, roads, power lines, animals and people. You can 
create lakes and rivers, change the weather conditions and 
even change the color of the sunset.

With Surveyor, you have the tools available to create your 
railroad, with track, stations, signals, maintenance facilities, 
turntables and the plethora of trackside infrastructure that 
combine together to form a working railroad. You can edit 
the default Routes or start from scratch and construct your 
own creation. You can also download a huge number of 
Routes created by others from the Trainz Download Station 
and modify them to suit your tastes.

Example Workflow
The following exercise is designed to serve as a brief 
introduction to the Surveyor tools and workflow.  This will 
help to familiarize you with some of the concepts that are 
visited in depth later in this document.

To begin, start TS12 and choose Routes from the Main Menu 
screen.
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Click LMB on the “Create Route” button near the top-left 
corner of the screen.  We are going to create our route from 
scratch. A new window will pop up as follows, asking you for 
some map details.

For now, simply click the tick button in the bottom-right 
corner of the box.

The first thing to learn in Surveyor is how to move around 
the baseboard and control your camera. Mastering these 
two basic skills will make your time in Surveyor much more 
enjoyable.

The baseboard in effect is the “table” upon which you build 
your route.  The grid lines run from North to South and from 
East to West.
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In the middle of the baseboard is your Surveyor Compass. 
There is also a small white arrow on the screen. The arrow 
is your default cursor, which you can control by moving your 
mouse. Move your cursor to the right of the Compass and 
Click RMB. The compass will move to that position and the 
screen will be re-centered on the compass.

Position your cursor over the compass in the middle of the 
screen and Click RMB+H, slowly moving your mouse cursor 
towards the edge of the screen. You will notice the compass 
following the cursor as you move around the baseboard. 
Learn to control the speed of the movement by moving the 
compass close to or away from the centre of the screen. 
Keep practicing these movements until you can successfully 
control the direction and speed you wish to move.

Use the arrow keys on your keyboard to rotate the camera 
around the compass. The left and right arrows rotate the 
camera. The up and down arrows change the elevation of 
the camera. Press the Page Up and Page Down keys to zoom 
in and out or you can use the mouse-wheel on your mouse 
if you have one.

Tip: A new feature of TS12 allows you to keep zooming out to 
satellite altitudes – and then transition into the map display.  
Feel free to have a play!

When you zoom in close, you will be able to see the four 
directions (North, South, East, and West) marked at the 
bottom of the compass. This is helpful to stay orientated in 
your TS12 world, positioning your rail system properly with 
respect to the rising and setting sun. Yes, on a clear day the 
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sun does rise and set in your TS2010 World!

Tip: Spend some time using a combination of the mouse and 
keyboard to control your view of the Surveyor landscape. This 
is an important skill to develop and some time invested early 
on will reward you later with effortless flitting around your 
map as you construct your rail empire.

Topology
Let’s start by clicking on the Topology Tab (F1). It’s the Tab at 
the top of the Tab Panel on the far right of the screen. When 
clicked on, the menu will fly out to the left.

Now select the Height Up tool in the top-left corner (Each 
tool will have a ‘tool tip’ label which will pop up when you 
move the cursor over the button) by Clicking LMB.  Notice 
that the name of the currently selected tool will be displayed 
next to the name of the tab (in this case, “Topology – Height 
Up”).  Now Click LMB+H on the radius knob, and drag it until 
its dial is in about the 12 o’clock position.  Alternatively, you 
can Click LMB on the position you would like the knob to turn 
to.  Set the sensitivity to the 12 o’clock position using one of 
the described methods.  When you move the mouse cursor 
back onto the Surveyor map, it will change into a dotted 
circle.

Place the circle around the centre of your square baseboard 
and Click LMB+H. The longer you hold the LMB the higher 
and bigger the hill becomes. Move the mouse around while 
holding LMB and you can create various peaks and ridges 
as shown below. Don’t go overboard here as you’ll want to 
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leave some room for your track, not that mountain ranges 
have ever stopped a track laying engineer.

Tip: The Undo/Redo buttons are found on the top menu 
panel. Use them if you want to retrace your steps backwards 
or forwards respectively.

Ground Texturing
Once you are happy with your hill, Click LMB on the Paint Tab 
(F2) from the tabs at the right of the screen. 
The Topology menu disappears to be replaced by the Paint 
menu. Scroll down the texture palette until you find a texture 
you like. Again select the radius of the texture effect by Click 
LMB+H on the Radius dial and moving it until you are happy 
with the size of the painting circle. Then Click LMB to apply 
the texture to the terrain.

Select a couple of different textures and play with blending 
them (overlapping), rotating them using the “direction” tool 
or the “[“ or “]” keys. Select and Texture with a directional 
pattern in it. Click LMB+H on a spot on your route and press 
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the “[“ or “]” keys repeatedly. You can also hold the “[“ or 
“]”to rotate the texture whilst painting.

Change the size of the pattern (the scale of the texture) by 
using the Scale tool. Change the size of the area covered (the 
white circle) using the Radius tool or the “+” or “-“ keys.

Using these tools, you can get some very artistic and realistic 
effects. Keep playing until you are happy with the result.
Now make sure that you are back to having only the 
mountain, nicely textured in the centre of the route. Use the 
Undo function to undo any extra texturing that you may have 
been playing with.

Industries
Now let’s place a couple of linked industries. First select the 
Object tab (F3) from the tab panel and select the Coal Mine 
object.

You will find this by typing in “Coal Mine” into the search 
bar at the top of the asset list. You can also use the Content 
Search Filter to locate items, it is described in section 9.8. 
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Make sure that you have Add Object mode enabled by 
Clicking LMB on the Add Object button.

Click LMB on the map to place the Coal Mine. You can move 
and rotate the object by Clicking LMB on the Move and 
Rotate buttons respectively. To use these tools, Click LMB+H 
on the object that you wish to move/rotate, in this case the 
coal mine, and then move the mouse accordingly. Position 
the Coal Mine as shown below.

Next set the coal mine’s properties by first Clicking LMB on 
the Edit Properties button (the ‘?’ icon) and then Click LMB 
on the Coal Mine. First let’s give it a name. Do this by typing in 
“Lignite Coal Co” in the name box at the top of the properties 
window. We will set the rate of coal production to 200. Do 
this by Clicking LMB on the underlined default production 
rate and entering 200 into the pop up window. Similarly we 
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will change the diesel consumption to a value of 0. Set the 
Start Amount for each to 0. Click LMB on the tick and we have 
defined the properties for our active Coal Mine.

Next we’ll set up a coal-fired power station. As we did for 
the Coal Mine, select the Power Station. It is in the same list 
as you found the Coal Mine. Place it on the other side of the 
baseboard (and the mountain) from the Coal Mine. Move 
and rotate the Power Station as required to line up the tracks 
so they are parallel to the tracks of the coal mine, as shown 
below. Set its properties, which in this case is only to name it 
to “High Power Co”.
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Laying Track
Now we will connect these two industries via a simple oval 
loop. The goal is to link up the Coal Mine’s loading track to the 
oval and run it around to the Power Station’s coal unloading 
track. Go to the tab panel and select the Track tab (F4).

Now choose the track “Auran Track TS2009 Oak”. Make sure 
you are in Add Track mode. Start laying track by Clicking 
LMB on the board where you want to start the track. You 
will notice a white circle associated with the track wherever 
you Click LMB on the board. These are called “spline points”. 
We will manipulate these points later to move the track 
either horizontally or vertically. These spline points are also 
attachment points for bridges, tunnels and other track - 
compatible objects.

The track is drawn between consecutive spline points. Click 
LMB on the map to add another spline point and the track 
will smooth itself out between the two points.

Attach one end of the track to one of the coal mine loading 
tracks (there are four) by first selecting the Add Track mode, 
and then clicking LMB on the spline point of the track you 
wish to attach it to. Now Click LMB in a number of spots 
around the mountain to form a smooth curve. 
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Remember to click on the end of the spline with the LMB 
so that you next track section is attached to the previous 
section (you can also hold down the Shift key if you wish to 
keep laying track without having to select the previous end 
point). At the end of this curve, attach the track to the power 
station’s track by clicking LMB on the end spline point of the 
power stations track. Do the same on the other side to form 
a continuous loop. 

You can smooth out your track laying by Click LMB on the 
Move tool button in the track menu and then Click LMB+H on 
any of the track spline points and move the mouse around, 
and watch as the track follows. Play with this until you are 
happy with your loop of track.

Just for fun, let’s add a siding. Click LMB on the Add Track 
Button, and then click on a section of your existing loop of 
track. A new spline point appears and you can now Click LMB 
again, away from the loop and create your siding. Trainz will 
automatically add in a lever, which will allow you to change 
the direction of the junction by clicking on the red arrow in 
Driver mode.  You can also name the junction by entering 
“Trackside mode”, Clicking LMB on the “Define Name” button 
(the “?” icon) and then clicking on the junction you wish to 
rename.
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Locomotives, Rolling Stock and Consists
We will now place a consist (a ‘train’ of locomotives and 
rolling stock) on the track. Select the Trains tab (F7) from the 
Tab Panel. Now scroll down and select a locomotive from the 
list of available items. Let’s choose a CR GM Class locomotive. 
Once it is selected, Click LMB on any spot on the track to 
place the locomotive. The locomotive will appear on the 
track with arrows above it defining the ends of the consist 
and which direction will be forward when you drive it.

Next, select the black coal car called “TRS Coal Hopper” from 
your list of engines and rolling stock. Click LMB on the placed 
locomotive towards the back of the loco and the coal car will 
appear behind the locomotive. Keep on Clicking LMB on the 
last car in the consist to add more coal cars. Stop when you 
have added 5 coal cars. You have now created a consist.
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Let’s name the consist by clicking by first Clicking LMB on the 
Edit Properties button and then Click LMB on the locomotive 
that is on the tracks. In the pop-up window, click on the 
existing name (VR GM Class 1 in the screenshot below) and 
type in “Coal Train” to replace it.

Give it a running number of 32 by clicking on the text “no 
running number” and then typing 32 into the new window, 
and then click on the tick to save your changes.

Assign a Driver
Our next challenge is to assign a driver to the Consist.

Tip: This is optional, as you may wish to drive your own trains 
in your route. Using Drivers adds a whole new dimension to 
TS12 so we will do that next.
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From the Menubar at the top of the screen, Click on “Edit 
SessionRules” icon (the button has an image of a notepad 
on it) (CTRL+R).  You can also access it from the Main Menu.

This window is where the rules that define a session’s 
behaviour are added and configured. As this is a new session, 
the 6 default rules are already included and configured so 
some minimal functionality is already available and the 
session can be run.

Tip: If you save a session without entering any Rules, a default 
set of Rules is applied for you.
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Click LMB on the 2nd rule, named “Driver Setup”, so that 
it becomes highlighted in blue. Then Click LMB on the Edit 
button to open the properties window for that rule.

Tip: In any of these windows if you decide not to go through 
with the change, click on the “X” button to cancel your 
selections.

The Driver Setup Rule is responsible for assigning driver 
characters to trains for the session. It will automatically try 
to find every loco and assign drivers to them. In this case, 
you will see how a driver character has been assigned to the 
“Coal Train” locomotive that we placed earlier.
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As this is a simple session without the need for complex 
driver attachments, the automatic assignment done by the 
rule is sufficient, but for the sake of configuring a rule, click 
on the driver character icon to bring up a list of drivers.

Choose any driver from the pop-up list and click on the green 
check (tick) to return back to the Driver Setup rule properties 
window. You will notice that the driver character icon has 
changed and that the driver you chose is now assigned to the 
locomotive.

Close the Driver Setup rule properties window by clicking 
LMB on the tick at the bottom right. Then exit the Edit Session 
window with changes saved by clicking LMB on the tick near 
the bottom right corner.

Sessions and the rules used to define them are examined in 
more detail in section 11 of this manual.
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Using Rules
Rules are a very powerful way of expanding and customizing 
your Trainz experience. Based upon the TrainzScript 
programming language, Rules provide non-programmers 
the capabilities to “program” a variety of instructions and 
behaviors for Drivers, locos and even interactive industries.
Every Session has a number of default Rules pre-loaded. In 
Surveyor, click on the Edit Session Rules icon, then click on 
Start-up Options, then click Edit. Here you can change the 
Start-up settings for your Session such as weather, time of day 
and realism level. Click the checkmark to save your changes.

As shown in the previous section, you can allocate Drivers 
to various locos by clicking on Driver Set-up then Edit. You 
can also add Driver Commands for each Driver. R-Click on 
the small arrow and choose a Command from the list. To add 
more Driver Commands to your list, edit the Driver Command 
Rule.

There are over 100 Rules included and many more available 
on the DLS. Rules allow you to add customized displays, 
speed rules, lighting, objectives, scoring systems, customized 
audio and much more. It is even possible to create a whole 
scenario in a single Rule.

Save and Drive
Click LMB on the ‘Main Menu’ button in the top left corner of 
the screen to pull down the main menu list. We will look into 
the main menu list later in this manual. Now Click LMB on 
the Save option to save your creation and make it available 
in the Routes list.
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Tip: Save your work in Surveyor regularly to ensure you don’t 
lose your work should the unforseen happen. You can also 
use the Save As option in the menu to save different versions 
of your route.

Ideally, you will have previously learned to use the Driver 
mode either through the previous chapter of this manual or 
through the tutorial sessions. If not, this is a good time to 
do so. Once you have learned how, you can load your new 
layout into Driver and experience the thrill of driving on a 
route that you have designed from scratch!

Tip: In TS12 you can try out your new route and session 
simply by clicking on the ‘QuickDrive’ icon or by pressing 
CTRL + F2. This will transfer you directly into Driver. When you 
leave Driver mode, you will automatically return to Surveyor 
so that you can immediately continue working on your route 
after testing it.

Well done! You have created your first route by going 
through the basic steps of building the terrain, texturing 
it, placing objects, laying track, putting down consists, 
and assigning drivers. This has been a quick peek into the 
powerful capabilities of Surveyor, feel free to experiment 
within Surveyor and discover its flexibility.
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9 - SURVEYOR IN DEPTH
9.1 Surveyor Title Bar 
The Title Bar appears at the top of the Surveyor screen and 
has several tools, plus the Main Menu drop-down box. 

Surveyor Main Menu 
Clicking on the word Main Menu button 
on the title bar opens up the Main 
Menu drop-down box.  See section 9.2 

for more information.

QuickDrive (Ctrl-F2) 
The QuickDrive button is shortcut that you can use to 
run the current session in Driver. This can be handy 
for session creators who can jump quickly into their 

session and test it without having to quit Surveyor.  See 
section 5 an introduction to using QuickDrive.

Edit Session Rules 
This button opens up the Edit Session window 
where the rules that define a session are added and 
configured. See section 11 for further details. 
 

Content Search Filter 
This button opens up Content Search Filter which is 
handy for quickly finding particular items for your 
route.  This feature is discussed in more detail in 

section 14.
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Wireframe View (F9) 
The Wireframe View button (F9) replaces the textured 
terrain with a see-through wireframe. This mode is 
useful for seeing what lies beneath the ground such 

as under hills when placing and moving tunnels. Use F9 again 
to return to the regular view.

Undo (Ctrl-Z) and Redo (Ctrl-Y) 
Undo and Redo are very 
useful functions for clearing 
up mistakes and recovering 

deleted objects etc. The number of levels you can undo or 
redo is determined by your computer memory. To use, just 
click on the appropriate Icon and your last step is Undone or 
Redone. If you have done a number of things quickly, such as 
painting a number of textures, be aware that these may all 
be become undone in one click. 

9.2 Surveyor Main Menu
Creating and Saving Routes & Sessions
Click LMB on New Route to begin a new project. You will be 
asked to Save if you have made changes to a route that you 
were working on. In the Create a New Route window that 
next opens up, enter or select the following information: 
Give the new route a Route Name (replacing the name ‘New 
Route’ and give this instance of the route a Session Name 
as well. This allows you to have a single route with multiple 
instances of it available. For example, you may have different 
sets of trains in different sessions. The options are endless.

Select a Geographical Region from the list for your route. 
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One impact of selecting a region is that the cars will drive 
on the appropriate side of the road for your region. It will 
also affect the default latitude and longitude settings for the 
World Origin, the placing of Trackside objects and the default 
selection of Metric or Imperial measures.

Set the Working Scale to Real Scale if you wish to develop a 
virtual railroad rather than a scale model one. This setting 
affects the markings on rulers that you can use to size things 
up on a route as you build it. If you select HO scale instead for 
example, the rulers will measure distance in actual inches or 
meters in HO scale. If you are developing a virtual version of 
a model railway select the appropriate scale.

Set Working Units to metric or imperial measures as you 
wish. This will affect the measurements used when displaying 
the operating conditions in the engines as you are operating 
them.

Save and Save As 
Use Save if you simply want to save the route and session 
that your are working on with the same names that you used 
previously.

Use Save As if you wish to save either the route or the session 
you have created with new names.

In either case you will see one or more of the following 
menus appear depending on where you are in the route 
and session building process. Note that the buttons that the 
items that you select have green buttons. If you cannot click 
on a red button to turn it green, it is because that option is 
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not available to you at this time.

If you wish to save it with a new name, click on the name 
New Route and a drop down menu appears.

You may now either type a name of your choice on top of the 
New Route name or you can click on any of the names in the 
list below if they have a (c) beside them. The (c) beside the 
name means that this is a route that has been created earlier 
by yourself or is a downloaded route created by someone 
else. The names in dark black type such as “British Midlands” 
are routes that came with the TS12 product and cannot be 
overwritten. So you have the option of clicking on any of the 
routes with a (c) beside them if you wish to overwrite them 
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with the route you are working on now. If you do choose to 
overwrite a route, you will see the following menu:

Click LMB on Yes or No depending on which choice you would 
like to make.

Tip: Be careful when overwriting a route as the route being 
overwritten is erased forever. Some route builders chose to 
store successive versions of a route with a different name or 
with a version number so that they can recover a prior version 
if they wish.

WARNING: If you Save As and use the same name for the 
Route you have just edited and Click LMB on the green tick 
you will get a dialogue box appearing that asks if it is OK 
to overwrite the route.  If you Click LMB be aware that all 
dependent Sessions for that Route will be lost. If you don’t 
want to be in danger of losing Sessions choose a different 
name for the Route. As the Routes that come with TS12 
cannot be overwritten, this warning does not apply to 
Sessions dependent on these Routes.
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If this variation of the menu appears, you now must decide 
if you are going to overwrite the route and the session 
information or just the route information. Click LMB on one 
of the buttons to the left of the following three options.

Do Not Save Session - This will save the route as you now have 
developed it but will not replace the session information such 
as the trains placed on the route and the information you 
have modified using the Edit Session menu item described 
below.

This allows you to save just the route that you are working on 
with the same name as you loaded it with.

Overwrite Existing Session - This will save the route as you 
now have developed it and it will also replace the session 
information such as the trains placed on the route and the 
information you have modified using the Edit Session menu 
item described below. The existing session information will 
be overwritten.
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Create New Session - This will save route as you now 
have developed it. It will also create a new session with 
information such as the trains placed on the route and the 
information you have modified using the Edit Session menu 
item described below. So now you will have a route with 
more than one session saved for it as the Session you loaded 
the route with will continue to be saved as well with the old 
name.

If you choose this option, enter a new name for your session 
in the field provided.

Tip: One of the great features of TS12 is that you can save 
many different session setups for a given route. E.g. an early 
morning passenger run or a midnight freight haul. 

If this menu appears, you may save the new route and session 
with the current route name (New Route) or you can click on 
the field and enter a new name for the route. The existing 
session (Default) will be stored with the new route.
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When this menu appears, you have the option of overwriting 
the existing session information or creating a new session. 
Click LMB on the red button to the left of Create a new 
session and enter a new session name by Clicking LMB on 
the field below it and entering a new name. Note that a drop 
down list of existing sessions appears. You may select one of 
these for overwriting if you wish.

If you select Save or Save As and there have been no changes 
since the last save operation, this message will appear. Click 
LMB on OK to return to Surveyor.

Delete Missing Assets 
Delete Missing Assets will remove any links to missing 
objects. This may have occurred if you have downloaded a 
new map and don’t have all the custom content installed, or 
have older content that is not compatible with your version 
of TS12.

This menu will appear asking you to confirm or deny the 
action.
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Mini-Map (Ctrl-M) 
Click on Mini-Map to bring up an overview of your current 
map. Ctrl-M is a quicker way of bringing up this map. You can 
also toggle the Mini-Map on and off using Ctrl-M.

Whilst in mini-map mode, you can navigate around the 
terrain quickly by zooming out and Clicking RMB to move the 
baseboards around the screen.

There is also the ability to show/hide certain types of items in 
the Mini-Map view. Click LMB on the “Map Display Options” 
text in the top left corner of the Mini-Map window and 
select/deselect the items you want to show/hide as desired. 
Click on the “X” in the upper left corner of the Mini-Map to 
close this window.

Find Object (Ctrl-F) 
Find Object (Ctrl-F) brings up a dialogue box that lets you 
type in the name of an object. The map will be re-centered 
if any “named object” with that name is found. An error is 
displayed if there is no object by that name. 

Various objects can be named such as turnouts, signs, 
stations even scenery. By selecting a type other than “All” 
you can narrow down your search.

Merge Route 
Merge Route is an important tool for joining one saved route 
to another. Select Merge Route and a list of all your saved 
maps are displayed.
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Choose which map you would like to join to the current 
map from the list and click on the Check Mark. You will see 
the baseboards from both maps and red shading on the 
baseboards where the current map and the new map overlap.

Use the four small arrows at the bottom of the box to move 
the map to be merged left, right, up or down and use the four 
white arrows on the mini-map to navigate around the mini 
map. Click LMB on Proceed once you have uncovered all the 
red overlapping sections.

Tip: You cannot rotate a new map but you can join to it on 
any side. Large maps will take some time to merge. Before 
merging, rotate the camera so that you are facing North. This 
helps you understand which side of your existing route you 
want to join to.

Once you have merged two maps, you will have to edit the 
joins to smooth out different level terrain, and also to join 
track from the old section to the new.

You can change the map name, scale or measurement units 
using the Edit Project dialogue box.

Edit Route 
Click LMB on Edit Route and a window opens in which you 
can modify the properties associated with a route. This is the 
same screen that appears when you clicked on Create New 
on the Surveyor main menu.

You may now change the Route name, add a Description, 
change the Working scale and the Working Units.
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Edit Session 
Click LMB on the Edit Session item to open up the Edit Session 
window. This window is where sessions are constructed and 
configured using rules. A default minimal session with several 
basic rules is already provided.
 
Edit Environment
The Environment Options allow you to adjust various settings 
that affect the look and feel of the entire route that you are 
creating. These settings are used to can change the skybox, 
weather, height of the snowline, time of year and lighting. 
The individual elements of the Edit Environment Menu are 
described in detail in section 9.7.

9.3 Options
Video Settings
Trainz is a 3D program that allows users to add unlimited 
objects into a scene. The better your computer hardware, the 
more objects you can display on screen and the smoother the 
graphics will appear. You can adjust the performance settings 
at any time in-game using Options/Video Setting in the Main 
Menu. There will always be a trade off between performance 
and graphics and it is up to you to find a combination that 
suits each individual route. Note that you can also adjust your 
screen resolution and turn shadows on or off under Options 
on the Trainz Launcher.

The draw distance can be increased from 1500m to 5000m. 
The scenery detail slider will not only reduce the distance 
that objects will be drawn, but also the Level of Detail of 
objects that take advantage of this feature. As more items 
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are created that use Level of Detail, performance can 
improve dramatically since objects that are miles away can 
be reduced in complexity.

Available Settings:
• Maximum Draw Distance: Set how far into the distance 
objects are drawn. Higher values will increase the work your 
computer will have to do and lower the game performance.

• Scenery Detail: Adjust the visual quality of scenery objects.

• Texture Detail: Adjust the detail level of textures throughout 
the game. Higher values use more RAM and may reduce 
game performance.

• Anisotropy: Lower values result in a smoother, sometimes 
blurry scene. Higher values improve the crispness of distant 
objects and objects that are on an angle to the observer. 
Anisotropy may reduce performance on low-end video cards.

• Train Detail: Adjust the detail level of Train objects such as 
locos, consists, wagons etc.

• Good Weather Fog: Controls the density of the distance fog 
effect during fine weather conditions.

• Bad Weather Fog: Controls the density of the distance fog 
effect during rainy or snowy conditions.

• Gamma: Adjust the depth of blacks and whites, lowering 
the gamma will make the simulator appear darker, increasing 
will make it lighter.
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• Enable in game video: Some Driver sessions may include 
video content incompatible with your installed video drivers 
or video codecs. If you find you are having difficulty with in-
game video you can use this option to temporarily disable 
any videos from being displayed.

• Auto-hide the menu bar: Ticking this option will cause the 
top menu bar to slide out of view when not in use. Move 
your mouse to the top of the screen to make the menu bar 
visible again.

9.4 Surveyor Settings
Surveyor is a tool that prevails with experimentation. It is 
free-form, open-ended software at its best and our users 
continually find ways to utilize it beyond anything we 
originally envisioned.

With this freedom also comes a dilemma. The Surveyor tool 
has no constraints on the amount and variety of objects that 
can be placed in your 3D world. Therein lies the issue; the 
more types of objects you add, the slower the performance 
when playing in Driver mode will be. You can minimize these 
frame rate effects by keeping the variety and number of 
objects minimal. Their effect on frame rate is in that order, 
first variety and then quantity. 

Available Settings:
• Compass Speed:  If the mouse is moving too fast for you 
when you hold down the RMB, adjust the Compass Speed 
slider to the left.  Adjust the slider to the right if you find you 
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need to travel more quickly over areas of your route.

• Fixed track vertex height:  Set to On ensures that as you 
lay track, its height is constrained to the gradient between 
two spline points.   The spline points are also “fixed” at that 
height so that when you adjust the terrain height, the track 
doesn’t move. You can then use the track laying tools to edit 
the spline points to your satisfaction.

• Spline Point Rotation: Set to Off turns the white spline point 
markers from spinning to static.

• Function Keys Open Panels:  Set to On the Function Keys 
(F1, etc) open the tab panels. When the option is set to OFF, 
the Function Keys will enable the panels but will not open 
the panels. Getting to know all the hotkeys can really speed 
up your map making progress.

• Randomly Rotate New Objects:  This setting is handy for 
when you are placing forests etc. You may want to switch it 
to Off when laying rows of houses.

• Contextual Information: Sets the level of helper graphics 
that are displayed in Surveyor. Set it to Off and only the 
graphics relevant to the current tab are displayed (e.g. Track 
spline points won’t display whilst the Texture tab is open).
Select the keys option for Compass Movement to use the 
cursor keys for moving the compass. The mouse will then 
move the camera. 

• Automatic Junction Placement:  When a junction or 
“turnout” is created, Surveyor automatically adds a switch 
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lever for controlling track direction. This option can be turned 
off should you prefer to manually add a particular type of 
control switch to your junctions, such as an electric turnout 
motor.

• Spline Editing Detail:  This controls the amount of detail 
visible in spline objects whilst they are being moved around.  
If your computer’s performance is suffering while you are 
moving splines into position, you can set this option to 
Simple. This displays a white line rather than the 3D spline 
details whilst it is being moved.  

• Compass Movement:  Toggles between mouse and 
keyboard for controlling compass movement. 

• Camera Behaviour:  Select Panning as the default Camera 
Behavior and the map slides left or right when you navigate 
around the terrain. Set to Rotation the map will rotate slightly 
as you navigate. 
• Default to Last Used Assets:  Set to on this option will keep 
the last asset you were last using selected in each Surveyor 
tab.  

• Auto-save interval: Adjust this slider to increase or decrease 
the time span between auto-saves while working in Surveyor.

• Only display favorite content:  TS12 allows you to flag 
objects for easy listing in both the routes/sessions selection 
menus as well as in Surveyor. Ticking this option will cause 
the Surveyor Content Filter to reveal only the items marked 
as favorites by default. If you wish to view the entire list of all 
items by default then you should un-tick this option.
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Items such as locomotives, scenery objects, structures, 
industries etc may also be set or unset as favorite items.

When “Only display favorite content” is enabled, you can 
temporarily reveal all items (both favorites and otherwise), 
by modifying the Content Search Filter to remove the 5-star 
rating criteria.  See section 12 for details about setting 
favorites.

9.5 Adding and Removing Favorites
To edit your favorites, enter ContentManager by selecting 
“Content” from the Trainz launcher.

To see all the current favorites, apply a search by selecting 
“rating” and then 5 stars and then L-Clicking “Apply”.

To remove an item from your favorites list R-Click on an item, 
hover the mouse over “rating” and select 0 stars.

To mark an item as a favorite, perform the same steps as 
above but select 5 stars.  See section 11 for more information.

9.6 Global Consist Library and QuickDrive
Allows you to create, edit and delete consists which can be 
accessed when using QuickDrive. QuickDrive is a default 
session rule that allows various elements of the Driver 
session to be adjusted from within Driver.
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For more information about using QuickDrive see Section 
5.  The Global Consist Library dialogue displays the Surveyor 
consist list by default. When you add a consist to the Surveyor 
list, it becomes available in the Global Consist Library.

In here you’ll also find options for adding and customising 
consist lists. This allows you to create several consist lists. For 
example you might have a dedicated list for passenger and 
another list for freight.

Creating a custom list
Click LMB on “Create new list”, enter a name for your new 
list in the popup and click the tick to accept. In the top left of 
the consist dialogue, your list name is now displayed beside 
“Current List:” Click LMB on your list name and choose 
SurveyorList from the drop down menu. You are now viewing 
the SurveyorList again.

Note that beside each consist listed is an option to “copy to” 
another list. Above the consist list to the right are backward/
forward buttons for scrolling through the pages of the list.
Click LMB on “Copy to” beside a consist of your choice, and 
select your new list from those available.

Click LMB on “SurveyorList” beside “Current List:” and select 
your list.  The selected consist now appears in your custom 
list; with options alongside to Edit, Copy, Rename or Delete 
it.

Click LMB on “Edit” to start a simple consist editor which 
enables you to add individual vehicles to a consist from your 
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collection of train vehicles.

Global Interface Addons
Allows you to activate or deactivate interface add-ons such 
as the iTrainz chat interface.
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9.7 Edit Environment Menu
The Environment menu is accessed from the Surveyor Main 
Menu by selecting “Edit Environment”.

Dynamic Lighting
The first tab to open when 
you select Edit Environment 
is the Lighting panel. This 
panel allows you to set the 
colors of the sky and water 
at various times throughout 
the day.

Time of Day (“+” or “-”) 
The main clock is a 24-hour 
clock and the small red lights 
around the outside are color 
control points.  Click on the 
12 o’clock light and it will highlight and the three-color RGB 
dials will also be highlighted allowing you to adjust the overall 
tint for that time of day.

To choose the time of day, click LMB+H and drag your mouse 
or use the “+” or “-” keys. Note that the lighting in your route 
changes as you work so that you can see the effect in real 
time.

Tip: The “+” and “-” are the keyboard keys between the “0” 
and “backspace” keys on your keyboard. They are not the 
keys on the number pad at the right of your keyboard.
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For more advanced lighting effects the sky tints can be 
composed of different bands.

Click the Sky Preview and a white line 
appears at the bottom of the window. Click 
in the center and the white line moves to the 
center. Click at the top of the window and it 
moves to the top. These are the three-color 

bands in the sky that you can adjust using the RGB dials.

Note: You must have one of the green buttons on the clock 
selected to be able to select a band in the sky.

Let’s begin with the lower band. Click on the bottom of the 
sky preview (make sure you have one of the green lights 
around the clock selected). Now move the three RGB color 
dials and notice the sky colors change.  Repeat this for the 
middle and upper bands.  There are three other colors that 
we can change and they are ambient, sun and water.

Note: Remember you can associate different settings with 
each of the green lights around the clock. 

Ambient Color Preview 
Click LMB on the top Ambient Color Preview 
box and adjust the RGB values to set the 
directional lighting primarily changing the 
color hue of buildings and other objects.
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Sun Color Preview 
Click LMB on the middle Sun Color Preview 
box and adjust the RGB values. This alters 
the ambient lighting, primarily affecting the 
terrain.

Water Color Preview 
Click LMB on the lower Water Color Preview 
box and adjust the RGB values. This alters the 
color of areas of water.

Add Clock (A) 
To add new green lights, select the Add Clock (A) 
tool and Click LMB on the outer rim of the clock to 
add new “lights” as required.

Move Clock (M)
You can also select Move Clock (M) to move the 
lights to a new time slot by dragging them around 
the clock. 

Delete Clock (D)
Click LMB on Delete Clock (D) to delete the green 
lights by Clicking LMB on them.

Reset Colors
If you wish to reset the RGB colors to the 
defaults used by TS12, Click LMB on the Reset 
Colors button.
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Diurnal Cycle 
To run the full 24hour cycle and see the effects, 
click on the Diurnal Cycle button. This runs the 
full day in around 30 seconds. Click on it again 
to stop the cycle at any time. You can also Click 
LMB and drag the hour hand to see how the 

colors blend over time.

World Origin Tools 
The second tab, signified by the globe icon, contains the 
World Origin and Session Date settings.

The World Origin is a marker 
that you place anywhere on 
your route to set the latitude, 
longitude and altitude of the 
origin marker.

Trig Stations (found in the 
Objects Menu) can then be 
placed anywhere on your 
route to identify the exact lat/
long and altitude of location. 
Zoom in close to a Trig Station 
and rotate to see the digital 
readout of lat and long.

Tip: Use the ‘?’ icon to name the Trig Station using the format 
“xx xxx.xxx N/S xxx xx.xxx W/E” and then use Ctrl F to bring 
up a list of all named objects. Click on the lat/long you are 
looking for from the list and you effectively have an unlimited 
number of bookmarks.
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The placing of a World Origin marker adjusts the sun position 
(the higher the latitude, the lower the sun position).

The altitude set in the World Origin controls the snow 
variation in objects where snow is seasonally supported.  The 
default snowline is set at 2000m.

If the World Origin’s altitude is set to 1999m, then a tree 
placed on an untouched baseboard won’t display the snow 
season. Raise the tree up a meter and it will appear to be 
covered in snow.

Add/Move World Origin 
To add a World Origin and then move it if you wish, 
Click LMB on Add/Move World Origin (O) and then 
Click LMB anywhere on your world to add the World 

Origin or Click LMB+H to move it around. Having added the 
World Origin, the next two commands below will become 
available to you as well.

Find World Origin 
To find the World Origin in your world, Click on Find 
World Origin (F) and the view will be centered on 
the World Origin.
 

Edit World Origin 
To edit the properties of the World Origin, Click 
LMB on Edit World Origin (E) and you can set up the 
latitude (setting it north or south of the equator), 

longitude (setting it East or West of the Greenwich Mean 
Time line), and altitude.
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Choosing a date here controls the time of year for your session. 
Some scenery provides seasonal variation and will change 
appearance to reflect the time of year and hemisphere. The 
default origin is northern hemisphere, so you can expect to 
see summer variations mid-year.

To change the hemisphere that your route is located L-Click 
Edit World Origin and enter co-ordinates for the desired 
location in the world.

Weather
The third and final tab controls the weather.  Here you can 
select from differently detailed sky textures.

The Weather Control (“[“ or 
“]”) slider shows what your 
route will look like in rain 
(move the slider left) or snow 
(move the slider right).

The Clouds text box is for 
selecting the type of cloud 
cover that will appear on 
the route. Change the clouds 
by scrolling through the list 
until your find the clouds 
you would like to use; or click 
LMB on the current selection 
to view a drop down list.

The Water text box works in the same manner, and is used 
for selecting the water conditions.  Note that the due to sky 
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reflections the overall appearance of water is effected by the 
choice of sky.

Here you can also change the game’s wind strength, and edit 
the altitude of the snow line. 

9.8 Content Search filter (Ctrl+Shift+F)
As so much content is shipped with TS12, you may 
at times need help finding the item you’re looking 
for.  The number of items displayed in the list can 

be reduced by relevance to your search using the Content 
Search Filter (pictured), on the right side of the Main Menu.

Click on the “+” and the Name filter appears. With the Objects 
tab open, click in the Name entry field and type T and notice 
how the list shortens. Type R, and this search is refined even 
further. Complete the word “tree” and the list displays only 
objects containing the word “tree”.

122



9 - SUR


V
EYOR


 IN

 DE
P

TH

Click on “+” again and a new Name filter appears, click it and 
type “pine”. Now you see only the objects with both “tree” 
and “pine” in the name.  Click on Name to see a drop down 
list of other available filters.

Once you’ve found what you’re looking for click on Clear 
to reset the filters.  To close the Search Filter click on the 
Content Search Filter icon (Ctrl-Shift-F) once more.
 
Bookmarks
Bookmarks can be set at various points along your route 
that you may wish to frequently return to.  Navigate to a 
particular place on your route and click RMB on one of the 
buttons under Bookmarks. Notice that the button turns green 
to indicate that a bookmark has been stored. Now navigate 
away from that location and click LMB on the green button. 
The camera will return to the bookmark location.

Pick List
The pick list is another handy device for helping to find your 
favorite content.  Located at the bottom of the Content Search 
Filter dialogue, the Pick List can store your frequently used 
ground textures, scenery objects, splines, track, trackside 
objects, and trains.

To add an item to your pick list simply find the item in the 
relevant menu, LMB+H on the item, drag it to the Pick List 
and then stop holding the LMB. To remove an item LMB+H 
on the item and drag it out of the Pick List window.

You can also share and customize your pick list with Content 
Manager, see section 14 for information.
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10 - SURVEYOR TOOL TABS 
Down the right side of the Surveyor main screen are seven 
menu tabs containing all of the tools you will need to 
successfully make your own route and session in Surveyor.

Leave your mouse cursor hovering over the first tab and you 
will notice a yellow text box appear saying Topology ‘F1’. 
This message is a “ToolTip” and gives you information about 
the function of that icon. You will also notice the “Hotkey” 
information (‘F1’) telling you which keystroke you can press 
as an alternative to clicking on the icon. Most functions in 
Surveyor have a ToolTip and Hotkey associated with them.

If you are in doubt as to what a particular icon will do, simply 
hold your mouse over it and the ToolTip will tell you what 
action that icon performs. 
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10.1 Topology Menu (F1)
Basic Topology Functions 
The Topology Menu provides 
the tools for creating various 
types of terrain. In this section 
you will learn how to make 
hills, valleys, mountains, lakes 
and rivers.

Tip: You will learn these 
features faster if you first start 
a new route per the instructions 
from section 9 before trying the 
features to be described in the 
rest of section 10.

Click on the Topology Tab (or 
press the F1 key) to open the 
Topology Menu. Here you 
will see a number of different 
tools that can be used to shape 
the terrain. Hold your mouse 
cursor over each one to see a 
short description as well as the 
appropriate Hotkey to press. To 
see the whole menu as in the 
diagram above, click on the 
“Advanced” button to expand 
the menu.
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Height Up (U) 
Click on the Height Up (U) and notice that the 
Mode changes to Height Up. Click on Height 
Down (D) and Adjust Height (A) to see how each 
time a tool is selected, the Mode changes. Click 
on the Height Up icon once again to select the 

Height Up tool, and notice that your mouse cursor changes 
to a circle. This circle is the “area of influence” for your cursor 
when using the land shaping tools.

Click LMB once near the center of your baseboard. Notice 
that the terrain is stretched upwards. Next, Click LMB+H, and 
the terrain continues to rise as long as you hold down the 
LMB. Notice how the hill becomes very steep and the base of 
the hill is the approximate size of the cursor circle.

Click LMB on the Radius Tool (“+”) to enlarge the circle of 
influence to its maximum size. Click LMB and hold near the 
compass icon once more. The hill this time is a lot wider and 
flatter. Click LMB on the Radius Tool (“-”) to reduce the size of 
the circle of influence.

Tip: The “+” and “-” are the keyboard keys between the “0” 
and “backspace” keys on your keyboard. They are not the 
keys on the number pad at the right of your keyboard.

Zoom Out (Page Down) so that you can see the whole circle. 
In Surveyor, you will often need to zoom in and out and use 
the arrow keys to rotate your camera to get the best view of 
what is happening. Whilst holding the LMB, move the mouse 
around the terrain and the hill “follows” your cursor. Zoom In 
(Page Up) for a closer view.
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Next, increase the sensitivity by moving the Sensitivity Dial 
(“]” and “[“) to the maximum setting and Click LMB. Now the 
hill grows a lot faster. You may need to zoom out again (Page 
Down) to see the whole hill.

As you make hills, you will find you need to Click RMB to 
move your camera position and also orient the camera in the 
direction you wish to face by using your arrow keys. A little 
practice makes hill creation a breeze.

Height Down (D) 
Height Down works the same as Height Up 
tool. Firstly move to a flat area then make an 
indentation by Clicking LMB where you want 
the terrain to be lowered. Again, notice that 
size of the cursor circle determines the amount 

of land that is lowered and the sensitivity determines how 
quickly it lowers.

Adjust Height (A) 
Adjust Height (A) allows finer control of the up 
and down movement. Click LMB and hold then 
push your mouse away from you to raise the 
terrain. Click LMB and hold then pull the mouse 
towards you to lower the terrain.

Combined with the zoom function (Page Up, Page Down), 
spinning the camera (arrow or cursor keys), and adjustment 
of the radius and sensitivity dials, you can now make a wide 
variety of different hills and valleys. Practice this until you are 
comfortable to move on.
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Get Height (G) 
Select Get Height (G), then Click RMB on the side of 
a hill. Notice that the number in the Height Value 
field changes. You have captured the height of the 
spot you clicked on. This is useful when you want to 

then go to another spot and set the spot to the same height.

Watch the Height Value field change as you Click RMB on 
different parts of the terrain.

Use Height (H) 
Click on Use Height (H) Then Click LMB to apply the 
selected Height Value to the terrain. The Use Height 
tool creates a plateau at your selected height and 
the radius of your cursor circle determines the 

amount of land that is leveled at one time.

Click LMB+H then move your mouse around the terrain to 
plateau a broader section.

Plateau (P) 
Plateau (P) works in a similar fashion, and simply 
creates a plateau at the current height of the 
compass. Click LMB on the side of a hill to create 
a plateau at that level by raising or lowering the 

terrain.

As an alternative to Get Height to select a Height Value, you 
can also enter specific height in the Height Value field. You 
can enter positive or negative values. Negative values allow 
you to depress the terrain.
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Add Water (W) 
To create a “riverbed”, make your circle radius as 
small as possible. Next, enter -10 in the Height Value 
field. Then click on Use Height. Now make your 

riverbed by Click LMB+H, then “painting” the new height 
along the terrain creating your riverbed as shown below.

Now Click LMB on Add Water (W) 
and paint the water texture along the 
riverbed by Clicking LMB and moving 
your mouse around. The radius of the 

cursor circle determines the texture panel size. You results 
will look like that shown below where we have partially 
completed the “water painting” job. 
Paint enough squares so that they will 
cover the area of your riverbed.

Adjust Water Height (E) 
At first as you see above, the water “floats” above 
the terrain. Adjust Water Height (E) works like the 
Adjust Height tool. Select the Adjust Water Height 

tool and Click LMB and hold (on the water texture) then drag 
your mouse forward and back, adjusting the water texture 
height until it is the appropriate 
height. Note how it properly fills 
the riverbed as you move the water 
downward.

Remove Water (Q) 
Click LMB on Remove Water (Q) and you then delete 
the water texture one panel at a time by Clicking 
LMB on each water panel.
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The Baseboard
Baseboards are in effect the “table” upon which you build 
your route. The baseboard sections are 720 meters by 720 
meters square and the default grid square is 10 meters by 
10 meters in size. If you chose Imperial measures instead of 
metric the grid squares still remain that size.

Alternatively a 5 meter by 5 meter grid can be adopted for 
finer control over cuttings and embankments etc.

Add Ground (X) – 10m Grid
Navigate to the edge of a baseboard by Clicking RMB 
to move the compass. Then select the Add Ground 
(X) tool. Click LMB in the void just off the edge of 

the baseboard to add another baseboard in that direction.
Bring up the Surveyor Main Menu by clicking on the word 
Surveyor on the top menu which drops down if you move 
your cursor to the top of the screen.

Select Mini Map (Ctrl-M). You will see a mini map showing 2 
baseboards. Zoom in and out by clicking on the “+” and “-” 
icons.
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Tip: The “+” and “-” are the keyboard keys between the “0” 
and “backspace” keys on your keyboard. They are not the 
keys on the number pad at the right of your keyboard.

Close the mini map by clicking on the x in the top-right corner 
(Ctrl-M) to toggle back to the full screen view.

Navigate to another edge and add two more baseboards 
then press Ctrl-M to view the mini map once more. Navigate 
around the mini map by Clicking RMB. Notice the main map 
also moves. This is very useful for navigating on large maps. 
Use Ctrl-M to close the mini map once more.

Add Ground (X) – 5m Grid
Navigate to the edge of a baseboard and then RMB on the 
Add Ground (X) tool.  A dialogue appears with the option to 
choose from either 5m or 10m grid. Select 5 meter and click 
the tick to accept. Click LMB in the void just off the edge of 
the baseboard to add another baseboard, this time with a 5 
meter terrain grid.

Click on an existing 10 meter baseboard to upgrade it to 5 
meter.

Delete Ground
Click LMB on the Delete Section button. Then Click 
LMB on any baseboard section to delete it.
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Advanced Topology Functions (Shift-F1)
The Advanced features menu can be opened and closed by 
using Shift-F1 or clicking on the Advanced Tab.

Displacement Maps
The final group of Topology tools relates to using a 
displacement map. A displacement map is a grayscale image 
used to create an instant height map.

There are two ways to apply displacements to the terrain. 
Firstly, let’s consider “Select and Fill”.

Select Area (B) 
Click on Select Area (B). Click LMB and drag the 
mouse to make a large square as shown below. 
The size of the square (or it can be a rectangle) 

determines the area that will be affected by the next 
operation.
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Fill Area (F) 
Scroll through the Displacement Maps (by clicking 
on the left and right arrows) until you find one 
called the Volcano, then click on Fill Area (F). The 

terrain is instantly transformed into the shape determined by 
the grayscale images of the displacement map chosen. In this 
case, we have our volcano.

Note: If you can’t Click LMB on this button, it is probably due 
to your not having used Select Area (B) to select an area to 
fill.

Click Undo to remove the volcano.

Repeat the process using the Valley grayscale map to build 
a valley. Then move the Direction dial and increase the 
Threshold dial. Click LMB on Fill Area once more. This time 
the valley is bigger and faces a different direction. By holding 
Shift whilst selecting your area, larger areas are selected at 
one time.
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Cancel Selection (D) 
Click LMB on Cancel Selection (D) to cancel the 
selection.

Get Displacement
Click on Select Area (B). Click LMB on the baseboard 
and drag the mouse to make a large square that 
covers an existing area of modified terrain.  Now 

click the “Get Displacement” button and you’ll notice that a 
displacement map has been derived from the shape of the 
terrain. This can now be used to apply the same terrain effect 
in another area.

Displacement Brushes
Displacement maps can alternatively be used like paint 
brushes, adding irregular detail to the Height Up and Down, 
Use Height and Plateau tools.

Scroll back through the list of displacement maps until 
“none” is selected.  Click on the Height Up tool and you’ll 
see the familiar circle of the default tool.  Now scroll through 
the displacements to Valley01 and notice that the Height 
Up brush has become a square. Its size and sensitivity can 
be adjusted as before.  Click and briefly hold LMB over the 
baseboard to apply the displacement to particular areas in 
real time.

Making Your Own Displacement Maps 
You can also make your own displacement maps using a 
simple paint program (e.g. MS Paint) and then drop them 
into the \World\Custom\Displacements folder in your TS12 
directory to make them accessible.
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10.2 Paint Menu (F2)
Basic Paint Functions
The Paint Menu provides 
access to a wide variety of 
ground textures. Textures in 
Surveyor are “bitmaps” which 
are created to look like various 
ground types such as sand, 
grass, rocks or gravel. You can 
even create your own textures 
using a simple paint program 
or a digital camera. (The 
resultant .bmp file must be 
a tiling 128x128 pixel image) 
Click on the Paint Tab (F2) to 
open the Paint Menu. You 
will see a number of default 
textures, grouped by region. 
Use the slider button to scroll 
through the list.

Click on one of the textures, and you will see a copy of it 
appear in the small current texture window. Click LMB on the 
terrain and use your mouse as a paintbrush to paint on the 
texture.

Scroll through the textures until you find a striped texture. 
Paint a section of terrain. You can see that a complex texture 
pattern makes easy work of creating stunning ground 
textures.
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Rotate the Direction Dial 90 degrees. Apply the texture again. 
Notice how the texture direction has changed.

Hold down the “[“ key and apply the texture once more. 
Notice the direction dial is spinning and the texture is being 
applied in various directions. This tool helps to eliminate 
repetitive patterns in your textures when you don’t want 
them.

Now move the Scale dial to the minimum setting and apply 
the texture, then move the scale dial to the maximum setting 
and notice the difference when you apply the texture this 
time. You can avoid repetitive texture patterns and create 
ultra-realistic effects by using the scale and direction tools 
along with choosing the right textures.

Get Texture (G) 
Click on the Get Texture (G) tool then Click LMB on 
a texture already painted onto your terrain. Notice 
the current texture window changes to show the 

newly selected texture. This is a useful way to find a texture 
that you have already used without scrolling through all the 
textures to find it again.

The Radius Dial (“+” or “-”) changes the area of influence of 
your cursor circle. Use the larger radius for quicker painting 
and the smallest radius for more accurate and detailed work. 

Tip: The “+’ and “-” are the keyboard keys between the “0” 
and “backspace” keys on your keyboard. They are not the 
keys on the number pad at the right of your keyboard.
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Fill Grid (L) 
The Fill Grid (L) will fill all unpainted areas of an 
entire baseboard with one texture. This is useful 
for finishing off an area where fine texturing is not 

required.

Tip: You can use the Pick List at the bottom of the Content 
Search Filter as a place to store multiple textures or objects 
that you would like to use.  Simply LMB+H on the texture, 
drag it to the Pick List and then stop holding the LMB.  You 
can now easily go between your items on the pick list without 
having to search for each one every time you want to use it.

Select Area (B) 
You can also texture a rectangular area by clicking 
on the Select Area (B) and using the mouse to drag 
a rectangle of any size.

Fill Area (F) 
Then Click LMB on a texture in the favorites box 
and use the Fill Area (F) tool to texture the whole 
rectangle. If you do not select an area first, Clicking 

LMB on Fill Area (F) and Surveyor will fill all areas on which 
there are no textures with the selected texture.

Note: If you can’t Click LMB on this button, it is probably due 
to your not having any textures in the favorites box.

Cancel Selection (D) 
Click LMB on Cancel Selection (D) to cancel the 
selected area.
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10.3 Objects Menu (F3) 
Object Management Functions 
There are a huge number of 
objects in TS12 that you can 
place onto the terrain. There are 
two different types of objects 
- objects and splines. We’ll 
explain spline objects later. For 
now we will concentrate on 
single objects.

Open the Objects Menu by 
clicking on the Objects Tab 
(F3). The default mode is Add 
Objects.  Begin by scrolling 
through the list of objects by 
clicking on the left and right 
arrows of the object list. The 
selected object shows as a 
rotating 3D object in the viewer 
window.

Note: You can control what is shown in your list by selecting 
specific  Object Regions (such as USA) and Object Types (such 
as Trackside).

Add Object (A) 
Check that you are in Add Object mode, or Click 
LMB on Add Object (A) to select this mode. Click 
LMB on the terrain and the selected object is placed 

wherever you click. You can repeat this several times quickly 
adding a number of trees or buildings.
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Tip: It is easy to click twice and get multiple copies of your 
object. Just use Undo to delete the unwanted copies of the 
objects.

Tip: If there is a green checkmark with the letters “IND” 
shown in the lower left corner of the Viewer window, this is 
an indication that this is an “interactive” piece of industry 
capable of participating with “interactive” rolling stock.

Move Object (M) 
Click on the Move Object (M) and Click LMB+H on 
any object and then drag the object around the 
terrain to new positions.

Rotate Object (R) 
Now click on the Rotate Object (R) and Click LMB+H 
and move the mouse left and right to rotate the 
objects. Note that a display shows you the number 

of degrees of rotation.

You can use the move and rotate tools to create rows of 
trees or to align houses along a road. You can set objects to 
“randomly rotate” or not by choosing the Randomly Rotate 
option in the Surveyor Options menu from the Main Menu. 

To find a particular object in the list of objects, click on the 
Object Selection text box, and then type the first few letters 
of the object name. Type in “tree” and the list automatically 
positions alphabetically at “tree”. Click on the Up and Down 
arrows (or use the “+” or “-” keys) to scroll up and down the 
list.
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Tip: The “+” and “-” are the keyboard keys between the “0” 
and “backspace” keys on your keyboard. They are not the 
keys on the number pad at the right of your keyboard. 

Above the Object Viewer Window are the Object Region and 
Object Type lists. Scroll through and select either a region or 
an object type or both in order to shorten the selection list.

Get Object (G) 
Click on the Get Object (G) tool and then Click 
LMB on an object already placed on the terrain. 
Notice that the object selected now appears in the 

selection window. 

Change the mode to Add Object (A) and Click LMB again 
on the terrain where you wish to place another copy of the 
newly selected object.

Delete Object (D) 
Select Delete Object (D) then Click LMB to delete an 
object. Continue Clicking LMB to delete a number 
of objects. If you click on the wrong object, click 

on Undo (Ctrl-Z) to undo the last action and replace the last 
deleted object. 

Adjust Height (H) 
When placed on a route, Objects are placed at 
ground level at that point in the route. If the ground 
is raised the object follows it. But you can place an 

object at a relative height to the ground at any point. 

Click LMB on Height Adjust (H) to enable the adjustment of 
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the height of any Object. Note that only objects which have 
been designed to be height adjustable will allow you to adjust 
their height. So if you cannot adjust the height of an object, 
the likely reason is that it wasn’t designed to do so. 

While in the flight of fancy shown below we have height 
adjusted a station to make it defy gravity, this function is very 
useful. For example, you can place objects on top of each 
other such as a building on a platform.

Holding the Ctrl key in conjunction with this move will adjust 
the object’s height in increments of 0.1 units and holding the 
Shift key will change the height by units of 0.05.

Edit Properties (N) 
Click LMB on Edit Properties (N). Then Click LMB on 
any object in your route. A menu will then open up 
allowing you to edit the properties of the object. 

For simple objects, this usually involves naming the object if 
you wish. 

For more complex operating industries, you are given the 
opportunity to change production and consumption rates 
for resources and other properties as we experienced in the 
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earlier tutorial with the power plan and the coal plant objects.  
Finally there is an option to move the object between layers. 
See section 10 for more details about layers. 

Special Object Types 
As well as the regular objects that are static and exist primarily 
for cosmetic purposes, there are also a range of interactive 
and special object types with unique features. These objects 
usually have track included that can be linked to the track on 
your main route. 

Industries 
An industry is a scenery item with 
track and which also produces 
and/or consumes products. Train 
vehicles can load and unload 
products at an industry allowing 
real world railroad activity (i.e. 
the transportation of goods) to be 
simulated.  The products produced 
and consumed by an industry can 

be viewed and tweaked by using the Edit Properties button 
as mentioned above.  Section 8 of this manual has a simple 
example showing how to place and integrate an industry into 
a route. 

Tip: Industries can be easily found in the scenery object list by 
selecting the “Industry” category. 

Note: To be of any use, an industry’s track must be connected 
to your railroad.  To load or unload, the vehicle used must be 
capable of carrying that particular product. 
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Fixed Track 
Fixed track scenery items are fixed, 
non-flexible segments of track and 
can be thought of as the Trainz 
equivalent to the sectional track 
model train manufacturers have.

A piece of fixed track can be placed 
like any ordinary scenery object 
and then connected to normal 

track splines. It is also possible for fixed track pieces to snap 
together when one piece is moved in close proximity to an 
end point of another. 
The end points of a fixed track are identified by the red arrow 
seen hovering above the track. 

When rotating a piece of fixed track, other pieces of fixed 
track attached to it will also be rotated resulting in the track 
pattern being maintained during rotation. The same also 
applies for moving connected pieces of fixed track. 

Tip: Fixed track pieces can be easily found in the scenery 
object list by selecting the “Fixed Track” category. 

Note: Gradients are not really supported with fixed track. It is 
advisable to use fixed track for flat areas only. 
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Animated Junctions 
These junctions differ from normal 
junctions in that they are pre-
defined fixed track pieces and 
have animated components. As an 
animated junction is a pre-defined 
fixed track piece, extra detail like 
guide rails can also be present in 
an animated junction. 

Animated junctions are added and manipulated on the 
Surveyor baseboard in the same way fixed track pieces are. 
Note: You will find the animated junctions in the “Fixed Track” 
category. The names of all animated junctions included with 
TS12 are prefixed with “Turnout”. 

Turntables 
Turntables are scenery objects 
with multiple incoming pieces of 
track where a special traverser 
track segment (usually rotating) 
can move around to offer access 
to all track pieces. Simply placing a 
turntable object on the baseboard 
and connecting the tracks is all that 
is required to have it functioning. 

Tip: The names of all turntables included with TS12 are 
prefixed with “Tside Turntable”. There is no turntable object 
category. 
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Crossings 
A crossing is a scenery object 
that allows rail track and a road 
to cross each other. As well as 
being a scenery object that can be 
connected to the route’s track, a 
crossing can also be linked up to 
road splines.

Crossings support animated gates 
that are automatically activated as a train enters and leaves a 
proximity region surrounding the crossing. 

The operation of crossings is automated and even the Carz 
will stop when the gates are lowered for a train to pass 
through. 

Tip: TS12 contains some examples of fully Train Controlled 
Level Crossings, where the bells and flashing lights turn off 
when the boom gates go up.

Add the level crossing road/rail junction “XING 1 US” from 
the Scenery Objects Tab.

Use the Edit Properties dialogue in the Scenery panel to 
uniquely name the crossing, e.g. Mycrossing.

Add the crossing lights “XING 1 US lights” to both sides of the 
crossing and name those in accordance with the name given 
to the crossing - e.g. Mycrossingsig1 and Mycrossingsig2.
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Backdrops 
Backdrops are rendered regardless 
of the view distance settings. This 
means they will always be visible 
and won’t disappear like other 
distant scenery items, thus making 
them suitable for scenic backdrops. 

iPortal
The iPortals is a special type of 
portal asset that allows train 
consists to be transferred between 
your Driver session and that of 
another online TS12 user.

This is not the same as full 
multiplayer game functionality. The 
iPortals allow a train to be moved 

between two separate sessions. Otherwise the sessions are 
still independent and have no other links or synchronization.
Placing and Configuring an iPortal

An iPortal is a scenery object with track and is placed and 
linked into your route in the same way an industry is. The two 
iPortal assets can be easily found in the scenery items list as 
they both start with “iPortal”.

To function in the Driver session, the iPortal needs to 
be configured. There are no rules needed, just open the 
properties window for an iPortal placed on your route.
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To get the iPortal working, not only must your TS12 
installation be configured to work with your Planet Auran 
account, but the iPortal itself also has several parameters 
that need setting as well.

iPortal id
Unique ID name that this portal is to be identified by.

Send to user
Name of the remote TS12 user that you wish to exchange 
train consists with. This setting isn’t needed if you are just 
transferring trains to other iPortals on your own route.

Destination iPortal id
Unique ID name of the destination iPortal that this iPortal is 
to exchange trains with. This can either be remotely located 
on another user’s system or from your own route.

Send Trains
Specifies whether trains are sent over the internet and 
exchanged with another user or just transferred locally to 
another iPortal.

Check for trains
Enable this option if you want the iPortal to wait for trains 
that another iPortal may send to it.

Driver mode after create
Determines how trains emitted from the iPortal will be 
controlled on your route once they have exited the iPortal.
Trains transferred through an iPortal will retain their vehicle 
loads so one potential fun activity is to operate your route 
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such that it requires an incoming loaded train from someone 
else through the iPortal.

Don’t forget to use iTrainz Chat so you can communicate with 
your friend and arrange iPortal exchanges. iTrainz Chat will 
also let you know if your friend is online.

Spline Management Functions 
The next mode to explore is Spline 
Mode. Splines are generally long thin 
objects such as roads, power lines, 
fences and rows of trees. They consist 
of two or more “spline points” denoted 
by white circles. These spline points 
can be placed any distance apart and 
the spline object is then “stretched” 
between the spline points as you place 
them on the route. 

Spline Mode (S) 
To enter Object Spline 
mode, Click LMB on 
the large Spline Mode 
(S) button at the top 
left of the tab menu. 

Add Spline (A) 
When you Click LMB on Spline Mode (S), the default 
selection will be Add Spline (A). 

Click LMB on the terrain to anchor the first spline point, and 
Click LMB again some distance away to place the second 
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spline point. You will see white circles at each end of the 
spline. These spline points determine the points of a spline 
that may be selected or moved. For example, in the picture 
below, we have paced the “Powerline B” spline on the route. 

To extend the spline further, Click LMB again on the last spline 
point, then Click LMB once more nearby to extend the spline. 
You can simplify this process by holding down the Ctrl key 
then placing several spline points. Release the Ctrl Key and 
place your final spline point to anchor the spline in place. 

Move Spline (M) 
You can move any spline point by selecting the Move 
Spline (M) tool and then Click LMB+H and dragging 
the spline point to a new position. Sometimes when 

you place a spline point, the spline “snaps” to a nearby spline 
point and creates a curved spline. To avoid this happening, 
hold the Shift key down when placing the spline points. This 
“forces” the spline point to go where ever you tell it to go. 

You can also use Shift-Click LMB to a spline to be placed on 
top of another. This is useful to create a right angle turnout 
such as a fence. 

Get Spline (G) 
Click LMB on the Get Spline (G) tool and then Click 
LMB on a spline object already placed on the terrain. 
Notice that the spline object selected now appears 

in the selection window. This is a quick way of finding the 
spline you want in case you wish to place additional ones into 
your route.
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Change the mode to Add Spline (A) and Click LMB again on 
the terrain where you wish to place the newly selected spline 
object. 

Delete Spline (D) 
Click LMB on Delete Spline (O) then click on a section 
of spline between two adjacent white circles to 
remove unwanted spline sections. If you delete a 

section that is not an end section of a spline, the spline will 
be split into two splines. 

Split Spline (Q) 
If a spline is already curved, you can split it into two 
sections by using the Split Spline (Q) tool. Simply 
Click LMB on the middle spline (or any non-end 

spline point) and you now have two separate splines. 

Toggle Traffic 
Many of the roads (which are splines) that you 
will be placing on your route will have vehicles 
(affectionately known as “Carz”) traveling on them 

automatically. You will see them moving in Surveyor after 
placing the roads. Clicking LMB on Toggle Traffic turns all 
traffic off on these types of roads.

Clicking LMB on the button again will have traffic resume. If 
the Toggle Traffic mode is ON, the button will be lit up in a 
bright green color. Please note that when you toggle traffic 
on and off, it affect all spline roads on your route. 
Roads are placed as splines as shown on the next page. 
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Advanced Spline Management Functions (Shift F3) 
Click LMB on the Advanced Menu (Shift F3) to access even 
more tools. A drop down menu is then revealed as shown at 
the bottom of the tool tab above. This provides you with the 
following tools. 

Spline Height (H) 
The Spline Height (H) tool can be used to raise or 
lower the height of certain types of splines (for 
example catenaries or road bridges). Click LMB on 

Spline Height then Click LMB+H on a spline point (the white 
circle) and drag the mouse forward or backwards. 

Delete Spline Point (X) 
Click LMB on Delete Spline Point (X) and then Click 
LMB on a white spline circle to remove unwanted 
spline points. You cannot delete an end spline point, 

but you can delete the whole section using the Delete Spline 
(D) tool.
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Insert Spline Point (I) 
Click LMB on Insert Spline Point (I) then Click LMB 
between two existing spline points. Notice that a 
new spline point is created. You may need to zoom 

in closer in order to insert a new spline point. 

Note: Don’t overuse spline points as each one will add 
load onto your graphics card and may noticeably degrade 
performance. 

Smooth Spline (S) 
Lay a road spline down on level ground on your 
route using at least four spline points. Use Spline 
Height (H) to pull up two spline points in the middle 

of the road. The road now floats above the ground. 

Click LMB on Smooth Spline (S). Now Click LMB on the raised 
spline section and the spline is instantly raised up to meet the 
road. To make a few minor adjustments, click LMB again on 
the road a few more times. Sometimes it takes a few passes 
to get the road just right. 

Find another level untouched area of your baseboard. Next, 
make and texture a small hill using the Topology tools. 

Lay a single section of road spline over the top of hill with a 
single pair of spline points at either end. Note that it clings 
to the surface of the hill. Now Click LMB on Smooth Spline 
(S) and then Click LMB on the road. As shown below, this 
will level the terrain between the two spline points, thereby 
creating a cutting through the hill to flatten the road. 

152



10 - SUR


V
EYOR


 TOO


LS

Smooth Spline (S) levels the track between two spline points, 
bringing the land up or down to match the levelled spline. 

Tip: Turntables and railroad crossings are actually standard 
objects rather than track objects but they both have spline 
points so that you can attach spline objects such as roads and 
track to them. 

Tip: Place a rail crossing as you would do a normal object and 
then connect track segments to the track spline points. Next, 
connect road splines to the road spline points. If you have 
laid the crossing correctly, when you load the map into Driver, 
road traffic will stop and allow your trains to run through the 
crossing. 

Tip: To get your catenaries to match your track in an electric 
route, it is generally best to place the spline points directly on 
top of the track spline points.  This ensures that the curvature 
matches that of the track and makes it easier to match the 
height.  When laying your catenaries, press Alt-O to show the 
track spline points then hold the shift key to allow placement 
of the catenary spline on top of the track spline. 
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Get Vertex Height
Click LMB on the Get Vertex Height and Click LMB on 
the highest spline point on your spline. The height is 
displayed in the Height Value box. 

Apply Vertex Height
Click LMB on Apply Vertex Height then Click LMB on 
another spline point. The spline point is raised to 
the same height as you first vertex. This is useful for 

ensuring level spline segments. 

Remove Gradient
Click LMB on Remove Gradient and then Click LMB 
on a spline section to remove the gradient between 
two spline points.

Edit Properties
This can be used to name the spline and also set its 
layer.
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10.4 Track Menu (F4) 
Track Mode Tools 
Learning how to lay track, place 
signals and create turnouts 
can be the key to running a 
successful TS12 Driver session. 
Track sections in TS12 are 
made up of flexible length 
track pieces created by placing 
2 spline points.  We call this 
“flexi-track” and it makes laying 
any lengths of track extremely 
simple.  Select the Track Menu 
(F4) and the default selection 
will be Track Mode (T). 

Add Track (A) 
The Add Track (A) 
tool should already 
be highlighted, so 

you are ready to lay your first 
length of flexi-track.  Click on 
the left or right arrows of the track selection dialogue to 
select the type of track you wish to lay, then Click LMB on 
the baseboard where you want to anchor your starting point. 
(We suggest you start with Single Track). 

Click LMB again a short distance away to place another spline 
point. A straight section of track has now been laid between 
the two spline points. 

To extend the track further, Click LMB again on the last spline 
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point (the white circle), then Click LMB once more nearby to 
extend the track. Unless all three spline points are exactly in 
a straight line, you will notice that the track is now curved. To 
connect two sections of track, just drag the end spline point 
of one on top of the end spline point of another and they will 
automatically connect. 

Move Track (M) 
To bend the track in any direction, select the Move 
Track (M) tool and then Click LMB and hold on one 
of the white spline point circles. Drag your mouse 

around the terrain and notice how the track bends. The 
shape of the curve is also affected by how close the spline 
point you are pulling is to the next spline points. 

Straighten Track (B) 
Click on Straighten Track (B) and then Click LMB on a 
bent section of laid track. Notice that the section of 
track straightens between the two spline points and 

the next track segment is also affected. 

Note: Double track cannot be straightened. 

Click again on the straightened track and it returns to a curved 
track. This tool is especially useful when creating turnouts 
and yards and tidying up messy track sections. 

Choose a different type of track by clicking on either the 
Track Region or Track Type dialogue box and scrolling down 
the list until you find a bridge. Lay a short section of bridge on 
the flat ground just as you did for the single track.
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Get Track (G) 
Click on Get Track (G) and then Click LMB on your 
original track. The bridge showing in the selection 
window is replaced by the track. Press “A” to change 

the mode to Add Track and you are ready to lay another 
section of track. 

Delete Track (D) 
Click on Delete Track (D) then click on the bridge 
section to delete it. 

Note: any trackside objects you place on a track segment will 
also be deleted when the track is deleted. 

Split Spline (Q) 
Click on the Split Spline tool (Q) and click on a 
middle spline point (white circle) in the track. The 
track breaks in two at that point.

Edit Properties
This can be used to name the track section and also 
set its layer.
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Creating a Turnout 
Depending on which part of the world you live in, there are 
different names for where one section of track branches 
off from another. Sometimes these are called turnouts, 
junctions, points or switches. We call them turnouts in this 
document. 

This section will teach you the basics of creating turnouts. 
To create a wye turnout, begin by laying two spline points. 
Next, Click LMB to the left of your first section of track and 
drag the new section towards the existing track. 

Click LMB about half way along the first track and the track 
bends to the shape of a turnout. You have just created your 
first turnout. 

To tidy up the turnout and make it look a little better, select 
the Straighten Track (B) tool then click on the lead out track 
to straighten the section leading into your new turnout. 

Add a new spline point to your turnout by going to the 
Advanced Menu (Shift F4) and selecting the Insert Spline (I). 
Click on the left-most track to add the new point. 

Use Move Track (M) to grab the new spline point and move 
it around until you are happy with the shape of the turnout. 
You now have a perfectly created wye turnout.

Note that a turnout lever has automatically been added to 
the Turnout. The Red and Green arrows indicate which way 
the turnout will be set when you begin to operate your new 
route. To change the turnout’s set direction, either Click 
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LMB on the turnout in Mini-Map mode or use the “Junction 
Direction”.

The Switch lever can be deleted using the Trackside Object 
Delete function. But you must replace it with another of your 
choice if the Turnout is to function properly. 

Later we will show you how to change turnout levers and add 
signals to complete the job. 

Tip: If you are trying to move or delete a piece of track and 
it won’t move or delete, you will receive an audible beep. 
This means that the track is attached to a non-movable item 
such as an interactive industry object, rail crossing or perhaps 
even a loco or item of rolling stock. In the case of vehicles, 
they need to be moved at least 2 spline points away from the 
section of track you wish to edit. 

Animated Junctions 
Animated junctions are supported in TS12 but cannot be 
created as track splines. Instead, you need to place an 
animated junction object on the baseboard.

Advanced Track Mode Tools (Shift-F4) 
In TS12, there are two ways you can lay track. Either lay the 
track and bring the land up to meet it, or create the land, 
then lay your track over it. We’ll show you both ways using 
Advanced Track Menu (Shift F4). 

Click LMB on the Advanced button to drop down the 
Advanced Track Menu. 
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Adjust Spline Height (H) 
Begin by laying a short section of curved track using 
4 or 5 spline points. Click LMB the Adjust Spline 
Height (H) and Click LMB and hold on a track spline 

point. Drag your mouse forward and back to raise and lower 
the spline point. Raise the track off the ground, and then 
bring the camera down close to the ground to get a better 
view. 

As you can see below, the track spline points will have arrows 
attached to them showing you the height of the track above 
the ground. 

Smooth Spline Height (S) 
Select the Smooth Spline Height (S). Click on the 
raised track section and the ground is instantly 
raised up to meet the track. To make a few minor 

adjustments, click again on the track a few more times 
between each pair of spline points. Sometimes it takes a few 
passes to get the track just right.

Find a level untouched area of your baseboard. Next, make a 
small hill using the Topology tools. 
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Lay a single section of track over the top of hill with a single 
pair of spline points at either end. Note that it clings to the 
surface of the hill. Now Click LMB on Smooth Spline Height 
(S) and then Click LMB on the track. As shown below, this 
will level the terrain between the two spline points, thereby 
creating a cutting through the hill to flatten the track. 

Smooth Spline (S) levels the track between two spline points, 
bringing the land up or down to match the leveled track.

Delete Spline Point (X) 
Click LMB on the Delete Spline Point (X) and Click 
LMB on a track spline point (not a spline end point 
as they cannot be deleted). Notice that the spline 

point is removed and the curvature is also affected. 

Insert Spline Point (I) 
Click on Insert Spline Point (I) to add a new spline 
point. Once again the track curvature is affected. 
Careful placement of spline points is one of the 

secrets to good track laying. But be careful not to put in too 
many as the more you have the greater the complexity of the 
route and the harder your computer has to work to give you 
smooth operations.
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Get Gradient (J) 
Next, select the Get Gradient (J) and Click LMB on 
your raised track section between two track spline 
points. The gradient between those points is shown 

in the Gradient Value box as a percentage slope. The value 2 
means 2% or 1 in 50. 

Apply Gradient (K) 
Enter a new gradient value in the Gradient Value 
text box, then click on Apply Gradient (K). Click the 
track near your first spline point to raise the track. 

Now click on Undo (Ctrl-Z) and then Click LMB near the 2nd 
spline point. Notice that the gradient has now been applied 
in reverse. The rule is that the gradient is always applied 
“away” from the spline point closest to where you click.

Remove Gradient 
Click LMB on remove Gradient and then Click on a 
track section to remove the gradient between two 
track points. 

Get Vertex Height 
Click LMB on the Get Vertex Height and Click LMB 
on the highest spline point on your track. The height 
is displayed in the Height Value box. 

Apply Vertex Height 
Click on Apply Vertex Height then Click LMB on 
another spline point. The spline point is raised to 
the same height as you first vertex. This is useful for 

ensuring level track segments. 

162



10 - SUR


V
EYOR


 TOO


LS

Show Curve Radius 
Next, click on Show Curve Radius then move your 
mouse along a track segment. The curve radius is 
shown next to your mouse cursor. The number is 

the radius measured in meters so a low number means a 
tight curve and a high number means a straighter track. 

Track in TS12 usually tries to “average” a curve so you can use 
Straighten Track to “end” a curve. This stops the track trying 
to bend back in the other direction. 

Even using Show Curve Radius, creating a nice curve can be 
a little tricky at first. Here are some tips. Move your camera 
vertically above the track and zoom out. Lay down five spline 
points in a gentle 90-degree curve. The curve is probably a 
little wobbly.

Use Move Track (M) to straighten the ends then use the 
Straighten Track (B) to straighten the two end sections. You 
now have a nice consistent curve through 90 degrees. 

Building Bridges 
Bridges and tunnels work much the same way as for normal 
track but can be a little harder to lay due to the type of 
terrain involved. It is sometimes easier to make the bridges 
and tunnels on flat ground then move them into place. 

Select the Track Type “Bridges” by clicking on the Track Type 
arrow keys, then scroll through the list of bridges until you 
find the bridge type you are looking for. 

To place the bridge, select the Add Track (A) tool and lay the 
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bridge just like you did for the track by clicking to place spline 
points.  It is best to lay bridges between two hills although 
you can lay the bridge and then remove the terrain beneath 
it. 

Below we have placed the bridge called “Bridge Stone Pole 
1t” on some flat terrain.

You can insert a spline point in the middle of the bridge using 
Insert Spline Point (I) and then Clicking LMB on the bridge 
section to insert the new point. 

Click on Move Track (M) and Click LMB and drag the middle 
spline point. This allows you to bend the bridge. Don’t bend 
it too far or it will “break”. Below we have inserted a spline 
point into the middle of the bridge and curved it.
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When you depress the ground under the bridge, the bridge 
piers will reveal themselves as shown below. Note that we 
have painted the ground and added water as well. 

To create a bridge that is level, you can use the Get Vertex 
Height tool. Click on the spline point at one end of the bridge 
and you will notice the Height Value is entered into the Spline 
Height dialogue box. 

Click on the Apply Height tool then click on the other two 
spline points. This applies the same height to each of those 
spline points. 

165



10 - SUR


V
EYOR


 TOO


LS

Building Tunnels 
Tunnels work in the same way as bridges. Repeat the steps 
above but firstly select a tunnel rather than a bridge. For 
your first tunnel, lay it on a flat section of ground so that the 
hills don’t interfere with the operation. (You can always add 
the hill afterwards). Here is an example of the double track 
“Tunnel Stone” placed on flat terrain. 

Once you have 3 spline points in a tunnel, select Move Track 
(M) and Click LMB and drag the middle spline point to create 
a bend in the tunnel. Notice that in TS12, the tunnel exits 
“snap” to the terrain at 45-degree increments. You may 
need to re-route your track to align it correctly to the tunnel 
entrance and exit. 

Ensure that you hide the tunnel exit properly by using the 
terrain Height Adjust tools and the track Smooth Spline tool 
to tidy up the entrance. 
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To join track to bridges or tunnels you should always use 
single track (even for a double track, bridge or tunnel). Lay 
the spline point away from the bridge first and then move 
the track towards the end spline. The track will snap to the 
bridge object. Use Smooth Spline to tidy up the terrain. 

Trackside Object Management 
Trackside Mode (Y) 

The second mode in the Track Menu is Trackside 
Mode. Click LMB on Trackside Mode (Y) to 
change the Track Tab menu to the Trackside 
Mode menu. 

Add Object (A) 
To add a trackside object Click LMB on the Add 
Object (A) button. The select the object you wish 
to place from the list. Click LMB at one or the other 

side at some point of the track. Your object will be placed 
beside the track and will be “attached” to it. So if you move 
the track it will move with it. 

Tip: Some of the most important Trackside objects are the 
AI Direction Markers. These are used by the Drivers for 
navigating (pathfinding) around your route. A Driver under 
AI control will not enter a track segment against the direction 
of the AI Direction Marker. Therefore these are useful for 
controlling Northbound or Southbound traffic etc, but, used 
incorrectly, they can also provide barriers stopping Drivers 
getting to where you want them to go. 

167



10 - SUR


V
EYOR


 TOO


LS

Move Object (M) 
Click LMB on Move Object (M). Then Click LMB+H on 
a Trackside Object on your track. Drag your mouse 
along the track to move the object to a different 

position. 

Rotate Object (R) 
To change the side of the track for a trackside 
object, click on the Rotate tool (R) and Click LMB 
on the object. It will switch sides of the track and 

rotate 180 degrees. The direction that a trackside object 
faces is controlled by the selection of Geographic region for 
the route. 

Get Object (G) 
Click on the Get Object (G) tool and then Click 
LMB on an object already placed at the trackside. 
Notice that the object selected now appears in the 

selection window. 

Change the mode to Add Object (A) and Click LMB again at 
another point on the track where you wish to place another 
copy of the newly selected object. 

Delete Object (D) 
Select Delete Object (D) then Click LMB to delete a 
trackside object. 

Continue Clicking LMB to delete a number of objects. If you 
click on the wrong object, click on Undo (Ctrl-Z) to undo the 
last action and replace the last deleted object. 
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Junction Direction (J) 
If you have a turnouts placed on your route, each 
should have a switch lever attached to it. The switch 
lever at a turnout has a green and red arrow. To 

change the default direction of travel (for when you drive on 
this track in the Driver module), Click LMB on the Junction 
Direction (J) tool and then Click LMB once on the green and 
red arrows. The direction is now changed (green denoting 
the default direction of travel). 

You can also make 3-way turnouts by simply adding a third 
track to the turnout. There are now three direction arrows. 

Define Name (N) 
Next, select the Define Name (N) tool and click again 
on the turnout. A dialogue box opens allowing you 
to type a name for the turnout in the box. Click the 

Check (proceed) icon to save the name and proceed. 

Australian & UK signals appear on the left of the track, USA 
signals appear on the right. European signals vary depending 
on the track. 

Careful placement of signals will allow you to operate 
complex operations involving several moving consists 
without incident. It is important to consider that the signals 
are there to protect the trains from each other, and any 
situation where their paths may cross should be protected 
by a signal. 

Extended sections of single line should be relieved by sections 
of double track or “crossing loops” that enable trains to 
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either pass or cross each other. At the entrance to a section 
of single line there can be two signals protecting the same 
block, i.e. one on each track to enable faster trains to pass 
slower ones. 

Keep in mind that once your train passes a signal, any 
following train will not be permitted to pass until your train 
reaches the next signal, so if traffic is going to be heavy, don’t 
place them too far apart. 

To protect AI trains from over running terminating track, a 
rail end marker or buffer must be used. 

Note: At the time of writing, TS12 signals are not capable of 
detecting a train crossing a block via a diamond crossing. 
If you wish to operate a fully automated system, diamond 
crossings should not be used in the path of AI trains. However 
it is possible through the use of Trainz script to develop a 
signaled crossing which does control intersecting trains 
properly. It is recommended that you place at least one signal 
per track segment (i.e. between each junction). 

Trackmark and Trigger Management Tools 
Trackmark Mode (V) 

The third mode in the Track Menu is Trackmark 
Mode. Trackmark mode is used for the 
management of Trackmarks and Triggers. 
These are used to assist in setting up the 
rules for a session, which allows you to design 

operations for your route. 
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Click LMB on the Trackmark Mode (V) to change the Track 
Tab menu to the Trackmark Mode menu. 

Trackmarks 
Trackmarks mark specific points out on the track in a route. 
They are named and then used in Rule building. For example, 
they can be used to guide Drivers to take their trains to 
specific points on the route. They are also used to program 
scenarios such as those in the tutorials described in the 
Engineer’s Guide. 

Add a red Trackmark by Clicking LMB on the center of the 
track where you would like a Trackmark to be placed. 

Add Trackmark (A) 
To add a Trackmark, Click LMB on the Add Trackmark 
(A) button. Click LMB at a point on the track. A 
trackmark will be placed on the track and will be 

“attached” to it. So if you move the track it will move with 
it. Note that the trackmarks will not be visible when you are 
operating your route. 

Move Trackmark (M) 
Click LMB on Move Trackmark (M). Then Click 
LMB+H on a Trackmark Object on your track. Drag 
your mouse along the track to move the object to a 

different position. 
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Rotate Trackmark (R) 
Select Rotate Trackmark (R) and the default direction 
of the Trackmark is reversed. 

Get Trackmark (G) 
Click on the Get Trackmark (G) tool and then Click 
LMB on a trackmark already placed at the track. 
Notice that a trackmark now appears in the selection 

window. 

Change the mode to Add Object (A) and Click LMB again at 
another point on the track where you wish to place another 
copy of the trackmark. 

Delete Trackmark (D) 
Select Delete Trackmark (D) then Click LMB on a 
trackmark to delete it. 

Define Name (N) 
To name your trackmarks so that you can find them again 
later on and use them in rules, Click LMB on Define Name 
(N). Then click on the trackmark and a dialogue box comes 
up where you can name the trackmark. 
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Finding a Trackmark 
To find the trackmark, use the Find Object (using the Type: 
Trackside to shorten the list if you wish) or Ctrl-F and select 
the trackmark from the list. The trackmark is located, and 
the screen is re-centered. This is useful for finding your way 
around the map. 

Triggers 
Similarly, you can also place Triggers, which are used when 
creating Rules or TS12Scripts. A trigger is point that can 
trigger an event such as a train starting off or sounding a 
horn. The can detect specific train passing a certain point 
and will then trigger other rules to be executed when that 
happens. See the section on Rules for more information. 

Simply Click LMB on trigger instead of trackmark in the 
selection list and then use exactly the same commands as for 
trackmarks to place your triggers as shown below. 

A trigger’s scope is defined by its radius which extends 
outwards from the trigger along the track. The default trigger 
radius is 20 meters and in most cases, this is sufficient. If 
needed, this can be altered and the advanced trigger tools.
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For a train to be visible to a trigger, the train must be 
within range of the trigger’s radius and there must be no 
obstructions such as a junction which can block the trigger’s 
view. Therefore caution is advised when placing triggers near 
junctions. 

Once placed, triggers will most likely be used in session rules. 
Several rules such as Trigger Check can monitor and react 
to trigger so it is possible to use this to initiate other events 
whenever a train enters a trigger for example.

Direction Trackmarks 
Direction trackmarks look exactly like regular trackmarks 
except they are yellow in color. They are used to indicate to 
the AI driver what direction is allowed on a section of track. 
Only the placement of the directional trackmarks is required. 
The AI drivers will automatically take the trackmarks into 
account. By placing direction trackmarks carefully, the AI 
trains can be restricted and coerced to take certain paths. 

Note: An AI driver will not go against a direction marker, 
so be careful where you place them, otherwise you could 
be blocking out a potential path that is needed to travel 
somewhere on your route. 
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Priority Trackmarks 
Priority trackmarks look exactly like regular trackmarks 
except they are purple in color. They are used to indicate to 
the AI driver the priority level of a section of track. 

All trains and track sections have a priority value in the range 
of [1 - 3] with the default value being 2. This priority value 
does not indicate a numerical scale of precedence, but rather 
is used for matching by the AI driver. This means the driver 
will try and take the train along track sections that have a 
priority equal to that of the train. 

The priority trackmark is the mechanism used to give a track 
section a priority value.

The AI driver will automatically take into account priority 
values so nothing else further is needed apart from setting 
up priority values on trains and track as needed. 

Note: The priority system is not an explicit path setting 
mechanism as a driver will still go over tracks of differing 
priorities if it can’t find a path along track with matching 
priority settings. 
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Advanced Trigger Management Tools 
The advanced settings of the Trackmark tools menu are used 
to set the radius of triggers. The radius defines the scope of 
the trigger and is explained in the previous section. 

Get Radius 
Click on the Get Radius tool and then Click LMB on 
a trigger. The trigger’s radius will now be in the text 
field adjacent to the button. Note that triggers have 

a default radius of 20 meters so this may not appear to have 
changed. 

Set Radius 
Click on Apply Radius then Click LMB on a trigger to 
apply the value in the radius field to that trigger. 

Adjust Radius 
Click on Edit Radius then Click LMB on a trigger 
and drag the mouse with the LMB still being held 
down to change the trigger radius. There is no visual 

indication of the radius as you drag it however. Use Get 
Radius to find out the new radius of that trigger. 
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9.5 Tools Menu (F5) 
The Tools Menu (F5) offers 
some additional tools for 
helping to create your TS12 
world. 

Ruler Management Tools
The ruler tool is used to 
measure track lengths, radius 
when laying curves, even 
the size of your basement or 
garage. 

Add Ruler (R) 
To add a ruler, 
Click LMB on Add 
Ruler (R), then Click LMB at your chosen point in 
your terrain and drag the mouse to the other end 

point for the ruler and release the mouse button. The ruler 
stretches out just like you experienced with spline objects. 

Changing the Scale of the Ruler 
To change the scale of the ruler, go into the Surveyor Main 
Menu and choose Edit Route. Change the units to real Scale, 
HO, OO or whatever scale you prefer. 

Move Ruler (T) 
To move the ruler, Click LMB on Move Ruler (T) 
and then Click LMB+H on either end of a ruler 
and then drag it to move that end of the ruler. 
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Delete Rule (Y) 
Use Delete Ruler (Y) to delete the ruler. Leaving 
a large number of rulers on your route can cause 
severe slowdowns, so make sure you delete 
them when they are no longer necessary. 

Camera Management Tools 
You can place static cameras, which focus on a section of 
track until the whole train passes by, or lineside (tracking) 
cameras, which pan across following the train movement.  
To select which camera to work with, click on either of the 
arrows in the middle of the tool list to switch between Static 
and Tracking camera mode. 

Place Camera (A) 
Before placing a camera, maneuver your normal 
viewpoint as close as possible to where you 
want to place the camera. Click on Place Camera 
(A), then Click LMB exactly where your Compass 
meets the ground. This places the camera in 3D 

space, and puts you automatically into Move Camera (M) 
mode. A Green box and a flashing green light appear. 

Move Camera (M) 
Use your zoom keys, and cursor keys to position 
the camera exactly as you want it to see in 
Driver, then Click LMB again to lock the camera 
in place. (Note that you stay in move mode until 
you choose to add another camera). Zoom out 

a little and you will see the 3D camera object. A red camera 
means it is a static camera, and green is a tracking camera. 
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The imagebelow shows the camera view and a Red static 
camera.

Delete Camera (D)
To delete an unwanted camera, select Delete 
Camera (D) and Click LMB on a 3D camera 
object. Cameras have a “range” in Driver of 150-
200 meters so careful placement is required. 

Copying and Pasting Tools 
Another very useful tool is the copy and paste function.
 
Select Area (B) 

Click LMB on Select Area (B) and Click LMB and 
drag to create a rectangle around the area you 
wish to copy. The white box shows the area that 
will be copied. 

Paste Mode (P) 
Click LMB on Paste Mode (P) and Click RMB to 
navigate around your terrain to the new location. 
Click LMB where you want the selection copied. 
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Cancel Selection (X) 
Click LMB on Cancel Selection (X) to cancel the selection. 

Paste Height, Textures, Objects or Track 
You can control what 
is and is not copied 
and pasted. 

You can copy height, textures, objects or any combination 
by selecting and deselecting the appropriate icons. These 
are “toggle” switches. Whilst in Paste Mode, click on Paste 
Height, Paste Textures or Paste Objects to include or exclude 
those elements from your paste function. The buttons will 
remain highlighted in bright green if toggled “on”. 

Paste Rotation (“[“ or “]”) 
You can also rotate your selection using the 
Paste Rotation dial (“[“ or “]”). 

Relative Height (L) or Absolute Height (S)
You can paste either relative or absolute 
heights by Clicking LMB on either icon 
to toggle between them. The default is 

absolute height. 
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9.6 Layers Menu (F6) 
Layers allow you to split 
design elements into easily 
manageable sections; they 
work in the same way as 
many graphical editing 
applications. 

You can lock layers so that 
anything associated with 
them cannot be edited and 
you can hide layers to make 
your route easier to work 
with.

Layers exist in either the 
route or a session. Layers 
applied to a route are 
available to all sessions for 
that route whereas layers 
applied to a session are only 
available for that session.

One of the advantages of using layers is the ability to set 
visible elements for a particular session, for example placing 
extra scenery or a side spur, which is specific to the session.

Note: Ground editing such as height, texture, water etc are 
separate from the layer system and cannot be affected by 
layers you create.
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Working with Layers
When you create a new route, you are by default adding 
objects to the route layer and so they will be present in any 
session created for the route.

To switch to working in a session layer, open the layers tab 
and Click LMB where it says “Session-layer”.  Objects you add 
will now be placed in the session layer.

Place a scenery object on a new route, Click LMB on the Edit 
Properties button (N). You will notice that besides an option 
to name the object, you can also see which layer the object is 
on. To move the object to another layer scroll to that layer by 
using the spinners on either side of the Layer name.

Add layer (A)
You can add extra layers by Clicking LMB on the 
Add Layer button. Enter a name for the new layer 
and select Route level or Session level in the popup 

dialogue and accept.

Tip: Layers can be dragged between Route and Session level 
in the Layers panel.

Delete Layer (D)
Select a layer and Click LMB on the Delete Layer 
button to remove it.

Merge Layers (M)
Select a layer and Click LMB on Merge Layers button. 
A popup dialogue gives you the option to choose a 
specific layer to merge with.
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9.7 Trains Menu (F7) 
In TS12, you may assemble 
consists and place them on 
track anywhere within the 
world you have created in 
Surveyor. The Trains tab is used 
for this purpose.

Building and Placing Trains 
Train Mode (T) 

Clicking LMB on 
the Train Mode 
(T) button in this 
tab allows you to 

assemble consists. A list of all 
engines and rolling stock is 
displayed below this button. 
Below the list are selection 
lists for Train Origin and Train 
Company. If “All” is selected in both of these lists, all consists 
and rolling stock will be displayed. By selecting a region or 
company in these lists the list displayed can be restricted to 
just that company or just that region or both. 

Add Train (A) 
Click on Add Train (A) to enable the building of a 
consist. Click LMB on the engine or rolling stock asset 
in the list that you would like to place on the route. 

Note that a picture of the asset appears in the Train Viewer 
window in the bottom of the tab. If you Click LMB on the 
asset in the Train Viewer window, the picture will rotate to 
show you different views of the selected item. Click RMB+H 
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on the item in the picture and move your mouse forward and 
back to increase and decrease the size of the item in the Train 
Viewer window. 

Click on a location on a track in your route and your item will 
be placed at that point. 

Tip: If there is a green checkmark with the letters “IND” 
shown in the lower left corner of the Viewer window, this is 
an indication that this is an “interactive” piece of rolling stock 
capable of participating with “interactive” industries. 

Tip: There is a little red button at the top right of the list 
labeled the Favorites Toggle.  If you click on this button, it 
turns Green and the list will display only those engine and 
rolling stock assets that you flagged as a Favorite using the 
Railyard module (described in the Engineers Guide). This 
allows you to eliminate those assets in which you have no 
interest making asset selection easier. Click LMB on the 
Favorites Toggle button once more to view all assets. 

Select items to be added to your consist by Clicking LMB on 
one end of the consist or the other to add engines or rolling 
stock. The Red and Green arrows adjust to mark the ends of 
the consist. Note that if you Click LMB too far away from the 
end of the consist, your addition will begin a new consist. The 
Green arrow indicates which direction the consist will travel 
when moved forward when operated in Driver. 

Tip: If you want to move the consist that you are building 
to another point on the track, use the Move Consist function 
available by switching to Consist Mode (described below)
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Move Train (M) 
Click LMB on Move Train (M) then LMB+H a train car.  
You can then drag the mouse to move the traincar 
anywhere that there is track.

Rotate Train (R) 
Click LMB on Rotate Train (R) to enable rotation of 
the engine or cars in a consist. Once enabled, Click 
LMB on any engine or car in a consist to change the 

direction in which it is facing.
 
Get Train (G) 

Click LMB on Get Train (G) to enable you to quickly 
find a copy of an engine or car already placed on 
the track. Once Get Train (G) is selected, Click LMB 

on any car in any consist on the route and that car will be 
selected from the list in the Trains tab and displayed in the 
Train Viewer window. This makes it easy to find any engine or 
car if you wish to add more of them to the route. 

Delete Train (D) 
Click LMB on Delete Train (D) to enable you to delete 
any engine or car already placed on the track. Once 
Delete Train (D) is selected, Click LMB on any engine 

or car in a consist on the route and that engine or car will 
be deleted. The consist will shorten if necessary to close the 
space taken by the car or engine and keep the consist intact. 

Decouple Carriage (X) 
Click LMB on Decouple Carriage (X) and then move 
the cursor to a point near the connection between 
two items in a consist until an image (colored Red) 
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of a coupler appears. Click LMB on the coupler and it will be 
seen to open. Additional Green and Red arrows will appear 
above the point of uncoupling to mark off the two consists 
that have now been made from the one original consist. 

Note: To re-couple these consists or any two trains, use the 
Move Train (M) button described a bit later. 

Edit Properties (P) 
Each engine or car in TS12 can be assigned 
properties. Click LMB on Edit Properties (P) to enable 
the setting of properties for engines and vehicles. 

Click LMB on an engine or car in a consist on the route and a 
new Properties window opens up. 
A name will be assigned to the engine or car by adding a 
number to its name as found in the list of locos and cars. 
You may change the name to any unique name that you 
wish. Names for locos and rolling stock persist only for this 
particular session. 

You may also change the running number for an engine or 
car by Clicking LMB on the underlined text after the words 
Running Number. A new window opens in which you may 
enter the number of your choice. If the engine or car has been 
designed with a number that is changeable, the number will 
change to match your selection. 
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Train Management Tools 
Consist Mode (C) 

Click LMB on Consist Mode (C), one of two large 
buttons at the top of the tab, to enable the 
placing of complete consists available in the list 
of consists below the button. 

A consist window appears at the bottom of the screen which 
display the currently selected consist in the list at the top of 
the tab. 

Click LMB on any consist in the list and it will appear in the 
consist window for your reference. 
You can Click LMB on any of the vehicles in the consist 
window to change their direction. Click LMB and hold on a 
vehicle and drag it outside of the consist window to remove 
it from the consist. 

Rename Consist Template 
Click LMB on the Rename Consist Template 
(large gray colored button labeled 

“Rename” under the consist list) button to rename the 
consist currently selected in the list. A window will open up 
in which you may do the renaming. 

Delete Consist Template 
Click LMB on the Delete Consist Template 
(large grey colored button labeled Delete 

under the consist list) button to delete the consist currently 
selected in the list. A window will open up in which you will 
click on the Yes or No button to confirm or deny the deletion. 
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Add Consist (A) 
Click LMB on Add Consist (A) to add one of your 
chosen consists to your route.  Click LMB at any point 
on the track to place the complete consist there. 

Move Consist (M) 
Click LMB on Move Consist (M) to enable you to move any 

consist on your route along the track to adjust its 
starting position. Click LMB+H on any consist to 
move it back and forth along the track. 

To join two separate consists together, move one consist 
along the track until it touches the other then release LMB. 
The two sets of associated Red and Green arrows that marked 
out the will then combine into one set for the new consist. 

Rotate Consist (R) 
Click LMB on Rotate Consist (R) to enable the 
rotation of any consist so that it is pointed in the 
other direction. Click LMB on the consist to change 

its direction. The Red and Green arrows will also switch 
positions to reflect the rotation. 

Get Consist (G) 
Click LMB on Get Consist (G) to add new consists to 
the consist list.  This also allows the quick selection 
and replication of consists already within the route.

If the consist is already in the consist list, it will be selected 
in that list so that it is easy for you to add to the route.  If 
the consist is not in the list (likely to be because you have 
assembled and placed it previously in Train Mode), you may 
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now give it a name in the window that opened up and the 
consist will be added to your list for future use. This is a great 
way to build up a list of your favorite consists for use on many 
different routes. 

Tip: When you name a consist, that name persists in the 
consist inventory across other routes and sessions where it 
is used. 

Delete Consist (D) 
Click LMB on the Delete Consist (D) button (not to 
be confused with the big gray colored Delete Train 
Template button in the middle of the Tab) to enable 

the deletion of consist placed on the track. Then Click LMB on 
any consist to remove it.

Decouple Vehicle (X) 
Click LMB on the Decouple Carriage (X) button to 
enable the decoupling of parts of a consist to break 
them up into smaller consists. Then Click LMB on 

the coupler icon that will appear when you move the cursor 
between cars or engines in a consist. You will see that the red 
and Green arrows will show that you now have two consists. 
Use Move Consist (M) to move them apart if you wish. 

Change Heading (H) 
Click LMB on the Change Heading (H) button to 
enable the changing of the heading of a consist. 
Then Click LMB on any consist and the Green and 

Red arrows will move to opposite ends of the consist setting 
the direction that will be forward when the consist is started 
in Driver mode. 
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11 - SESSION RULES AND MANAGEMENT 
Introduction 
One of the powerful features of TS12 is the ability to apply 
Rules to a Session. TS12 ships with some standard Rules 
to get you started, but like other assets, new Rules will 
become available for download enabling you to expand the 
possibilities. 

What can rules do? Well they can set basic parameters in a 
Session including which driver is in each Train, the weather 
state, control method, set up industry dependencies, what 
Driver Commands are available in the Driver Module and set 
the time and time rate. 

They can also be combined, so that when a particular train 
hits a trigger the weather may change or a sound may be 
played. 

Then there is the ability to pull HTML pages and sound files 
into the game. On top of that the Rules can be arranged to 
occur in a particular order. 

All of this adds up to an open-ended system to manipulate 
the Driver experience, even for someone who has no real 
programming experience. We expect Rules to be one of the 
strongest features of TS12 as there really is no limit to what 
can be done using Rules. 

Note: If you don’t want to have anything to do with Rules 
(Keep It Simple) then fear not, a default set of rules including 
assigning Drivers to Trains is automatically saved when you 
save a Session in Surveyor. 
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In this section we will describe how to use the Edit Session 
interface to add, delete and edit rules. 

Edit Session 
Recall that a Session is different from a route as it may include 
for example different trains. Click LMB on Edit Session on the 
Surveyor Menu and a window opens in which you can modify 
the properties associated with a Session.  From here, you 
may change the Session Name, add a Description, and the 
operating Rules to be used in this session. 

Adding Rules 
Click LMB on the Add Rule button (labeled 
“Add”) to add a new rule to the session. 
A window opens up with the set of rules 

that you can choose from. Click on any one of the rules to 
add it to the list of rules to be included in this session.

Once you have added the rules you want, it is time to edit 
them to make them specific to your needs. 
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Editing Rules 
Each rule may have a number of 
parameters associated with it that need 
configuring in order to modify it to your 

requirements. Highlight the Rule in the list that you wish to 
modify and Click LMB on the “Edit” button to bring up the 
Rule’s Properties Window. All editable parameters are made 
available to configure in this window. By clicking on the 
available hyperlinks, you can edit the rule’s parameter. 

You can also edit the name of any Rule by Click LMB on its text 
descriptor and typing in its new name. This can help identify 
a particular Rule in a complex Rule arrangement. Note that 
it is possible to have multiple rules of the same type in a 
session where each rule instance has its own configuration. 
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Managing the Rules 
The Rules in your Rules List can be further manipulated by 
the four command buttons at the bottom of the Edit Session 
window. 

The Outdent, Indent, Promote and Demote commands are 
used to order the Rules in a Hierarchical and Ordered fashion. 
Some rules (like the Trigger Check Rule) require indented 
child rules immediately below them. This determines what 
happens when the Trigger Check Rule is activated. Other rules, 
like the Ordered List Rule also use child rules below them to 
fulfill its purpose. The child rules below the Ordered List Rule 
can be re-ordered by using the “Promote” and “Demote” 
buttons to alter the order in which they are executed. 
As you can imagine the combinations are limitless. 

You can also Delete Rules altogether by selecting the Rule 
with a Click LMB and then Click LMB on the “Delete” button.
 
Outdent (Rule) 

To Outdent a Rule by one level, select the Rule by 
Click LMB to highlight it and then Click LMB on 
the “Outdent” button. This removes the Rule from 

dependency upon the Rule it was Indented under. 

Note: Be careful here as Rules subsequent to the Outdented 
Rule that are Indented will now only be executed if the 
Outdented Rule conditions are met. Use the “Promote” and 
“Demote” buttons to reorder the Rule List if this is not the 
desired outcome. 
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Note: The top level of the Rule Hierarchy is reached when the 
Rule is lined up as far left as it can get (Further presses of the 
Outdent button have no effect). 

Indent (Rule) 
To Indent a Rule by one level, select the Rule by 
Click LMB to highlight it and then Click LMB on 
the “Indent” button. This makes the selected Rule 

dependent on the next higher Outdented Rule above it. The 
indented Rule will not be executed unless the Rule next up in 
the Hierarchy is activated.
 
Promote (Rule) 

To Promote a Rule up the Rule List select the Rule by 
Click LMB to highlight it and then Click LMB on the 
“Promote” button. Once the Rule has reached the 

top of the Rule list, it can no longer be Promoted.
 
Demote (Rule) 

To Demote a Rule down the Rule List select the Rule 
by Click LMB to highlight it and then Click LMB on 
the “Promote” button. Once the Rule has reached 

the bottom of the Rule list, it can no longer be Demoted. 

Delete (Rule) 
If you want to remove a Rule from the list 
select it by Click LMB on it and then Click 
LMB the “Delete” button. A dialogue box 

pops up confirming the deletion. Click LMB the “Yes” button 
to confirm the deletion or Click LMB the “No” button to 
cancel.
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12 - Favorites
Favorites allows you to flag objects for easy listing in both the 
routes/sessions selection menus as well as in Surveyor.

The Routes/Sessions Menu
When entering the main menu for routes and sessions 
favorite items are highlighted by a gold star next to their title. 
You can filter the lists by clicking on the gold star at the top of 
the column. Only favorite items are shown when lit, while all 
items are shown when unlit.

Surveyor Favorites
Items such as locomotives, scenery objects, structures, 
industries etc may also be set or unset as a favorite item.

Adding & Removing Favorites
In order to edit your favorites, you will need to enter Content 
Manager by selecting “Content” from the Trainz launcher. 
In order to see all the current favorites you will need to run 
a search by selecting rating and then 5 stars and L-Clicking 
“Apply”.

To remove an item from your favorites list, R-Click on an item, 
hover the mouse over rating and select 0 stars.

To mark an item as a favorite, perform the same steps as 
above but select 5 stars.
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13 - CONTENT and ASSETS 
Content broadly describes anything that you can add to 
your TS12 software that will expand the collection of objects 
available to you within the game. This includes locomotives, 
rolling stock, track, vehicles, people, buildings, bridges, 
tunnels, routes, rules, sessions, scenarios etc.

Content is created by community members just like you and 
is available from many places on the Internet. The major 
source of content is a huge library of over 150,000 objects 
that can be accessed using Content Manager. This section of 
the manual will tell you a little more about identifying and 
utilizing new content for TS12.

The KUID System 
Whilst you should not need to know much about the KUID 
(or Koolthingz Unique IDentifier) system, it is a term you will 
come across if you start delving into the world of custom 
content. A KUID is simply a way of identifying content for 
your TS12 software. Here is an example: 

<KUID:43750:12345:02> 

The first part of the KUID (43750 in this example) identifies 
the content creator, so all content from any particular author 
will have the same first set of digits. When you register at 
Planet Auran, you will be given a unique content creator I.D. 
that you can find in your User Profile.

The second set of digits is the unique identifier for a specific 
asset from the author. 

196



13 - CONTENT



 AND




 ASSETS


There is also a third number. This is the item’s version 
number and is used to allow Content Creators to update their 
creations without having to introduce a new KUID.
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14 - CONTENT MANAGER 
14.1 Introduction 
Content Manager (CM) can be accessed from the Trainz 
Launcher. Click on “Content” and take a look at the layout.
CM has a number of functions rolled into one, integrated 
package giving you control and access to the many thousands 
of assets available for Trainz. The main functions that CMP 
offers are: 
.	 • Download Station Index 
.	 • Downloading Content 
.	 • Content Management 
.	 • Archiving/Backup 
.	 • Uploading Content 
.	 • Creating/Editing/Verifying Content 
We will examine each of these functions below. 
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Menus 
The menu items generally duplicate in-game functions. Some 
menu actions have keyboard shortcuts which are shown to 
the right of the action listed in the menu.  Each menu is item 
is described in detail ahead.
 
Status Bar 
Displays warning/error messages in red/orange/yellow as 
well as a running total of items displayed out of the total 
items available including those on the Download Station (DS).  
 
Main View Panel 
The Main View panel can show assets in text or thumbnail 
mode. Click LMB on the button on the title bar to select one 
or the other. 

The thumbnail view shows assets via a thumbnail picture as 
uploaded to the DS. Thumbnails are downloaded from the 
DS as required, so they may take some time to appear. 

The text view is more like a spreadsheet with columns 
containing various information on each asset. You can elect 
to view more or less columns by right-clicking on the header 
and selecting the columns to show or hide. The column 
width can be adjusted by dragging the vertical dividers in the 
header. The order of the columns can be changed by dragging 
and dropping the column header to a new location.

Just under the title bar are a number of tabs. Clicking on 
these tabs immediately filters the current assets in the Main 
View panel which correspond to search filters as described in 
the Sorting, Searching and Organizing Content section.
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Action Panels
The width of the panels can be adjusted by dragging the 
vertical divider to the right of the Action panels. There is a 
minimum width.

You can view/hide the Action panels by toggling with the TAB 
key or from the View menu. 

Each of the Action panels can be opened and closed by 
clicking on the icon in the Action panel’s header bar. The 
action panels are: 

Download Helper 
Used to download files from the Download Station. See 
section on the Download Station and Downloading for 
details. 

Search 
Used to find assets. See section on Sorting, Searching and 
Organizing Content. 

Asset Details 
Drag an asset(s) from the Main View panel onto this panel to 
see the asset in more detail, including a thumbnail picture. 
Use the < and > navigation buttons to scroll through multiple 
assets. You can rate an asset by clicking on the star rating 
(1 to 5 stars), alter its name and description as well as view 
license information. 

Uploads 
Used to upload assets to the Download Station. See section 
on Uploading for details 
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Archiver 
Used to archive/backup assets. See section on Archiving for 
details. 

Pick List 
This is used as a “clipboard” for commonly used assets. Drag 
and drop an asset(s) from the Main View onto the Pick List 
panel to add it. You can remove an asset by clicking on the “-” 
button to the right of the asset name or remove all assets by 
clicking on the Clear button. To view the Pick List assets in the 
Main View panel, click on the View In Main List button.  This 
Pick List can be shared with and used by Surveyor.

Icons 
Throughout CM there are a number of icons with specific 
meanings which help you quickly identify an asset’s 
attributes. All icons have tool tips so if you’re not sure what 
the icon represents, hover over it with the mouse cursor. 

Category 
These icons denote the category of the asset, be it a train, 
route or other component of the Trainz world. 

Status 
These icons give you information on the Location, Archive, 
Modification, Version, Editing, Origin and Error status of the 
assets. 

Ratings 
A zero to five star rating for an asset. Adjust the rating by 
selecting the number of stars for an asset in the Asset Details 
action panel. 
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Settings 
You can bring up the Settings window by either clicking on 
the Settings using File -> Settings. The settings are divided 
between four tabs:

Archives 
Lists all the archives of which CMP is aware. You can Add, 
Remove or Update archives. Note that removing an archive 
only removes it from the list, it does not remove the archive 
file. 

Filters 
Lists all the search filters including the default ones. You 
can remove individual search filters (default or custom) and 
restore the default filters. Warning! Restoring the default 
filters will also remove any custom filters. 

Internet 
Enter your Planet Auran username and password and your 
internet connection type to get access to the Download 
Station while on-line. Don’t have a Planet Auran account 
yet? Then click on the “Register Now!” link to register and 
get access to the Download Station and Community Forums 
- it’s easy and free! 

If you have a First Class Ticket (FCT) this tab also shows how 
many days are left on the FCT and your total downloads 
(right-click to reset this). If you don’t have a FCT it shows your 
daily download total and the limit (currently 100MB)…click 
on the ticket to open a browser window which allows you to 
upgrade to a FCT.
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All registered users of TS12 gain free access to the Download 
Station. However, we limit your daily downloads to 100 MB 
and a limited maximum speed. 

You have the option of upgrading your Download Station 
access with a First Class Ticket (FCT). The FCT gives you 
unlimited downloading from the Download Station. What is 
more, the downloads are at broadband speeds so you get 
what you want faster.

Miscellaneous 
Here you can choose Main View settings, icon sizes, sound 
settings and delete confirmation choices. 

Then there is the option to remove assets from the Download 
Helper pane automatically once downloaded, what to do with 
assets that are open for edit when launching TS12, ability to 
choose a custom script editor and whether you want search 
filter parameters to be applied automatically or require the 
use of the Apply button. 
 

14.2 Sorting, Searching and Organizing Content 
Sorting 
You can sort on a column by clicking on the column’s heading. 
Subsequent clicks toggle the direction of sort, ascending or 
descending order. 

Searching 
The Search panel allows you to put in one or more search 
parameters to find the content you are looking for quickly. 
Results of the search are immediately shown in the Main 
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View panel unless the Settings for CMP have been selected 
so that the user needs to click on the Apply button to perform 
the search. 

Default Search Filters 
A number of default Search Filters are defined for the most 
common searches. These are listed in the form of Tabs in the 
Main View panel. Clicking on the tab immediately applies the 
named search filter. 

Note that you can modify a default Search Filter by adding 
or removing search parameters. Let’s say you select the “All” 
Default Search filter and add an extra search parameter in 
the Search panel. When you do this, the Search Filter tab 
changes to “Current Search” to indicate that the assets being 
viewed no longer reflect the Default Search filter. 

Adding a Search Parameter 
The default Search panel has a search parameter of “Name” 
with no value entered. 

To change the search parameter click on the drop down 
list and select the required parameter from the list. If the 
parameter allows a value to search on, then click on the 
value input box immediately to the right of the parameter 
and select or enter the required value. 

To add another search parameter click on the “+” button to 
the right of an existing search parameter and a new search 
parameter line appears with the default “Name” parameter 
with no value set. 
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Each new parameter and value must be satisfied for items 
to show in the Main Panel view, in other words all search 
parameter lines are “AND”. 

There is also a “?” button to the left of the parameter name. 
If this is enabled, you can click on it to add a logical operator 
of “does not equal” to the parameter e.g. “does not equal” 
Built-In will show only those items that are not Built-In to 
TS12. 

Tip: when searching on Author ID, put in the author’s UserID 
(#nnnnnn) rather than their username. Once the items have 
been found, CMP downloads further information about the 
asset including the author’s username. Thereafter you can 
also search using the author’s username. 

Removing a Search Parameter 
To remove a search parameter, click on the “-” button to the 
right of the search parameter. 

To remove all the search parameters click on the Reset 
button. This returns the Search panel to its default of “Name” 
parameter with no value entered. 

Current Search and Saving Search Filters 
As soon as you modify an existing search filter your search is 
displayed on the Current Search tab. 

You can also save your own custom searches and they will 
appear as one of the tabbed Search Filters in the main view. 
Here is how:
Once you are happy with the parameters you have selected 
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for your custom search, click on the Save button to bring up 
a Save Filter dialogue. Enter a name for the search filter and 
click on the Save button. 

The search filter is now added to the tabs in the Main View 
panel. You can manage your Search Filters in the Settings 
dialogue (see Settings). 

Keywords 
You can use keywords to enhance the description of assets 
and make them easier to find. By default all assets have 
their name text as keywords. Content Creators can also add 
keywords to their content when they create assets to assist 
in finding them amongst the thousands available. 

You can also add your own keywords to content by right 
clicking on one or more selected assets and clicking on Edit 
Keywords in the context menu. Enter the desired keyword 
and click on the Add button. You can continue adding 
keywords in this way to the selected content. 

Once the keywords have been added, in the future you can 
use the Keyword search parameter to find the relevant items 
quickly and easily. 

14.3 Disabling, Enabling and Deleting Assets 
Once an asset is installed on your computer it is available 
within Trainz for use in Surveyor. TS12 comes with several 
thousand items of built-in content which are available in-
game. 
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Note: Some built-in content is not available for use in Surveyor. 
This is determined by the content creator who contributed 
the item. 

For some, this large quantity of assets can be overwhelming 
and you may want to limit what you see in Trainz, or perhaps 
you have no interest in a particular country’s locomotives 
and rolling stock. 

To reduce the number of assets visible in-game you can use 
the Disable or Delete function in CM. 

Note: When disabling or deleting items you may be “breaking” 
assets that are dependant on that item. To check if the item 
you are about to disable/delete is a dependency, select the 
item, right-click and choose View Dependant Assets. This 
brings up a dialogue box listing the assets that are dependant 
on that item. Do you still want to disable/delete it? 

Disabling an asset means that it is still present on your 
computer, but not available within Trainz. To disable an asset, 
select it (one or more) and click on the Enable/Disable button 
on the tool bar. To make a disabled asset available in Trainz, 
select it (one or more) and click on the Enable/Disable button 
on the tool bar. 

Deleting an asset removes the asset completely from your 
computer. Of course this makes it unavailable in Trainz. If it 
was a Download Station item it will still be listed in CMP, but 
you will have to re-download it to make it active in the game. 
To delete an asset, select it (one or more) and click on the 
Delete button on the tool bar. 
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WARNING: Make sure you back up your custom (non-DS) 
assets. Once they have been deleted there is no way to 
recover them. 

Note: Built-in assets cannot be Deleted, but they can be 
Disabled. Installed, non-built-in assets can be Disabled or 
Deleted. 

Tip: Want to just quickly see an asset in Trainz from within 
CM? Select the asset and right-click, from the context menu 
choose View In… and then the relevant Trainz module. After 
viewing the asset, return to CM by quitting out of the Trainz 
module. Note that assets must be on your local machine to 
do this as you cannot view items you haven’t downloaded.
 

14.4 The Download Station and Downloading 
The Download Station, at time of writing, has over 150,000 
assets available for you to download and add to your Trainz 
software. CM maintains an index of assets on the Download 
Station which is constantly being updated via the internet as 
new assets are added. 

Important! Before you start downloading from the Download 
Station, you must register your TS12 serial number with Auran 
and enter your username and password in the Internet tab of 
the Settings window. 

Use the searching and sorting capability of CM to browse 
through the assets and find what you are looking for; see the 
section on Sorting, Searching and Organising Content. 
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Selecting Assets to Download 
Downloading assets has never been simpler. Just select the 
items you want to download in the main view panel (you can 
select multiples by using the SHIFT and CTRL key modes), 
then drag and drop them on the Download Helper panel. 

You can also add assets to the Download Helper panel by 
right clicking on them and selecting Download from the 
context menu. 

A Word About Dependencies 
Some assets require other assets (dependencies) to make 
them complete, for example a locomotive needs bogies, 
engine sounds, engine specifications etc. CM takes care 
of this automatically. When you drop an item into the 
Download Helper panel, CMP checks the selected assets for 
dependencies and then adds them below the parent asset so 
the asset is complete.

Assets with dependencies have a “?” icon to the left of 
the asset’s name. Clicking on the arrow head will show the 
dependencies in the main list.

If you drag a lot of items onto the Download Helper, it may 
take some time to check all the assets for dependencies and 
add them. 

If you already have the assets (parent or child) on the local 
machine the Download Helper will not download them again. 
If the asset is in a known Archive (see Importing Content and 
CDPs Archiving), when you start the download process CM 
will get the required assets from the archive. 
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To view dependencies for a local asset, select it and Click 
RMB.  Choose View Dependencies from the context menu.  
You can view the dependencies in the main list by clicking on 
the ‘View in Main List” button. 

Tip: After viewing the dependencies in the main view you can 
return to your previous view by clicking on the “Click here to 
resume your previous search” text in the Search panel.  This is 
true of assets that have been correctly created and they and 
their dependencies are on the Download Station.

Managing Your Download Helper List 
As you add assets to the list and their dependencies are 
found, the total size in MB of the selected assets are shown 
at the top of the Download Helper panel. 

You can remove individual items from the list by clicking on 
the “-” button to the right of the asset’s name. Removing an 
asset removes its dependencies too. Removing a dependency 
just removes it, although the parent asset may not work 
properly if the removed dependency was critical. 

You can remove all the items in the list by clicking on the 
Clear button. 

Assets are downloaded in the order they are arranged in 
the Download Helper panel list. To change the order of the 
list, just drag and drop the assets until they are in the order 
you desire. Note that dependencies can only be arranged 
beneath the dependency’s parent asset. 
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To keep an item in the Download Helper list, but not 
download it immediately, uncheck the checkbox to the far 
left of the asset. Use this feature to manage your download 
quota if you don’t have a First Class Ticket. 

Starting and Stopping a Download 
Once you have selected the assets for download and 
arranged your download list you can begin the download by 
clicking on the Start button. CM contacts the DS and begins 
downloading assets. As each asset is downloaded a blue bar 
shows the download progress for the asset and the DS icon 
to the right of the asset’s name is replaced by a Local icon to 
indicate success in downloading/installing the asset.

Once the download has started you can stop it by clicking 
on the Stop button. Assets not yet, or partially downloaded, 
remain in the Download Helper list ready for download. To 
resume the download, just click on the Start button again.

Once the downloads are complete you can clear the list by 
clicking on the Clear button, or this can be done automatically 
by checking the Remove Downloaded Items from the List 
Automatically checkbox on the Miscellaneous tab in Settings. 

14.5 Importing Content and CDPs 
To import existing content, either in folder form, or as a CDP 
there are two options available in the File menu.

Import Content allows you to specify a folder containing 
the content and upon confirmation, CM will import all the 
content it finds in the selected folder and its sub-folders. 
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A dialogue box appears listing the items that have been 
imported. View the items in the main list by clicking on the 
button in the dialogue box.

Import CDPs allows you to select one or more CDP files in an 
open file dialogue. CM imports the asset(s) in the CDP file(s) 
and a dialogue box appears listing the items that have been 
imported.  You can view the items in the main list by clicking 
on the “View in Main List” button in the dialogue box.

Archiving 
The Archive function in CM allows you to “back up” your 
downloaded or custom content.  It is not designed as a way 
of distributing content to others.  For that, use the CDP 
method instead.

Why not use CDP’s to archive your content? You could, but 
the advantage of archives is that CM knows about what you 
have put in your archives. Every time you create an archive, 
CP records what assets are in the archive and where the 
archive has been saved.

Then, when you need the asset (if you have deleted it), 
instead of downloading the asset again needlessly, it takes 
the asset from the archive. If you have moved the archive, 
say to a CD-R, then a dialog box appears requesting you select 
the location of the archive. CM then updates the location of 
that archive for use next time.
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Some points about Archives beyond what has already been 
mentioned above:

1) When an asset is archived it is flagged with an archive 
status icon.
2) Built-in assets cannot be archived. 
3) If an asset is already installed and an archive containing 
that asset is installed the already installed assets are marked 
as “open for edit”. 
4) You can use the Archive Settings (select Settings) to add or 
remove archives as well as update their location.

Creating Archives 
Select the assets you want to archive and drag them onto the 
Archiver panel.  If the asset(s) have dependencies you will be 
prompted to select which item’s dependencies you want to 
include in the archive. You cannot archive built-in assets.

Another method is to select the asset(s) you want to archive 
in the main list, then right click and choose Archive from the 
context menu. The asset(s) are added to the Archiver panel. 
Any unwanted asset(s) can be deleted from the archive list 
by clicking on the “-” button to the right of the asset’s name. 
When you are ready to create the archive, click on the Archive 
button in the Archiver panel and you will be prompted to 
name and save the archive to a location.

The named archive and its location are stored in CMP’s 
archive list for future reference.

Note: Assets that are “open for edit” need to be committed 
before being able to be added to an archive.
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Installing Assets in Archives 
There are a number of ways of installing/restoring assets in 
an archive. 

1) In CM, select the archive from a list which appears when 
clicking on the “?” button in the Archiver panel header. 
2) Double-click on an archive (.cmpa) file in Explorer. 
3) Drag and drop an archive onto CMP. 

In each case the action loads the selected archive into the 
Archiver panel and a dialogue box appears asking if you want 
all of the assets installed. You can select the “all” option in 
the dialogue or you can bypass this dialogue and then select 
which assets to install in the Archiver panel…select the assets 
by highlighting them (you can use the Shift and Ctrl keys 
to select multiple) , then right-click and choose “Install”. A 
dialogue box confirms the assets have been installed.

14.6 Creating and Editing Content 
Note! Content Creation and editing is something learned 
over time by the advanced Trainz user. It’s not within the 
scope of this manual to provide all the steps to successful 
content creation.  The following sections are only a guide to 
the simple basics of the Trainz format, and how the available 
tools relate to them.

Tip: The Trainz Forum is a great place to meet other would 
be creators and also learn tips and tricks from the masters.  
There is also a host of official and community developed 
guides and tutorials freely available on the web.
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First it is important to know how assets are stored for use in 
TS12.  TS12 stores its assets in a database, the Trainz Asset 
Database (TAD).

To create new assets they must be developed and then 
committed to the TAD before they can be used in TS12.

Similarly, assets that you want to edit need to be “copied” 
out of the TAD (Open for Edit), edited and then committed 
back into the TAD before the changes can be seen in TS12.

To help create valid or content for TS12 we have developed 
Content Creator Plus (CCP) which checks content to make 
sure it meets our content creation guidelines before it is 
committed to the TAD. See the section on CCP for more 
information.

To Commit an asset to the TAD that is Open for Edit, select 
the asset(s) in the Main View and right-click, then choose 
Edit -> Commit from the context menu.

Tip: Keyboard shortcut to commit one or more selected assets 
is Ctrl-M.

An asset modified locally is flagged with a Modified status 
icon in the Main View.
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Creating Content 
Besides importing new content/CDPs you can create new 
content for TS12 in a number of ways.

File -> New 
Use this option to create an entirely new asset from scratch.  
Selecting File -> New from the menu will launch Content 
Creator Plus (CCP) and begin the creation process.  See 
section 15 for more information on Content Creator Plus.  
Once the asset has been created it needs to be Committed to 
the TAD to become available in TS12.

Create New Version 
Use this option to update an existing asset. Select an asset 
in the Main View and right-click, then choose Create New 
Version from the context menu.

A new version of the asset is created which is Open for Edit 
and the KUID version for the new asset is incremented. You 
can now make the desired changes and then Commit the 
new version to the TAD. This new version will automatically 
obsolete the older version it was created from.

Note: You can only use this option with assets you have 
created. 

Clone 
Use this option to base a new asset on an existing asset. 
Select an asset in the Main View and either right-click then 
choose Clone from the context menu or click on the Clone 
button in the tool bar or choose the File -> Clone option in 
the menu.
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A new asset appears with a KUID based on your user ID and 
in Open for Edit mode. Notice the Clone status icon appears 
in the CM main view. You can clone any local assets. 
 
Editing Content 
There are a range of options when it comes to editing 
content. Similar to creating content, once the content has 
been edited, it needs to be committed to the TAD before the 
changes are manifest in TS12.

Open for Edit 
Use this if you want to extract the asset out of the TAD. To 
do this select an asset in the Main View and right-click, then 
choose Edit -> Open for Edit from the context menu. The 
asset is flagged with an Open for Edit status icon.

Behind the scenes your TS12\User Data\Editing directory 
now has a copy of the asset sitting in a folder. If you want to 
automatically open the folder in Explorer use the next option 
“Edit in Explorer”.

Edit in Explorer 
This is the same as the Open for Edit option, but also opens 
up an Explorer window with the Open for Edit asset’s folder 
showing. To do this select an asset in the Main View and Click 
RMB, then choose Edit -> Edit in Explorer from the menu.

Edit in Content Creator Plus 
This is the same as Open for Edit, but in addition loads the 
selected asset into CCP. To do this select an asset in the Main 
View and right-click, then choose Edit -> Edit in Content 
Creator Plus from the context menu.
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Edit Script 
This is the same as Open for Edit, but also opens the asset’s 
script file ready for editing. The default script editor is 
Notepad, but you can also select a custom editor in Settings 
-> Miscellaneous.

Select an asset in the Main View and right-click, then choose 
Edit -> Edit Script from the context menu. If the asset selected 
doesn’t have a script associated with it you will get an error 
message and the asset will be left in the Open for Edit mode.

Reverting Content 
When an asset is Open for Edit it can be returned to its 
previous state in the TAD by using the Revert option.

This essentially deletes the asset’s editing folder and turns 
off the Open for Edit flag. To Revert an asset select the asset 
in the Main View and right-click, then choose Edit -> Revert 
from the context menu.

Another Revert option, available only for built-in content, is to 
Revert to Original. In this case the modified asset is reverted 
back to its original state as supplied with TS12. Select a built-
in asset in the Main View and right-click, then choose Edit -> 
Revert to Original from the context menu.

WARNING: When reverting assets all changes made to the 
asset are lost. In the case of Revert to Original this means any 
and all changes, in the Revert case it means all those changes 
made since the asset was last committed to the TAD.
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Uploading 
The uploading process has now been streamlined and is 
integrated with the Download Station and Planet Auran.

Important! Before you start uploading to the Download 
Station, you must register your TS12 serial number with Auran 
and enter your username and password in the Internet tab of 
the Settings window. Your User ID (in the Settings|Internet 
tab) is automatically entered based on your registration 
details.

Firstly select one or more assets that you want to upload in 
the Main View, then either drag and drop them to the open 
Uploads panel or right-click and choose Upload from the 
context menu.

The selected asset(s) will be moved to the Uploads panel. A 
dialogue box appears giving you the option to also include 
the selected asset’s dependencies. Also if any of the assets 
are broken or are not your assets then these assets will be 
flagged in the dialogue box with appropriate error messages.
 
Similar to the Download Helper and Archive panels, you can 
remove assets from the Uploads panel by clicking on the “-” 
button to the right of the asset name.

Once you have your assets organized in the Uploads panel, 
click on the Upload button to begin the uploading process.

Firstly a Planet Auran license agreement appears. Once you 
have read the license and accept it click on the Accept button. 
In CM a dialogue box opens showing the success or failure of 
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the upload. If successful, at the same time, CM logs you onto 
Planet Auran and the secure website opens up in a browser 
window at the Your Content page.

In the Planet Auran browser window you can click on the 
“Unprocessed” button to confirm your asset has been 
received. It will have a generic name “upload.cdp” and will 
also have a time/date stamp so you can identify it.

You can still stop the upload process at this point, by clicking 
on the “Do not process” link.

Once a day unprocessed uploads are processed by the 
Download Station and the asset now is moved to the “Waiting 
for Approval” station. This is where the content is manually 
checked for any issues and if it passes the manual inspection 
the asset is marked as Approved and you will receive an email 
confirming its approval. Please note that as this is a manual 
process, the time between processing and approval can vary. 

We try and get this done quickly, but we also have weekends, 
public holidays, sick days, urgent matters and sometimes an 
overwhelming amount of content to approve, so we ask for 
your patience.

Once you receive an email that your asset(s) have been 
approved the asset is usually available on the Download 
Station within six hours.
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15 - CONTENT CREATOR PLUS 
Introduction 
Content Creator Plus (CCP) is a program launched from within 
Content Manager to generate a config.txt file for Trainz model 
assets, or to edit and amend existing config.txt files.

Trainz model assets are classified under different Kinds. Each 
Kind has particular data requirements to be entered using 
the appropriate input dialogue boxes. A data Container is a 
portion of the config.txt file that covers a particular function 
for the model, for example the model mesh files to be used, 
or the effects to be applied.

Within the Container the commands that Trainz recognizes 
are called Tags. Each Tag indicates data values to be used 
or a function to be implemented. Dialogue boxes and drop 
down menus are provided for the data entry and inbuilt error 
checking will indicate faulty data or entries. An error message 
display will assist in creating a correctly configured model.

Certain input fields are mandatory, while others are optional, 
required for more complicated models or additional model 
functions. The program can also load a previously created 
config.txt file, for validation, amendment, additions, or as the 
basis of a new model configuration file.

The program validates the config.txt file as acceptable for the 
Download Station prior to uploading a model or package.

The Content Creator’s Guide (CCG) is separately available, for 
information on the tags that may be used for each Kind, their 
functionality, and the data values required. 
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Starting a New Model Asset

From within Content Manager launch Content Creator Plus 
using the File -> New option in the top menu.

A screen showing the different Kinds of assets that can be 
created will be displayed.
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Choose the correct Kind for the model, and the main input 
screen will be displayed.

The main input screen is divided into different display areas: 

Tree view
Tag space
Error Message Box

The screen sections of the program are fully resizable by 
dragging the frame edges.
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Configuring the Program
The first step is to use the Preferences menu to enter your 
Personal Details, located in the top Menu under Edit -> 
Preference. These are optional personal details you may 
enter. The fields will auto fill the values in the config file, 
when the appropriate tags are chosen from the drop down 
menu. 
 
Enter your name or forum name in the Name box.
The Organisation entry may be “My Trainz” for example.
The E-Mail address field is a contact address.
Enter your Website address in the Website box.

The License text entry will display the license details you would 
like to have included in the model. Typically include details 
of model usage, distribution, limitations, or modification 
approvals for your model, that you wish to apply. When you 
have entered the details, use the Save option. These details 
will now be included in all config.txt files for models that you 
create, when you choose to place these tags in your asset.

Menus 
File -> Save 
Save the current config.txt file. Used to save and replace a 
previously saved file.

File -> Exit 
To exit the program, you will be asked if you wish to save the 
config.txt file.
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Edit -> Cut, Copy, Paste 
To remove, copy or paste containers or multiple tags, useful 
for reproducing similar entries, such as multiple sound files, 
or attached track entries for example.

Edit -> Refresh: 
To referesh the screen display.

Edit -> Preferences 
To set the program preferences.

Help 
The Help file and Details about the program.

The Tree View 
When an existing config file is loaded using the File -> Open 
menu, the program will “parse” the text file and gather 
two different kinds of information: the Containers and the 
Tags. The tags are values being assigned to a property, and 
a container is a section of the config.txt file that groups a 
number of tags or other containers.

With many possible tags and containers, the best way to 
manage the display of containers and tags is to load them in 
a hierarchy as a tree view (as for example, the tree view of 
Explorer). When starting a new model, the Tree view will be 
empty, and containers and tags will be added as required to 
build up the config.txt file for the model.

When opening an existing model config.txt file for editing, 
CCP will display all the entered containers in the tree view. 
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The tree may be freely expanded or collapsed (by clicking 
with the LMB on the plus or minus symbols). When you click 
on one of the nodes, it will show the tags that are included 
for that container in the tag space so you can add new entries 
or edit existing values.

When selecting a mesh in the tree view, a graphical viewport 
displays. Buttons below the view port allow the camera to be 
moved, and allows the mesh to be rotated or zoomed in and 
out. You may use the mouse within the image box to move 
or rotate the image.  When you click LMB on a container that 
holds a mesh, the rendered mesh will change to the one 
you’ve selected. The mouse roll button may also be used for 
zooming.

While some containers may be renamed, others are required 
to retain a unique name. Attempting to rename a container 
may give a warning message, for example “You cannot 
rename the container “meshtable” because it is a unique 
type.”

When you click RMB on one of the nodes a contextual menu 
will popup with various sections.

The first section is the available sub container section, and 
shows sub containers that may be added to the opened 
container. Select a sub container by clicking LMB on it. 
Depending on the type of container added, a number of 
compulsory or mandatory entry dialogue boxes may appear 
in the tag space.

Next is the tag section. This shows the list of non compulsory 
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tags. (A non compulsory tag is an optional tag for additional 
functionality). Clicking LMB on one of the choices will add 
the tag in the tag space that represents the container. Any 
non compulsory tags may also be deleted. Occasionally, 
some containers have no additional optional tags.

The rename option allows the container name to be changed. 
For example, all the meshes under the mesh table can have 
a unique custom name, but a container cannot be renamed 
using a name that already exists. The tree view will allow the 
name to be edited, by clicking RMB on the name, and using 
the rename option. 
 

The Tag Space 
This section of the program displays the content of a 
container. It dynamically changes as you either select 
different containers or add/delete tags.

The Kind: This is the label or title of the container (the asset 
Kind): When clicking on a container, a new container display 
is loaded in the tag space. In this example, the main container 
“traincar” is selected, and the name of that container is set 
as the title, “Traincar”.

The tag list: The name of every mandatory and/or selected 
optional single tags will be displayed on the left hand side of 
the space. (On some occasions, it will be a text box, in which 
case the tag name may be changed).

The delete button: A tag that has a delete button is a non 
compulsory (optional) tag and clicking LMB on the delete 
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button will remove the tag from the container (it will be 
placed back in the tree view menu, for possible re-selection). 
The list of values: For every tag, there is an associated value 
to be entered so that the program passes that value to the 
tag. There can be different ways of entering the value (combo 
box, text box, tick box, or several text boxes).  

The Error Box 
When a config.txt file is loaded or saved, the program will 
validate the data input to make sure that everything is correct. 
The error box is used to output error/warning messages to 
the user to assist error checking if the model is not working 
in Trainz. 
 
Clicking LMB on an error message will display the relevant 
tag in the program. Clicking RMB on a message or error line 
will display a contextual menu with the option to copy the 
message to the clipboard.

Creating a New Asset 
In the file menu in Content Manager, using the option File -> 
New will open a list, where the Kind for the new asset may 
be selected.

The dialogue shows all the asset Kinds supported by the 
program. Select a kind and the program will generate the basic 
config.txt file structure for that kind, using the mandatory 
tags. Mandatory tags may not be sufficient to create a fully 
working asset. You may also add additional optional tags and 
containers to your config.txt file for a more complex model.
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Opening an Existing Asset 
In Content Manager, select the existing model and use RMB 
to open a menu, choose Edit in Content Creator Plus and 
the program will load the config.txt file for examination or 
editing.

While loading the file, CCP will parse the file and show any 
warning and error messages based on missing or incorrect 
tags, or tags that should not be included in the file.

Note: As soon as the file is opened with CCP, changes are made 
to the config.txt file, even if you exit the file without saving. 
For this reason, If you wish to retain the original config.txt for 
reference, you should open the asset in Explorer, and make a 
backup of the config.txt file, before you open it in CCP.

If you import an asset with a Trainz-build 2.4 or earlier, into 
CMP, any error messages will assist you in making the asset 
compatible with TS12. If you open that asset in CCP it will 
convert it to Trainz-build 2.5, and additional errors may be 
flagged, requiring fixing.

If you import an asset after entering a Trainz-build 2.5 tag 
in the config.txt file, CCP will NOT convert the file to Trainz-
build 2.5 format. It will expect all relevant Trainz-build tags to 
have been entered prior to import. Error messages will assist 
in file correction.

Formats for Entering Tag Data 
Tags require different types of entry, depending on the type 
of data required. Some will require a simple text string and 
others will require more complex data like a VectorX , a float 
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list or a Boolean value. The program will generate different 
types of Graphic User Interface (GUI) for different data types.
 
String, floating point or integer number 
These three data types are simple text or numeric values. A 
string entry is text, a floating point number (or float) includes 
a decimal point, and an integer number has no decimal point. 
The value you type in an entry box will be directly associated 
with the tag.

VectorX 
Vectors are a series of required values. The X represents 
the dimension of the vector (the number of input values 
required). For a Vector3, there will be three text boxes 
requiring three floating point numbers (numbers which 
include a decimal point) to be entered.

Float List Entry 
A float list for a tag will take a series of floating point number 
values.

KUID Entry 
The KUID entry is made up of three different parts: The user 
ID, the content ID and the version ID ‘
When the personal details option has been filled in, the first 
field will be filled automatically with your user ID. Otherwise, 
the program will default to a -1 user ID. The second entry is 
the content ID which represents the Identification number 
of the asset that you are currently creating. The third value 
is the version ID which is the version identification number 
of the content that you are currently creating or editing. 
The maximum value for the version ID is 127. If this limit is 
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reached, a different Content ID is used for the model.

Note: When creating a new asset the KUID is assigned 
automatically, and is not editable by the user.

Boolean Entry 
A Boolean entry is a simple true or false value. It is represented 
by a check box.

Clicking LMB in the box will toggle the tick mark on or off. A 
tick represents true and for an unchecked box, the entry is 
false.

Data Choices 
Where a large list of choices is offered, it is convenient to 
display the available selections in a combo box. 
 
Open the box and select a value by clicking LMB on that 
value. A check mark is shown in the box. Multiple choices 
may be selected by ticking additional boxes in the list.

File Browser 
A file browser GUI is used to locate data stored on the 
computer hard drive, a mesh file name and local path for 
instance, a script file, an animation file or a texture file.

Clicking on the small browse button with LMB will open a file 
browser.

Once the file is located click LMB on the OK symbol and the 
field will be filled with the file name and path name.
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The file type selections in the browser will reflect the types 
that are required to fill the dialogue box. In the following 
browser opened from the mesh dialogue box, the correct 
available mesh extensions are offered (*.IM, *.LM, *.LM.
TXT). From a script dialogue box, the file types will be of the 
*.gs or *.gse types. A texture search will offer the *.bmp, 
*.jpg and *.tga file types.

Asset Browser 
This kind of GUI is a KUID entry but for simplicity, a list of 
installed assets by name, instead of kuid, is presented in the 
browser. It is used to retrieve dependencies of the model, 
such as an interior, bogey or horn sound for a traincar.

Click LMB on the small browse button and this browse form 
will pop up. Some browsers will filter the file types so a valid 
file is offered for selection. 
 
Browse through the list of installed assets, or type in a partial 
name in the top box to locate the asset required, select the 
asset from the list, and then click LMB on the Select button. 
This will internally store the asset KUID in CM. A null KUID 
may also alternatively be selected, where that option is 
required by the original asset.

Some files shown may have similar names, and you will 
need to determine the correct file. If you know a kuid for 
the required asset to be selected, you can locate that kuid in 
CM, note the name of the asset and then locate it by name 
in this browser. It is advisable to give all assets relevant and 
distinctive names.
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After an asset is loaded with the browser, LMB clicking on 
the small “C” content button will take you to that asset in 
CMP. You can then verify that it is the correct asset, or check 
details.

Saving the config.txt File 
Use the file menu option Save to save the config.txt file. You 
do not need to specify a location.  CCP will automatically save 
the file correctly. 
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16 - Keyboard controls

KP = Number Pad

Some controls will not work with this Help window open.

Capital letters represent the letter to press (no need to press 
the Shift key.)

A comma (,) means there is more than one option. Choose 
either option.

Shift X means hold the shift key down and press the X key.

DCC Mode

Down X, COMMA 

Forward W, FULLSTOP 

Stop S, SLASH

Handbrake (if throttle at 
idle)

A, APOSTROPHE

cab mode

Brake Release Q, KP9, KPPGUP

Brake Lap Z, KP6, KPRIGHT

Brake Application A, KP3, KPPGDN

Emergency Brake PAUSE

Independent Brake E, KP4, KPLEFT

Independent Brake Bail D, KP0, KPINS

Throttle Up W, KP8, KPUP

Throttle Down X, KP2, KPDN

Throttle Idle S, KP5, KPCLEAR

Reverser Handle Forward F, KPSTAR

234



16 - K
EY

B
OARD





 CONTRO





LS

Reverser Handle Backward R, KPSLASH

Dynamic Brake Toggle C, KP7, KPHOME

Steam controls

Shovel Coal SPACE 

Coalman Wave SHIFT SPACE 

Fans SHIFT F 

Regulator Up W, FULLSTOP, KP8, KPUP 

Regulator Down S, SLASH, KP2, KPDN 

Reverser Up F, KPSTAR 

Reverser Down R, KPSLASH 

Injector Up I 

Injector Down O 

Blower Up N 

Blower Down SHIFT N   

all locos

Lights L 

Lights SHIFT L 

Toggle on/off Flashing Ditch 
lights

; (semi-colon) 

Pantograph KP1, KPEND, END

Horn H, KPPLUS 

Sand V, KPMINUS 

Bell B 
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Interface Display Options 

Help F1 

Hide / Display All F5 

Hide / Display Drivers and Orders F6 

Hide / Display Driver Button Bar F7 

Hide / Display Custom HUD F8 

Hide / Display Driver HUD F9   

Camera Movements 

Up UP ARROW 

Down DOWN ARROW 

Left LEFT ARROW 

Right RIGHT ARROW 

Zoom In PAGEUP (OR MOUSEWHEEL) 

Zoom Out PAGEDOWN (OR 
MOUSEWHEEL) 

Forward Along Consist PLUS (on top row, not 
Numpad) 

Backward Along Consist MINUS 

Interior Cab View 1

Chase View 2

Lineside View 3

Free Roaming View 4

Driver 1 CTRL 1 

Driver 2 CTRL 2 

Driver 3 CTRL 3 

Driver 4 CTRL 4 
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Driver 5 CTRL 5 

Driver 6 CTRL 6 

Driver 7 CTRL 7   

Cab Camera Controls 

Previous View [ 

Next View ] 

Previous View Fast CTRL [ 

Next View Fast CTRL ] 

Zoom In PAGEUP (OR MOUSEWHEEL) 

Zoom Out PAGEDOWN (OR 
MOUSEWHEEL)   

Other 

Metric Speed Display G 

Decouple CTRL D 

Train Reverse Heading ALT C 

Display Work Orders (Scenarios) K 

Objective Window (scenarios) ENTER 

Switch Forward Junction J 

Switch Rear Junction CTRL J 

hud_help_toggle CTRL H 

Reset Tripmeter T   
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Map View 

Background ALT B 

Gradients ALT G 

Junctions ALT J 

Signals ALT S 

Triggers ALT T 

Trackmarks ALT M 

Industries ALT I 

Named Objects ALT N 

Objects ALT O 

Consists ALT C 

Trackside Labels ALT L   

General 

Close ESCAPE 

Find Object CTRL F 

Map View M, CTRL M 

Pause P 

Save CTRL S 

Load CTRL L 

Display Performance Tuning 
Dialogue

CTRL T
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17 - Extra Fun
Want to have some extra fun?

Try pressing Ctrl + Alt + Shift + P on a new map, then stand 
back and watch (click on the map and press esc to stop).

Also try Ctrl + Alt + Shift + Z in a map with road traffic or Ctrl + 
Alt + A (then click on the map) for a spectacular effect.
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